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c T A4NE Y T P —ERADEE

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T 4 FalL—> 3> A4 F (—RERIZIRME)
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i

ERAT DHIIC

Z DETIL, Cisco ASA OfE % BtrT 2 FIEICHOWTEIH L £,

ca<w LRI A B —TxA A (CLI) DALY —L~DT 7EA (21 ~—)
« ASDM 7 7 B ADEHE (32 =—)

« ASDM Dt (38 ~—)

« ASDM BIED I A X~ A4 X (40 =—7)

s TIGHAREOT 7 4V FERE (42 X—2)

B E DR (55 ~—)

ASDM CTOa~>y RIA A F—T A AV —LDOfFH (56 X—)

Vi O EEEOWAH (57 2—)

ARSI A MM A —T AR (CLH) Oarvyy—ILA
DT7I7EAX

ASDM 7 7 & AD AR ELE, CLIZMH L TITHOBRER S HLEE1H D 7,

PIIRCE ZAT D1, 2 Y =V K= hpBEBE CLIICT 7 B ALY, Lok, EFHT 7
A (1061 =) IZfE> T Telnet £721XSSHEZHAL T, VE— K727 RAZHETEE
T, VATFARTTIZALF I TFAPNE— RTEELTWAEAIE, 2>V —L FA—|
T 7 BATDEVAT ADFITAN=AICAD £,

N

CE) ASAVO V=T 7 EBRAZOWTIE, ASAVD I A v 7 AX— K A REBRLTLEE
Uy,

TFITS5AT2oRAY—ILADTIER

TFIGAT VA Ay — T 7 AT A%, ROFIEIZHENET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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B 757 2a0v—n~075+t2

ATy

ATy T2

ATvT3

ATv74

ATy Th

FIE

fEnayy—n r—7NEFEH L Carta—FaEary ) — L R— MIEELET, ¥—
ST ER 2 LS EERREE 9600 N —, T—X% B b8, NUT 4L, Ay T EY
1. 7a—#l#Z2 LICREL T, v Y —/UZEmR LET,

=)L =T NDFEHMZONTIL, ASADNN— R =7 A4 REBRBLTIEE N,

Enter ¥ — %L C, ROT o T IRERENDZ EEMERLET,

ciscoasa>

Zo7ur7 hMi, 2—VEXECE— FTIEEL WD LERLET, =2—PEXECE—F
T, ARz~ FOLEBEHTXET,

¥ EXEC T— Rl 7 7 B 24 212i%, koa<r FE AN LET,

ciscoasa> enable

kDT a 7 RRFERENET,

Password:
RELSNDOTXTOa<wr L, FHHEEXECE— FCHEHATE£7, HHEEXECE— Kb o
V74X al—TaryEF—RIABRZELTEET,

T MR LT, A F—=T NV RAT—RKEANLET,

T 7NV ETIEHARRAT = RIZEAICHREINTWA T2, Enter ¥ — 2 L TRICHERE T,
A FX—=T NV NRAT— REEETHIZIE, "A R, FAAL %, BLXOAS X—T L XA T —
K& Telnet XA T — ROFRE (681 X—) ML T EEW,

Ta 7 RERO L HIICELET,

ciscoasa#

FiMEE— REH T3 D121, disable 2~ K| exit 2~ K, 2T quit 2~ K2 AL
*7,

Ja—n"naryZ 4 Xal—valryT—RIT7 78R TH00%, koa<wr FEANLET,
ciscoasa# configure terminal

Tuar 7 NRRO X DI L ET,

ciscoasa(config) #

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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Firepower2100 3 > —)LADT7 V£ R .

Ja—r\)ar7 4 Xal— g T— RnL5ASADOREERKBTCEET, Fa—L o
T4 X2l —aryEBT—REKTT5IC0%, exita~ > R, quita~> R, ¥7idend 2~
KZ2ATTLET,

Firepower2100 2 > —)L~ADTF7 VX

ATy I

ATy T2

ATvT3
ATy T4

Firepower 2100 = >/ —/L 7R— kG FXOS CLI \Z#%%¢ L £ 77, &I, FXOS CLI /5 ASA =22
VWL, BERAZ N TEX E T, FXOSITSSHE T 28413, ASACLIIZ b5kt
T&EF9, SSH O DEEGIZ 2 > Y — Vi TldZz\W\ =8, FXOS SSH #5657 H %D ASA
W T o 2 D TE E9, [FEEIC. ASA IZ SSH #5424 1. FXOS CLI IZf#ki Tx %
R

IR& HEIIZ

—EEICHETE D A Y — T 1 D72 T, FX0S 2 Y — b ASA DAy Y —)L
WZHEET A6, Telnet £ 721X SSH DG & 13872 | T O3 K#ER T,

FIE

B o Ya—HF%&ar Y —/LR— MIEHE L £ 7, Firepower2100 (21X DB-9toRJ-45> U 7
V=TI E L TWATD, BT A27-0iir— K =7 48D ) 7L toUSB 77—
TINMETT, THEHOLNL—T 4 7 VAT DIHERUSB Y 7 v KT A4 NE5T
AVA =L LTLEEN, RO Y TLHREEZEHRLET,

* 9600 7R —

857 —X% Ew bk

YT a2l

1 Aby7 Ev b
FXOS CLI I L £,

ASA IZHHE L E T,

connect asa

i

firepower-2100# connect asa

Attaching to Diagnostic CLI ... Press 'Ctrl+a then d' to detach.
Type help or '?' for a list of available commands.

ciscoasa>

FX0S =2 Y —/VIZRE DL, Ctrl+a, d E A ST LET,
ASA IZ SSH #5595 34 (ASA TSSH 7 7/ B A% E L) . FXOSCLLIZ#k LE T,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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. Firepower 4100/9300 v —> LD ASA I —I)LADT Y £ R

connect fxos

FXOS ~D#FEZ RO bNET, T 74/ bO2—V4 : admin B L VXA U — K : Admin123
A LET, ASACLIIZREAITIE, exit & AT 5, F721F Ctrl-Shift-6. x & A S LF
@—O

1 -

ciscoasa# connect fxos
Connecting to fxos.
Connected to fxos. Escape character sequence is 'CTRL-"X'.

FX0S 2.2(2.32) kp2110

kp2110 login: admin

Password: Adminl23

Last login: Sat Jan 23 16:20:16 UTC 2017 on pts/1

Successful login attempts for user 'admin' : 4

Cisco Firepower Extensible Operating System (FX-0S) Software

[..]

kp2110#

kp2110# exit

Remote card closed command session. Press any key to continue.
Connection with fxos terminated.

Type help or '?' for a list of available commands.

ciscoasa#

Firepower 4100/9300 v —> LMD ASA O VYV —)LADT IR

ATy I

WIEARRE DA Firepower 4100/9300 & v —3 ZA—"NA P2 (2 YV — R— R, H5H
UME Telnet £721L SSHAZFEH L CTYE—T) #L Ca~ L RIAM L A F—T A AT
TIHEAL, ASAEX=2 VT 4 BV 2— /U LET,

FIE

Firepower 4100/9300 * ¥ — 3 A —/3/SA H CLI (=2 Y —/LE 721X SSH) 128t L. &I ASA
Wty a LR LET,

connect module s/otconsole

POTEY 2= ary ) —) U778 ATHLEEL, FXOSTEY 2—/VDOCLIZT 7 A LFE
T, TOHBASAT IV r—2a CERTHOMLENRDY FT, BEEOERIZIEIIZ ASA T
TV = a R T AR, ROa<wy RFAXy 7 TExET,

connect asa

1 -

Firepower# connect module 1 console
Firepower-modulel> connect asa

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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ATy T2

ATv7T3

ATy T4

Firepower 4100/9300 v —> LMD ASA I Y —)LADT IR .

asa>

i DREHE L~V TCh B EE EXEC E— RIZRDO X 9127 7R LET,

enable

1 -

asa> enable
Password:
asat

T M LT, A =T NV RAT—=RKEANLET, T 74/ FTlE, 7SAT— RiEzZe
HT9,

it EXEC E— RZHM& T HI21X, disable, exit, £/ quit 2~ REZ A LET,

Ja—\)y a7 4 F¥Fal—yaryET— Rt LET,
configure terminal

1 :

asa# configure terminal
asa (config) #

Ja—/NL ary7 4Xalb—vay E— REe& T3 5IT1E, disable, exit, F72iX quit =~
Y RE AT LET,

~HANLTASAa Y — Lty varaZ2 T L CTelnet 7 7 r—a & T L, RIZ
quit # AJJ LC FX0S A— S # CLI ##& T LE 7,

NG TN a—F 4 OB TRINZ FX0OS Y 2—L® CLIICRE A4, Ctrl-A-D %
AHLET,

1 -

Firepower# connect module 1 console
Telnet escape character is '~'.
Trying 127.5.1.1...

Connected to 127.5.1.1.

Escape character is '~'.

CISCO Serial Over LAN:

Close Network Connection to Exit
Firepower-modulel> connect asa
asa> enable

Password:

asa# configure terminal

asa (config) #

asa(config)# [Ctrl-A-D]
Firepower-modulel> ~

telnet> quit

Connection closed.

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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Firepower#

ASAH—EXEDa—)Larvy—IL~ADT7HER

VIR E DA, AA v FIZ (Y =)L iR— MZ, &5 Telnet £ 7213 SSH 2 L C
VE—FT) L Ca~vr RIS A X —T A& (CLI) IZ7 7 ®BAL., ASASM (282
BELET, ASASMIZITTHHAREOT 7 4V b a7 4 Xab—rarBNEEnNCnipniz
O, ASDMZFEH L T7 7 AT HRNZCLITHREZITOIVLENRH Y £9°, T 2 TiL, ASASM
CLIIZT 78 AT D HIECHOWTEH LET,

BHEAEIZDONT

A A T CLI D5 ASASM IZEERE T D 1TIE, IRD 2 SO FEMEA T F 9,

o iz — LB« service-module session =1~ > K& LT, ASASM ~Ofgf8 =1
VNV AR L ET, R Y — VRIS, EEO 3 Y — DT T OF|
HEHIRNH Y £,

FlRERIORLET,
cHEIX Y m— RHRBEHE L, ¥4 L7 7 b LETA,
«ASASM U m— R bR a i C& | AX— T v Ay —VxMBETEET,
¢ ASASM 3 A A—TVZm— RTERWES, ROMMON IZ7 7 A T&E £ T,
I ANAY — ROREIFZLETITH Y A,

HIFR 2 RIZR LET,
o FEREDMEGETT (9600 R —)
—JECT VT 4 TNITE D — VBRI 1 DT T,

e ZMa=wy RiX, Cul+Shift+6, x NF —I )P — " TFr 7 MIERLHTZHDT A
=T =V ATHDLE I TN YN QIEAT A EIFITEERA,
CtrI+Shift+6. x!%. ASASM =Y — /)L E TR —T7 LT, AA vFFr 7 MR
HIODY = ATHEHY ET, LR ->T, ZORMTASASMZRK T LE D &
THL. b —IF AL =N TFar TP MNIEVET, AL vFIFZ—IF L
P —NEEEGE LTSS, ASASM a2V Y — Ly a BT 7T 4 TDEETT,
AA v F TarF R Ne&KTTH5EIITEERA, TV Y= NEAL v TF T
MZRETITIE, BEES ) 7 AEGREAEHT 208N DY £, ZO%4E . Cisco I0S
TH—=I TN —NELFAAL vTF TR —TLFEETTHH, £7203 Telnet
session 2~ R&ZfEH L F7,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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ASAH—ER EVa—LADOTA 2 .

GE) 2y Y — RO KFED D, ASASM ZELL 22 7 b L
L, BREY bEBESAET 5 TN D Y ET. Mo
AIRE T4 o F DA, BAF OB 4 T 5 BN B 0 %
‘a—o

* Telnet $%#5¢ : session =~ > RZ&{#H LT, ASASM ~® Telnet £t 2 {ERK L £ 77,

4

GE) HLWASASMIZx LTIk o N A L CTEfi T £H A,
Z DA TIX, ASASM _ETO Telnet & 7' A > /XA T — KO E
DUNETT (T74NV FONRAT—REH Y FHA) . passwd =
< REFEHL TR —RERE LRI, ZOFXEFEHAT
xFET,

FlEAZRIORLET,
« ASASM ~DOB¥ Dt v g v ERBICHEH X,
e Telnet & v > = i3, &l T,
HIFR 2 IR LET,
e Telnet &> a if, ASASM U — REFICKTL, #1427 7 FLET,

e ASASM NERIZe — RT5F TASASM IZIZT 7B A T&EEHA, LEN-T,
ROMMON |27 7 B AT&E FH A,

s W Telnet 2 7' A » NAT — RERETHHLERHVET, T 74/ ONRRT—
FixdH v FHA,

ASAH—ER ELa—)LAOBOT A Y

MR EDEES ., AL vFIT (AL v FDar Yy —)L R — M, &AL Telnet F 7~ 13 SSH
PHEHALTYE—FT) L TCa~vry RIS v A v Z—T oA AT 7 AL, ASASM (T
B LET,

VAT ANTTIZVINTF AT A NE— RTEEL TWDEHEIL. A1 v TBRENS ASASM
T 7 BARATHEAT LDFITAR—=RIZAD £,

F DT, Telnet F721XSSHAZHFHLTYE— R 77 2% ASASM ICEHERETXE T,

FIE

RATY TN AL v TFhE, ROWVTNNERITLET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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B assav—cxES2—~0nsqy

BHIOT 7 A THEHATRE : AL v F CLINSLZDa~vwr FE2 AL, ASASM (2=
V=L T EALET,

service-module session [switch {1|2}] slot number

il

Router# service-module session slot 3
ciscoasa>

VSS NDAA v F DA, switch 515 E AT LE9,

EVa—NDOARy NEEERTITDHITIE, A4 vTF 7v 7 T show module =2~ >
FEATLET,

2—H EXEC E— RIZT7T 7 A LET,

B7A U NAY = FOFERITHEAAEE : A v FCLINLZDa<y Re AL, Ry
7 7 L— % LT ASASM (T Telnet #55¢ L £,

session [switch {1 || 2}] slot numberprocessor 1

0y RAT— ROAIBRDENFET,
ciscoasa passwd:

i

Router# session slot 3 processor 1
ciscoasa passwd: cisco
ciscoasa>

VSS WD A A~ FOE . switch 515%2 AT LET,

session slot processor 0 =~ > NiL, DO H —ERX TV 2 — L TIEYR— SN TWET
. ASASM TiIHAR—FShTWEEA, ASASMIZIZ7 ety 003D Y A,

EVa— DAy NEFERRTDHITIE. AA vF 7'v 7 KT show module =~ >
KEAALET,

ASADM ~DOwr 7 A v SAT— K&z ANJJLET, passwd 2~ REfEH LT RAY—F
ERELET, 774NV ONRRT—REHY THA,

2—H EXEC E— RIZT7T 7k A LET,

ATV T2 EEm DR HEL~ L Th 5 il EXEC E— RIZIRD L 927 78 A LET,

enable

51

ciscoasa> enable
Password:
ciscoasa#

. ASDM T &
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ATvT3

avv—rtvvaronsrzyr |

T MK LT, A R—T NV NRRAT—RE AN LET, 774/ FTIE, NAT— NEZ%E
HTd,

F5HE EXEC B — R&#& T4 5121, disable =~ R, exit 2~ R, £720% quit 2~ K%
AHLET,

Jua—)Lar7 4 Xal—yary B—RIT7EBALET,
configure terminal

ra—r\ L ary 7 4 Xalb—varyE®— REKTTHITIE, disable 2~ K| exit 2~ R,
FolT quit 2~ READLET,

BMELEYY
BT 7Y ADHA RTA
RA NG, RAL VL, BEOA X —T I 22T — K& Telnet 7S A U — ROEE (681
D)

avy—I)Lteyviaroagr7ok

ASASMM BT 777 F LARWES . v Y — VRIS S, XA A7 7 MIb v A,
ASASM 2 Y=Lty al BT LTAL vy TFDOCLIWKT 7 BATHIZIE, ROFJEESE
ITLUET,

BEREFICHEWEE IR TV A AREEDSH D, o2~V DT 77 0 TR ERKTT5
WX, 77747 7ay ) —)VEROKT (B0—) ZZRLTIEIN,

FIE

AA v F CLLIZREDIZIE, WEATILET,
Ctrl+Shift+6., x
AAwF TarT MIED 9,

asasmf [Ctrl-Shift-6, x]
Router#

GB)  KEBLOEEF—FR— RO Shiftt6 (¥ ¥ L v bits (N 2O LET, BHloF—
A—FREHEHLTEY, BoOXFE LTxy Ly s () ZHNTERVWEA,
—RERY E T IIKFERINS, T A — T EE RO LFICEE TE E T, terminal
escape-character ascii number 1~ > R (Z Dk v g CEETS) | 7213 default
escape-character ascii_number 2~ > N (kI EE T 2) Z#EHLET, 2Lz
. BIED vy a v Dy —47 v A% Cltw, x ICEFE T 5121,
terminal escape-character 23 2 A/ L £79°,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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B 777 onasv—regorT

TOT4Hay

ATy T

ATy T2

Y — LIEGDRT

oY — RO KEEDT-HIZ, ASASMEZIELL B/ 7 hLAWnWeE, BHLE-LY b E
W D72 » TR ONIFET D AREMENH Y £, D AR 7 A 328550, BFEOR:
BERTTAXNERH Y 7,

FIE

A A »F CLID G, showusers 2~ REMFHA LT, #isnlza—V2ERrLET, a3
V=) 22— L Teconl EMEENFET, AA M T FL R, 127.0.0.5l00 &L FREINFET (slot
ITEYa— DAy NEETT) |

show users

7 zE, koo~ FHEAE, Ay 21D EYa2a—ADTA4 2 0D2—% [con] %
RLTWET,

Router# show users
Line User Host (s) Idle Location
* 0 con 0 127.0.0.20 00:00:02

a = NVEROHBTA BT )T T AHIZIE, kOoa<wr REAJJLET,
clear /ine number

I &R L ET,

Router# clear line O

Telnet vy 3Oy 7k

Telnet v > aE28TLTAAL v F CLIICT 78 AT 5121%., IROFIEEZFEITLES,

FIE

AA wF CLIIZEAIZI1E, ASASM T — FE/721Z=2— EXEC E— K0 b exit = AT L
T, AT 4 X2l —2 g3 F— RNIZASTWAIEARIL, Telnett v > a UK T I 5 F Tk
DIRL exit # AJJLET,

AA v F Tur T MIEY £,

asasm# exit
Router#
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GE) bz, =& —7 2 —4 2 A Ctrl+Shift+6, x ZfifH L T, Telnetz v 3% =T
A —TFTAHIENTEET, TOZRF—F 2 —F U A2EHTDHE AL vF
7 S TCTEnter ¥—%2H3 LT, Telnet by a v aHETEET, AAMvTF
M Telnet ¥ a v 28§ 5121, AA v F CLI T disconnect * A/ LE T,
Ty va U LRWEE . ASASM SRIEICHE > TRAAIIZ Z A L7 7 M LE T,

JYIbrY9zT7 EDa—)LaAYV—ILADTHI LR

ASA 5506-X IZ ASAFirePOWER 2 EFD Y 7 N =T YV a— L&A L A =)L L TWAERE.
FVa— )b aryy— Dty g v EETTEXET,

\}

GE)  session 2~ REZHEHLTCASANRNY 7 FL—0Z N LT AN—RY =27 £V a2—/LCLIICT 7
TR TEHZ LITTEER A,

FIE

ASACLI G, EVa—A~Dt v araFirLET,
session {sfr | cxsc | ips} console

B -

ciscoasa# session sfr console

Opening console session with module sfr.

Connected to module sfr. Escape character sequence is 'CTRL-"X'.
Cisco ASA SFR Boot Image 5.3.1

asasfr login: admin
Password: Adminl23

ASAS506W-X DA VY LA 7O EARA a2y —ILADT7 IR

TAXYLATIEABRALL N ar ) —NIT7ERAT A%, ROFIAEZETLET,
FI§
ATFYT1 ASACLI 26, T7ERARL L b~y a L Z2FETLET,

sessionwlanconsole

1 -
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ciscoasa# session wlan console
opening console session with module wlan
connected to module wlan. Escape character sequence is ‘CTRL-"X’

ap>

AT T2 78R KA LB CLIIZOWTIL, [Cisco I0S Configuration Guide for Autonomous Aironet
Access Points ] [FRE] 2 L T XV,

ASDM 7 U £ X DEETE

TR, TN a7 4 F a2l — g TASDMICT 78 AT 5 HE, BXOT 7+
IV NREDI2WGEILT 7B RAEFRET D HIEZHOWTHALET,

ASDM 7 7 £ R (7 7547 A, ASAV) (3T B TIHHHHDT
JFIbarI74FaL— a3 DER

THRHEFREOTFT 740 a7 4 X2 lb—3 3 o ClE, ASDMEBSRIZT 74V hDXy h T —
JRECTHARE SN TVET,

FIE

IKDOA VB —T 2 A ZABLOPR Y NU— T HREZMET LT ASDM IZ86 L E7,
EHA U H—T 2 AL, THAOET ML > TR F9,

* ASA 5506-X 35 L TN ASA 5508-X. ASA 5516-X : ASDM (289 A A v X —T = A A
IZ GigabitEthernet 1/2 T3,

*+ ASA 5512-X LAFE : ASDM (285t 35 A > % — 7 = A A% Management 0/0 T,
* ASAv : ASDM (28t T % A » & —7 = A A% Management 0/0 T,
* ISA 3000 : ASDM (Z##5i 3 % A > % —7 = A AlX Management 1/1 T,

* Firepower 4100/9300 > v —3 ™ ASA : ASDM (285t T 5 A v ¥ —7 = A A,
FXOS ¥ ¥ —¥ A== NS ¥ L TCERINTWHITREOEHRY A T DA H—T =
A ATT,

T 7 AN NOFET RLAFKRO LBV TT,
CASAT T AT A 1 192.168.1.1,

¢ ASAv : BABRZEHA L A —T oA ADIPT RLAZRELET,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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* Firepower 4100/9300 > v — 3/ o ASA  BARFIZEHA L X —T = ZADIPT R
AEHFRELET,

cASDMIZT VB ATEH7 74T MIRDEEY T,

CASAT TFIAT LA T4 T2 ME192.168.1.024 %> NU—727 FIch D MEND
DET, T74N a7 4 X2l — 30280 DHCP A 2—7 M2 &N 5T~
W, BEHAT—3 g VX OHPHAND IP 7 RLRAZEN Y THZ LN TEET,

e ASAv : BARHIEH 7 SA T FOIPT RLAZHELET, ASAv L. HEmah
720747 MIXLTDHCP — 3¢ L CTHEREL £ H A,

« Firepower 4100/9300 3 v —3 ED ASA : T _XTDHRA MME, FHA L X —T A A
FDASDM ~DT 7 v 2R EFFRENE T, ASAVIT, B INT=T T4 T MIL
T DHCP #— "¢ L THEBEL £H A,

GE) <A T arTFFARNE—RIELETEE, ERdoXy NU—7REEMHH L CEH
QAT HFARNDL ASDMIZT 7B ATE AL 910720 £97,

BMELEYY
THMMREDT 7 40 MR E (42 X—)
~NVTF arTRRANE—-ROEMEEIZT =Tk (272 X—2)
ASDM DjE#E) (38 ~—27)

ASDM 7V L ADH A A T4 X
ZOFIAE, ASA Y —ER EV 2=V ERSTRTOET /MIEH S NET,
WOGEMEIZ 1 DU ESTETELLEEIE. ZOFIEZEHLET,
s THHEREOT 740 b 207 4 X2 L—3 3 VR,
s NTUANRT LU N T AT U4 =L E— RIZEE LTV,
e wNT AT HAN ET— RIZEE L2V,
YTV =T v R E— ROYE ASDM ISHIENOFEZHICT 7 AT 572z, MEOE
HIPT RLA%F Ef%éﬁ7/a/%fztl%ﬁﬁﬁ@77jwk:/74#Jv~va
YEEMT O AR LET, ZOHEICRBINATWDFIAIL, Fl=—X (FT7 AN

TLyhE—RRODALTF arTHFARNT— RORERE) BDbIESY, MhoRELHERT
HVBENHHEAIZOBERA L T EE N,

W]

GE)  ASAVORES, BARIZI NI U AT LU M E— REZRETX L0, ZOFIHET., HELY
V7T AHAVERHAHGERE, EARITEFICRYLHET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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FIE

ATy F1 2= R—FTCLIIZT Z7EALET,

ATvT2 (FTvar) PFUART VLU N T AT U=V T REA =T M LET,
Zoavry R BREEZZ VT LET,
firewall transparent

ATFyT3 BHA L A—T oA ZAERELET,

interface interface id
nameif name
security-level level
no shutdown
ip address ip address mask

1 -

ciscoasa(config)# interface management 0/0
ciscoasa(config-if)# nameif management
ciscoasa(config-if)# security-level 100
ciscoasa(config-if)# no shutdown

( ) #

ciscoasa(config-if ip address 192.168.1.1 255.255.255.0

security-level [, 1~ 100 D5 T7, 100 B bLETT,

ATy T4 (EEEFSINEEREAA M) BHXY FY—27ODHCP 7V — V&% ELE7,

dhcpd address ip address-ip address interface name
dhcpd enable interface name

1

ciscoasa(config)# dhcpd address 192.168.1.2-192.168.1.254 management
ciscoasa(config)# dhcpd enable management

ZOFPIZA o F =T 2 A AT FUABRGENTWRWI & AR LET,

A7y 75 (VE— MEFHAZ M) HHAA P~OL—FERELET,
route management _ifc management_host_ip mask gateway ip 1

51

ciscoasa(config)# route management 10.1.1.0 255.255.255.0 192.168.1.50 1

AFw7T6 ASDM O HTTP ¥ — %A X —7 NI LET,

http server enable

AT ST BHARRA D ASDM ~DT 7 A %A LET,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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ATvT8

ATvT9

ASAH4—EX EV2—L0ASIM 75 £ 20EE [

http ip_address mask interface _name

51

ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

RECZHRFELET,

write memory
(A7vay) = FKe~vLF T— RIERELET,
mode multiple

Ta T IRFREINTED, BEORELZEH AL THXA MRS A L 2EKRLET,
ASAZVn—FRTrkorRdDENFET,

15l

ROBETIE, 77AT VA=V E—RB T AT L b F— FICEBS L,
Management 0/0 1 & ¥ —7 = A ANFKE I 4L, FEAR A Mk L TASDM 3 A Rx—7
MIEhET,

firewall transparent
interface management 0/0

ip address 192.168.1.1 255.255.255.0
nameif management

security-level 100

no shutdown

dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management

http server enable

http 192.168.1.0 255.255.255.0 management

EErEYY
THHWREDOT 7 4L MR EDE I (43 <—)
T7AT U= E—F (VTN E—FK) ORE (230 2—)
TIIAT LA ALy —A~DT 7 EA (21 ~—)
ASDM O fHE) (38 ~—7)

ASAH—ERX EZa—I)LOASDM 749 X DERTE

ASASM [ZITWEEA X —T = A A7, ASDM 7 7 B ARHFRIRE SN TWER A,
ASASM @ CLI Zfifi L CASDM 7 7 £ A &R ETHXHE N H Y £3, ASDM 7 7 & 2 AT
ASASM Z R ET HI2IE, IROFIEEFEITLET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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1R BHHEIIZ

ASASM D7 A w7 AZ— K HA FIZHE-> T, ASASMIZVLAN A ' Z —7 = A Z%E|) 4T
i‘j‘o

FIE

ATV 1 ASASM IZHEE L, /7 m— b av 7 4 Falb—rary B—RIT778ALET,
AT9TFT2 (FTvay) NFUAXT LY N I AT U4 —VE— R FX—T M LET,
firewall transparent
Zoavwr NI, REEZZ VT LET,
ATY T3 THAOE—RIIL U T, WOWTHNOEEEZ T CTEHA VH—T o4 AEHFRELET,
e N—T v RE—R X =Tz A% )N—T v RE—-RFRTHRELET,
interface vlan number
ip address ip address [mask]

nameif name
security-level level

il

config) # interface vlan 1

config-if)# ip address 192.168.1.1 255.255.255.0
config-if) # nameif inside

config-if)# security-level 100

ciscoasa
ciscoasa
ciscoasa
ciscoasa

security-level [%, 1~100 &S TT (100 DR HEETT) ,

RFGUART LU N E—FR TV oA A —T oA RAEREL, 7V v J—
FIE L VLAN 280 4 CTFE 9,

interface bvi number
ip address ip address [mask]

interface vlan number
bridge-group bvi number
nameif name
security-level level

il -

ciscoasa(config)# interface bvi 1
ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0

config)# interface vlan 1
config-if)# bridge-group 1
config-if)# nameif inside
config-if)# security-level 100

ciscoasa
ciscoasa
ciscoasa
ciscoasa
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RTv74

ATy T5

ATvT6

ATvF1

ATy T8

ATvT9

ASAH4—EX EV2—L0ASIM 75 £ 20EE [

security-level [Z, 1~100 ®&F 5 T3 (100 N HELETT) |

(B SN EHAA M) BHA X —T 24 A3y NU—7 LOEHAKR X O DHCP
A =TI LET,

dhcpd address ip address-ip address interface name
dhcpd enable interface name

1 :

ciscoasa(config)# dhcpd address 192.168.1.2-192.168.1.254 inside
ciscoasa(config)# dhcpd enable inside

ZOBENICIIERT FL2AEESHRNTL EE0,

(VE— MEHEAR M) HBEARA M~DOL— FERELET,
route management_ifc management_host_ip mask gateway _ipl

B -

ciscoasa(config)# route management 10.1.1.0 255.255.255.0 192.168.1.50

ASDM @ HTTP $— "% A x—T M2 LET,

http server enable

IR A RO ASDM ~D 7T 7 A EHA LET,

http ip_address mask interface_name

1 :

ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

RECHRFLET,
write memory

(A7varv) FE=FevLF E—RICHRELET,
mode multiple

T NREREINTEL, BEEORTEEZEH I TXFA MIEBRTHZ L E2ARBLET,
ASASM U r— RT 25 L I9RDOLNET,

1

KDONL—F > K E— RORETITZ. VLAN1 DA v Z—T oA ZA5FHEL, EFHERR
k@ ASDM O A F—T M2 LET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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interface vlan 1

nameif inside

ip address 192.168.1.1 255.255.255.0
security-level 100

dhcpd address 192.168.1.3-192.168.1.254 inside
dhcpd enable inside

http server enable

http 192.168.1.0 255.255.255.0 inside

ROBETIX, 77AT V4 —LE—FE FT AT L hF— RICE# L, VLAN
1A X —T 2 AZFELTBVI1IZE Y Y TH%, HEARA MDD ASDM % A1 X —
T LET,

firewall transparent
interface bvi 1

ip address 192.168.1.1 255.255.255.0
interface vlan 1

bridge-group 1

nameif inside

security-level 100

dhcpd address 192.168.1.3-192.168.1.254 inside
dhcpd enable inside

http server enable

http 192.168.1.0 255.255.255.0 inside

EENEYY
ASA P —EREVa2—)L aLV—)b~DT 7EA (26 X—)
Tr7AT T4 —LE—F (V7N F—FR) ORE (230 2—)

ASDM O #Z Ef

ASDM (Z. KD 2 H>DFIETEE TXE4,

«ASDM-IDM 7 > F % : T F ¥ iE. ASADOLWeb 77UV EHEH L THF Y a—RKENR
AT TV r—a T, ZNEERATAE. EDASAIP 7 RL R IZEH TE £,
o> ASA IZEe T 285G, J0 Ty 2HEX Ve — RT3 0EEIHD FHA,

« Java Web Start : FH T 25 ASA Z &2 Web 77 U THEkE L C. Java Web Start 7 7° U /7 —
VarEREFELIIESTALERSD T, EETa L a—XIZva— My MER
ECEET, 2770, ASAIPT RLAZ LIy a— by FE2R T 0ERHY 9,

GE)  Web Start ZfEHT 25/, Javax ¥ v 227 U T LTLEEN, 7 U T LARWEA,
Hostscan 72 E D1 7' A U EIAR Y O —IZkTAEERIKDOND RN H Y 3, Z OREIZ,
ToFxEFEHLTOWDLILAIZIIRELEEA,
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ATy I

ATvT2

ATvT3

asomoies [

ASDM Tit, BHEHOE=DIZHIO ASAIP 7 KLU A ZBIRTE £9, 7 F v & Java Web Start
DOREREDEVL, FIT, 2—TREINTED X 512 ASA IZHKi L. ASDM ZiEEh4 202 H
Di‘é—o

Z 2T, FTASDMICEET A FEIZOW T LE 9, WKIZT »F v £ 7213 Java Web Start
ZfEH L C ASDM ZEET 5 HIEIZ DWW TR L £7,

ASDM |1 — AL D \Users\<user_id>\.asdm7 4 L7 FUNIZF ¥ v 2, vl BLORER
EO7 7 ANERIFL, TempT 4 L7 M UWNIZH AnyConnect 72 7 7 A VIR ED T 7 A V%
L ET,

FIE

ASDM 7 747 FE LTHRE L2 Ea— X TRO URL AN LET,
https://asa_ip_address/admin
WRDORL > 2 Ff> ASDM B ~— VR FR SN ET,

+ Install ASDM Launcher and Run ASDM

* Run ASDM

* Run Startup Wizard

TroFxEATyE— RTHICEF, ROFIEEZFEITLET,

a) [Install ASDM Launcher and Run ASDM] #72 U v 7 L¥E 7,

b) Z—VLHENRRAT—RDT 4 —)L REZEOFFIZL FHA A b—1DHE) | [OK] %
27U w7 LET, HTTPS BIENRE SN TV AR WAL, 22—V 4B LA x—TIL 3
AT — K (F7#4/VhTLH) ZANLRNTASDMIZT 7 A T& %9, iF : HTTPS
RALE A X —T M LT HE, 22— 4 LBEEM T ONTe AT —R2 A LET, REE
DEDTRWEETH, B /A VHET (=452 T7 T 7 DEFITLRNT) 22—
ZENRRAT—REANTEHE, AADMIZL > TR—INT—F_XR—=ZAT—HENF = v 7 &
ET,

Q) AVAR—THALVE2—FIRFLT, AVAM—TEEBHLET, 1A M=%
T45%E, ASDM-IDM 7 > F ¥ 2N HEIICB & £ 97,

d) HHIPT FL A, BIOWULa—H4 L2 T— R (FilA v 2 =L OBAIEZEH) %
ABDL, [OK]ZZ7 VU 7 LET,

Java Web Start Z 35121

a) [Run ASDM] % 7=1% [Run Startup Wizard] 27 V v 7 L £ 7,

b) T T ERFRENTEL, Va— b Iy bEaAYEa—XIRFELET, ATV a v
T, 77V =y a B RAETICHAS 2L TEET,

c) va— & v b5 Java Web Start &8 L 97,

d) BRINTHAT TRy 7 A>T, ERDOIEHEEZITANLE T, CiscoASDM-IDM
Launcher A F/R S FE T,

e) T—PHLNRRAT—KDT7 4 — L REZEDOEFIZL (FiA A2 —LDHA) | [OK] %
70 w7 LET, HTTPS BFEAHE SN TV ARWEAIEL, 2—PF4AB LIRS R—TIL

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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AT —FR (F7 /)L FTZEA) ZANLARWTASDMICT 7 AT&£9, ¥ : HTTPS
AEE A X — T M LTeE . — 4 CBEf T oAU — RE A LET, 8F
DHEHTRVGAETH, B A VEET (2—HFHET 77 DOFEFIZLRNT) 22—
K RAT—REANTHE, ASDMICE > TH—HILF—EZ_XR—ZAT—HRNF = v/ &
ET,

ASDM EI{EDH R A TA X

TATF T 4T 4iAEEL A A R—/L L TASDM X EFICEET 5717 T722< . ASDM & —
TAEVEBRKTAHZLELTEAED, LOVREWFAXDar 7 4 Fab—2 g Z0ET
FE9,

ASDMD7 A ToT4 TAEBHEDA VX =)L

Java 7 Update 51 LI Z 9 58546, ASDM 7 VU F ¥ IZIHEHE CTE DFEHENSMLE T, FE
HEOEMIL, HOBAMNEDOIDIAEHEL A VA M—/L 925 Z LI K-> THHEICH -9 2 &
NTExFET, FEHEELA A F—/L3 5 F T, Java Web Start 2] L C ASDM % @7 5 =
ENRTEET,

ASDM T 57 DIZ ASAICHCEL SN IDGEAELZ A A h—L L., JavaZfEH LT
SEHAE A BEET AICIE. RO~==2 T A ESZRB LT E S0,

http://www.cisco.com/go/asdm-certificate

ASDMO> D74 Fal— a3y AEYDEKX

ASDM THHR— F INDHRFRET A XILSI2KB T, 2OV A RE2B25E, 75—~
VADMENELDZENHVET, X a7 4 Xab—aron— FEHIE, %
TLlLlEar74X¥al—varyDEERAT—ZAXAL TRy 7 AIERINET, 20D
LEx A XORE VNI T 4 F 2l —arTliE, AADMIZE>TEFR a7 4 Falb—
a VOB THOI TV T, %TbtﬂAmﬁﬁﬁﬁtb BERHEIE N TS K5Iz
R2FET, ZOXIRRMAEAELZEEIZ. ASDM U AT A b —7 AE Y OB KZ B
HZEEHERELET,

Windows TOASDM I T s Falb—2 32 AEDEXK

ASDM b —7 XE U P A XEMWEKTHITiE, ROTFIEZFEITL T runbat 7 7 1 L EFREL
3
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Mac0S THOASDM 3> 7« ¥aL—> 3y 22Uk [

FIE

ATFYFT1 ASDM A VA =T 4 L7 FU (7z& z2IE, C:\Program Files (x86)\Cisco Systems\ASDM) (Z
BEIL £,

ATV T2 {EFEODT XA =T 4 X %fEH LT runbat 7 7 A LV EREL F7,

RATw T3 Tstartjavawexe] CTIHAEHITT, [-Xmx] DT VT 4 v 7 AR5 HEET L, BHO
bE—7 YA XERELET, 72& 2L, 768 MB DAL -Xmx768M IZZEH L, 1 GB DA
1T -Xmx1G IZEHE L ET,

2Tw 4 runbat 7 7 A NVERELET,

MacOS TOASDM O 74 Xal— 3> AEIDEK

ASDM bt —7" A& Y YA XEHERT 5121, IROFIEZ FEAT L T Info.plist 7 7 1 L ZHRE L
e

FIE

AT v F1 [Cisco ASDM-IDM] 7 A 22> %477 U »» 7 L. [Show Package Contents] Z &R L £ 7,

AT w72 [Contents] 7 # /L& T, Infoplist 7 7 A VX T NI ) w7 LET, BEBREY—NVEA LA F—
NLTWAEEIE, TANRT4 VRN IT42THEET, 9 TRVWIGEIE, TextEdit T
P& £,

AT 73 [Java]>[VMOptions] T. [-Xmx] OF L7 ¢ v 7 AN LRI ZEFT L, S8 e—7
YA REFRELET, 2L 2iE, 768 MB OHA1E-Xmx768M IZAE L, 1GB DAL -Xmx1G
WCEFELET,

<key>CFBundleIconFile«</keys
<stringrasdm3Z2.icng</string>

<kev=VMOptions</key>
<stringr-Ems6dm -Xmz5 12m|</string>

<key>CFBundleDocumentTypeas</key>
<array>

ATYTE ZOT77A Ry s EnNb5E, ROLI T —RNERENET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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The file “Info.plist” is locked because you
haven’t made any changes to it recently.

f If you want to make changes to this document, click
Unlock. To keep the file unchanged and work with a copy,
click Duplicate.

i_ Unlock | :_ Cancel | - Duplicate |

TEE4

ATY 5 [Unlock] #7 Vw27 L, 77 A VEHRFLET,

[Unlock] # A 7 0 73R 7 ANERSNRNGEIL, =7 4 X %4 T LE 7, [CiscoASDM-IDM]
TAar&E427 Y w7 L, [CopyCisco ASDM-IDM] 38R L C, EXALMERN H 550 (5
A7 Ny TRE) VT ET, E0%, Zoavt—rhbbe—7 YA XEEFELET,

TIHEREEFEDT 74U FERE

THHWREDT 7 4L REREEIL, YAIBH LWV ASA @A Lzay 7 4 Falb— g
<7,

cASAT FIAT VA BHHOA VA —T7 =2 A AT THEHFHEOFT 74+ a7 4 XK=
L—2a il o CTRESNDTZO, ASDMEHEA L CZ DA X —T7 oA AT LT
BREEFETTEET,

Firepower 4100/9300 v —3 £ ASA : ASA DA KT u £330 7 A X &R+
Llx, BHHAODA VZ—T7 2 A AITHMMEOT 74V h a7 4FX¥alb—Ta il
Lo THRESNATZD, ASDMEEA L TCZDA v Z—T = A ATHER L THRELXTET T
%iﬁ—o

¢ ASAV : NAN—=NRAPFIZE 5 TE, BAO—BE LT, EHHOA X —T = ZEA
HE WHOREEARE) Lo TRESNHTZD, ASDM ZHH LTI OA ¥ —
T AR L TRELYSE T TEET, 72— F—R"—IPT7 FLAHRETXET,
T, BREIIEUTC, [THHEMEEOT 740 b av 74 Xal—varz@l+sz
EHTEET,

cASASM : T 7 4V FREITHV ¥ A, I T 4 Fa2b—Ta L ERBET DI, ASA
P —EREV 22— a = )~DT AR (26 —) LT ZE N,

Firepower 4100/9300 > ¥ —3 D7 754 7 2B LN ASA DA, TEHHHEOT 7 4 L
FRET, V=T v R 7 74T U=V E—REIU TN arTHANE—RFOLTHEAT
XFET, ASAVOEES, BARFZ R T AT LY FE— RELIFL—F v RE— FEZRIRT
TET,
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\}

puEEoF I a0t

G¥)

TG fAEFD

A A=Y TrAne (BEN) T7408 ar74Xab—va iz, log,
crypto_archive/, 33 & U coredumpinfo/coredump.cfg 287 7 v > 2 AE Y NOIEHED 7 4 L& L
TZr7ANTT, 77y a2 AEFYNT, ZOHLDT7 7 A VDRI, A A=Y 77 A4 /LDH
fPe—BELRWEERHD ET, N7 7 AL, M T TNTa—=T 4 TITRILET
D, BEENBEELZZLEATTOITTESHY A,

TI74IL FEREDETT

ZOETHE, LHEHMEEOT 73/ a7 4 Xalb—a U EETT A HECOW TR L
%9, CLIB L U'ASDM DOl F O FNERFZEE STV ET, ASAv T, ZOFIHZETT D
L THEARENEESN, ASAT 7534 7 ZADOLEA LR U TERHAREOF 740~ 2
TJ4F¥al—varyNEpEsnEd,

GE)

&

ASASM THIffE DT 7 4L b a7 4 Xa b —a v End 5, RETHESNET,
THHWREDOT 74k a7 4 X2 b— a3 03dH 0 A, Firepower 9300 ASA 3=
T4 ED 22—V TlE, HAOF 74V s ar 7 X2 lb—3a o E2ETT 5L BIEREN
WEEINDETTT, 77408 a7 4Xab—a B2 HET5I00E, A—7U3F)
HASAZH D) —EEMTLAINENDY 7,

1R DRI

TOBEEIZ. V=T v R 77 AT U4 —L E— RCOMEATEET, hTFL AT LU
E—RDOYA., AV B —Tx2AADIPT RLARYR—FEINEHA, 51T, ZOHREIX
TN aAYTHFANE—RTOAMEATEET, a7 4Falb—arBr)T7rank
ASA 21X, ZOMEAMFEH L CRABMICRET 2EREA I TXAIRHY £H A,

FIE

THHWROT 740 b a7 4 Fab—rarzflulET,
configure factory-default [ip _address [mask]|
11

ciscoasa (config)# configure factory-default 10.1.1.1 255.255.255.0

ip_address ZfRETHHAIE. T 74/ FDOIP T KL A 192.168.1.1 24580 ic, B
FENOET G C T, W ERITEHA X —T =2 A ADIPT RLAZEELET, http =
<~ RTIE, BETAHAY 7Ry AEHINVET, [FAEEZ, dhepdaddress =~ > ROFaFHIL,
BELEY TRy FHOT RLATHR S ET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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ATvT2
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F7o. TOa~r R, bootsystem 2~ K (fFET 2586) Z#fioar7 4 X¥alb—g
LEBIZZ VT LET, bootsystem 2~ NiZ, A7 T v a AEY I—ROA A —T%
G, FFEDA A=Y bORENZ AIREIC L E T, HREOREIZRE L2k, KEIASA %V
B—RT5E AE7 T v a )‘%U@Hﬂﬂ@/l’% Vinb7—hLET, AT T via
AEVICA A=V R0 GE, ASAILZ7— M LERA,

T4V AT 4 Falb—rvark 77y va AEVIRFELET,
write memory

ZOa~wy T, FHIT boot config 2~ > REFRE LT, BIOEATZ%E L T\ il
%\%ﬁ:/74élv~ya/ix&—k7/72/74#;V~V3/®77¢wb@ﬁ
FHZRFEEINET, a7 4 FXFalb—varnz707&8nsE, ZORABE 7 VT ENET,

(ASDM TOFJE, ) AL ASDM T 7V r—rar v RUT, WEETLET,
a) [File] > [Reset Device to the Factory Default Configuration] DJIEIZEIR L F 5,

[Reset Device to the Default Configuration] 4 7 10 7' 7R v 7 ANRERINFE T,

b) (FFvar) FT7FALERT RLZ192168.1.1 ZEHT 50, FFHA L4 —T <
A A® [Management IP address] % A7) L £,

o) AFvar) FmyrFH o URX KD [Management Subnet Mask] % 38R L %9,

d) [OK] #2727 LET,

MERBHD I AT 0 7Ry 7 ARFRINET,

GE) ZOBMRIZED T— M A=V PEET DL EIIEOHT L. MOREL &b
\27 U7 S3vET, [Configuration] > [Device Management] > [System
Image/Configuration] > [Boot Image/Configuration] ~XA1 > CiX, AT LDA
A=TVEEL, FEDA A=V Pb 7 — M C&EET, HAREOREIZRE L%,
WEIASA Z Vv — R4 5L, WEHZ T v a AE DRPIDOA A—Vnb T —
FLET, WHIZ T v a AEVITA A—VRRWEE, ASAIZ7—FLEYE
oo

e) [Yes]Z27 U v7 LET,

) TIT7ANVIEREEZELLIED, ZOREEWNE T T v a AEVICHRFELE T, [File] >
[Save Running Configuration to Flash] %8R L £ 9,
ZOFTvareERT 5L UENCH ORIz EL TWLHHETH, FTar 7«
Xal—varRAY— T v 7 ar7 4 ¥al—3ar0F 740 sDOBFTIAREES R
F9, a7 4 X¥alb—var a7 V7 LESAE, ZORAL 7 VT SRTWET,

ASAv EARTEDETT

ZDIETHE, ASAV DEA (B0 H) FBEEEILT D HECO VTR LET,
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ATy

ATvT2

ATvT3

ATvT4

Asass06-X o —207 7+ hEE I

FIE

Tz VAN EAT O TLDIT, AL A EREOBRZYY £,

AR UNAIEBINT 77 4 T B Z &b T 572012, BRAEULZMLENH Y £9, EHIR
EANNTEEFICLESGG, 7774 7HBOREEZHETHE, R UANAEENT 77 47
RV ET, URIT 2T 4 7 Thol#EENR ) n— &, 72— A4 —"—=U 7% LT
HEpiasns &, HWREIIH LW 77 0 THEENG RIS, HEREARENMHESNL
£7

Vo — RBICEAREAXE L LET, 72— A —R—2ITH7-0IC. T 7T 4 THEETRD
avr REANLET,

write erase

GE)  ASAV RBUIEDIFATA A —V % T— T 5720, D7 — A A—VIZITRY £8
lo TEDT— A A=V ZMMHT 5121, bootimage =~ > REASML T 7231,

AT A4 X2 b —2 g VIHMEFELRNWTLSE SN,

ASAv z ) m—RL, HBAFRELZT— RFLET,
reload
T2 VA== TH DI, AZ AN EEOEREBEALET,

7T 4 TEROY n— K, AL S EROBREBALET, HABESA S 231 2
B SnET

ASA5506-X ) —XDT I7#4 I FEFE

ASA 5506-X U — XOHMEOT 7L hDar 7 ¥zl —3 g 0, RO EBY T,

» Integrated Routing and Bridging #%#E : GigabitEthernet 1/2 ~ 1/8 (X7 V v ¥ 7 )b—7" 1 IZFF
B, 7V RS 2 —T =4 X (BVD) 1

« NG -> AN ~D 5 7 4 v 7 7 11— : GigabitEthernet 1/1 (4}45) . BVI1 (PNE)
« DHCP DA IP 7 R A, NIEBIP 7 R LA : 192.168.1.1

« (ASA 5506W-X) WiFi<->WEO 77 ¢ v 27 Z7ma—_ WiFi->NE~D N7 7 4 > 7
7 1 — : GigabitEthernet 1/9 (WiFi)

o (ASA 5506W-X) WiFi ® IP 7 KL % : 192.168.10.1

s NEFB L ONWIiFi D7 T4 7 > M2 DHCP, 727 R KRA v MEKEZFDT T
DY FA T M ASA # DHCP #— & LTEEHA L £,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .



ASA5506-X > 1) —XDT T4l FERE

CEHLIA L E—T 2 A ARFEE L TWBEN, £ THROVLEAITR

ASA OBt |

ASAFirePOWER

EVa— Mt TS H =T 2 A AEEHLTASANER Yy MU — 27 1286 L. N

A H =T 2 A A AL F—Fy b~DF—+ A L THEHATEET,
«ASDM 7 7 & A : NEA A b & Wi-Fi IR A ORI ENE T,

* NAT : N#f. WiFi, BXOEHNLINEA~DTXTD T T4 v 7 DA F—T = A R

PAT,

DAy 4 Xal—vgiRkOa<wy RTHERINTWET,

interface Managementl/1
management-only
no nameif
no security-level
no ip address
no shutdown

interface GigabitEthernetl/1
nameif outside
security-level O
ip address dhcp setroute
no shutdown

|

interface GigabitEthernetl/2
nameif inside 1
security-level 100
bridge-group 1
no shutdown

interface GigabitEthernetl/3
nameif inside 2
security-level 100
no shutdown
bridge-group 1

interface GigabitEthernetl/4
nameif inside 3
security-level 100
no shutdown
bridge-group 1

interface GigabitEthernetl/5
nameif inside 4
security-level 100
no shutdown
bridge-group 1

interface GigabitEthernetl/6
nameif inside 5
security-level 100
no shutdown
bridge-group 1

interface GigabitEthernetl/7
nameif inside 6
security-level 100
no shutdown
bridge-group 1

interface GigabitEthernetl/8
nameif inside 7
security-level 100
no shutdown
bridge-group 1

|

interface bvi 1
nameif inside

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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security-level 100

ip address 192.168.1.1 255.255.255.0
|
object network obj anyl

subnet 0.0.0.0 0.0.0.0

nat (inside_1,outside) dynamic interface
object network obj any2

subnet 0.0.0.0 0.0.0.0

nat (inside_2,outside) dynamic interface
object network obj any3

subnet 0.0.0.0 0.0.0.0

nat (inside_3,outside) dynamic interface
object network obj any4

subnet 0.0.0.0 0.0.0.0

nat (inside_4,outside) dynamic interface
object network obj any5

subnet 0.0.0.0 0.0.0.0

nat (inside_5,outside) dynamic interface
object network obj any6

subnet 0.0.0.0 0.0.0.0

nat (inside_ 6,outside) dynamic interface
object network obj any7

subnet 0.0.0.0 0.0.0.0

nat (inside_7,outside) dynamic interface
|
same-security-traffic permit inter-interface
|

http server enable

http 192.168.1.0 255.255.255.0 inside 1
http 192.168.1.0 255.255.255.0 inside 2
http 192.168.1.0 255.255.255.0 inside 3
http 192.168.1.0 255.255.255.0 inside 4
http 192.168.1.0 255.255.255.0 inside 5
http 192.168.1.0 255.255.255.0 inside 6
http 192.168.1.0 255.255.255.0 inside 7

|
dhcpd auto_config outside
dhcpd address 192.168.1.5-192.168.1.254 inside
dhcpd enable inside

|

logging asdm informational

ASA 5506W-X OIEHIE. koa<r Ry EENE T,

interface GigabitEthernet 1/9
security-level 100
nameif wifi
ip address 192.168.10.1 255.255.255.0
no shutdown

I

object network obj any wifi

subnet 0.0.0.0 0.0.0.0

nat (wifi,outside) dynamic interface

I

http 192.168.10.0 255.255.255.0 wifi
!

dhcpd address 192.168.10.2-192.168.10.254 wifi
dhcpd enable wifi

ASA5506-X > 1) — XD T 7 AL FEETE .

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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B asass0sxs s U s6X DT T 4L REE

ASA 5508-XE5 L U 516-X DT 7 A4 )L FERTE

ASA 5508-X35 L TN 5516-X O TFHATREOT 7 4V FE%EIX, RO LB D TY,

« NEB -> FM~D N Z 7 4 » 7 7 v — : GigabitEthernet 1/1 (#+45) . GigabitEthernet 1/2
(PNEB)

« DHCP DA IP 7 RL A, NIEBIP 7 R LA : 192.168.1.1
Ny NU—F Ry NU—F DT T4 T Mk 5 DHCP,

EH A H—T oA ARBEEH L TWDN, £ 5 TRWEAITIARZKE, ASA Firepower
EVa— VL, ZOA L E—T =24 ZAEFHLTHNE Ry NU—27 128k L. ASADNES
AE =T 2 A AL F—Fy b~DF— 7= L L THEHTEET,

+ASDM 7 7 & A : NEBAR A MZEFRISNET,

o NAT : WEB L OVEFNOHER~DTXTDO T T 4 7 DA H—T = A A PAT,
DAy 4 Xal—vg kO awy RTHERINTHWET,

interface Managementl/1
management-only
no nameif
no security-level
no ip address
no shutdown
interface GigabitEthernetl/1
nameif outside
security-level O
ip address dhcp setroute
no shutdown
interface GigabitEthernetl/2
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown
|
object network obj any
subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface
|
http server enable
http 192.168.1.0 255.255.255.0 inside
|

dhcpd auto_config outside

dhcpd address 192.168.1.5-192.168.1.254 inside
dhcpd enable inside

|

logging asdm informational

ASA 5512-X. 5515-X. 5525-X B K U ENLED T I+ )L FERTE

ASA 5512-X, 5515-X. 5525-X LA TIFHMIFOT 7 4L M EIL, (RO EFBY TT,
« HHLA L H—T = A A : Management 0/0 (FHE) ,
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Firepower 2100 £ ASA O 7 7 A+ JL M ERE .

cIPT7 RL R : %7 N1 A1 192.168.1.1/24 T,

« DHCP V—/ % : HHIKR A b TIX DHCP V' — "0 X =TS TWAB T2, FHLA v
H—T A AP DB —HF 21, 192.168.1.2 ~192.168.1.254 DE DT KL AN
ELTHNET,

+ASDM 7 7 A : KRR MIHFRIENET,
DAy 4 Xal—vgikOawy RTHERINTHWET,

interface management 0/0
ip address 192.168.1.1 255.255.255.0
nameif management
security-level 100
no shutdown
|
asdm logging informational
asdm history enable
|
http server enable
http 192.168.1.0 255.255.255.0 management
|
dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management

Firepower 2100 LD ASA DT 7 + )L FERTE

ASA DERTE
Firepower 2100 D ASA @ TIGHMREDT 7 4 /L R EIX, kD LBV TT,

NS ->HAI~D N T T 47 Ta— A —FFxy M1/ UML) . A=y b12 (N
)

« DHCP DAMBIP 7 KL A, NERIP 7 R LA 1 192.168.1.1

« WERA v 4 —7 = A A LD DHCP #—/% : 192.168.1.20-192.168.1.254

« M58 DHCP 726 DT 7 4 )b b JL— k

EBLER 1 (FE) | IP T RLZ 192.168.45.1

«ASDM 7 7 & A : HHAR A MIFFAI SN ET,

« NAT : WD DANE~DT X TDO T 7 4 v 7 DA % —7 = A A PAT,

*FXOSEB NT 7 4 v 7 OBAMR : FXOS v ¥ — %, ASANGA v X2 —7 = A A L CHEH
NZT7 4T BB CTEET,

* DNS #—/3 : OpenDNS #— N d o 500 U ORI TWET,

DA 7 4 X2l —Ta IR0 avwy NI TWET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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. Firepower 2100 £ ASA O 7 7 A+ JL hERTE

interface Managementl/1
management-only
nameif management
security-level 100
ip address 192.168.45.1 255.255.255.0
no shutdown
interface Ethernetl/1
nameif outside
security-level O
ip address dhcp setroute
no shutdown
interface Ethernetl/2
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown
|
object network obj any
subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface
|
http server enable
http 192.168.45.0 255.255.255.0 management
|

dhcpd auto_config outside

dhcpd address 192.168.1.20-192.168.1.254 inside
dhcpd enable inside

ip-client outside

dns domain-lookup outside

dns server-group DefaultDNS

name-server 208.67.222.222 outside
name-server 208.67.220.220 outside

FX0S D&% E

Firepower 2100 0> FXOS O TR DT 7 4+ R EIX. RO LBV TT,
EEL /1 : 1P T R LA 192.168.45.45
T ITANNT =R Uz ASAT—H A X —T xR
« Firepower Chassis Manager 55 X OVSSH 7 7 B R - HH AR v T —27 )b,
« T 74/ hOZ—H4% admin, T 7 A/ FD/XA Y — K Admin123
«DHCP #—/3: 7 747 > N IP 7 R L AHiPH 192.168.45.10-192.168.45.12

e NTP #—~ : Cisco NTP #—~3 : (.sourcefire.pool.ntp.org, 1.sourcefire.pool.ntp.org,
2.sourcefire.pool.ntp.org

« DNS #—/3 : OpenDNS : 208.67.222.222, 208.67.220.220
A=V Xy P I BLOA—VFRy M12: A%
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Firepower 4100/9300 < v —> T 7 A+ JL b ERTED ASA .

Firepower 4100/9300 >+ — < T 7 # )L L EXE D ASA

Firepower 4100/9300 >+ —3 k12 ASA # &5 L7454, ASDM Z#flifl L THBIA v ¥ —7 =
A ASDERENARRIZ I 5% O/RT A —F ZHREETE ET, —BIeERIZIZR O E
B FET,

CEHA U H—T AR

* Firepower4100/9300 > % — 3 A— A ¥ L CERINIALBEOEHRI A T A X —
Tz A A

« ZA11X T'management]
AEEDOIP T KA
ctF2VUT 4 L0

o ERIEL

ML L H—T 2 ANDT 77V K J— K

cASDM 7 7t A : T RTCDOFA SNHFAEINET,

2R RTRY 2=y FOREIL, ROa~vy RCHERENET, 7 I92% 2=y FOBN
DRETENZDOWTIE, Firepower 4100/9300 ¥ ¥ —3 A— "L FNHLD 7 T AXOEN (517
N—=) EZRLTIEE N,

interface <management ifc>
management-only
ip address <ip_ address> <mask>
ipv6é address <ipv6_address>
ipv6 enable
nameif management
security-level O
no shutdown
http server enable
http 0.0.0.0 0.0.0.0 management
http ::/0 management
route management 0.0.0.0 0.0.0.0 <gateway ip> 1
ipv6 route management ::/0 <gateway ipv6>

ISA3000 DT 7 4L FEETE

ISA 3000 D LIGHMEEDT 7 4V PR EIX. KD EBY T,

c RFUART LU N T AT U —IVE—R: NTUVAXT LY N7 7 AT U4 —V3,
[Bump In The Wire| £721% AT NVA T7 AT U 4—)L] OLIITEETD LA Y2
T7AT A= IITHY, ERINTZT N, A~DONN—F Ky 7L LTRSS EH
Ao

ATV VRIBA v H =T 2 A A TRTDAN— A U H =T =2 AFFE LRy T —
JRICAELTOET (IP7 FLRAREFRRESATOEEA, Ry FT— E—HT 5

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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B saavo7or0rse

KIITHRET HDLENHY ET) : GigabitEthernet 1/1 (outsidel) . GigabitEthernet 1/2
(insidel) . GigabitEthernet 1/3 (outside2) . GigabitEthernet 1/4 (inside2)

c TRTONEHBLUINBA v F—7 = A AIHEBETEET,
EHL/1AH—T oA A ASDM 7 27 & AD 192.168.1.1/24
EH DY T4 T MIXtd % DHCP,

*ASDM 7 7 & Z : FHFHAR A MIFAISNET,

e N=RU =T NARRE, ROA F—T 24 A XT THHIT/R>THET,
GigabitEthernet 1/1 33 X T8 1/2, GigabitEthernet 1/3 33 L TF 1/4

A\

GE)  ISA 3000 ~DFEWMNBIWT S 4L, N— R =7 NA XX EF— R
BATT5 L, BETELDRERLOA L F—T 2 A AXT ORI
720 £, insidel & inside2 3 L N outsidel & outside2 ILiE{E T
RV ET, THLDA v H—T = A AWM OBAFOERE DN T
ThkbhEd, BEVFRAIND E, ASAR T —%5| &k
7=, BNV ERE TR S E T,

+ ASA Firepower £ = —/L : §XTD KT 7 ¢ v 7 73, Inline Tap Monitor-Only E— K DE
Va—VIEESRET, ZOET—RTE, T=4 Y THNTOR T 7 4 v 7 OEE
A R U — A5 ASA Firepower & ¥ = —/VIZEE SN E T,

s BRI~ v K 2L (Precision Time Protocol) : PTP k5 7 ¢ v 714, Firepower ®-E
Va—VIEREENERA,

Zoar74Xal—ya IROavy RCHEERIATWET,

firewall transparent

interface GigabitEthernetl/1
bridge-group 1
nameif outsidel
security-level 0
no shutdown

interface GigabitEthernetl/2
bridge-group 1
nameif insidel
security-level 100
no shutdown

interface GigabitEthernetl/3
bridge-group 1
nameif outside?2
security-level 0
no shutdown

interface GigabitEthernetl/4
bridge-group 1
nameif inside2
security-level 100
no shutdown

interface Managementl/1
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management-only

no shutdown

nameif management

security-level 100

ip address 192.168.1.1 255.255.255.0
interface BVIL

no ip address
access-list allowAll extended permit ip any any
access-group allowAll in interface outsidel
access-group allowAll in interface outside2

same-security-traffic permit inter-interface

hardware-bypass GigabitEthernet 1/1-1/2
hardware-bypass GigabitEthernet 1/3-1/4

http server enable
http 192.168.1.0 255.255.255.0 management

dhcpd address 192.168.1.5-192.168.1.254 management
dhcpd enable management

access-list sfrAccessList extended permit ip any any
class-map sfrclass
match access-1list sfrAccessList
policy-map global policy
class sfrclass
sfr fail-open monitor-only
service-policy global policy global

ASAv E A X TE
ASAv LIZ ASA #JRBH L7=456 . ASDM ZfEH] L TEBL0/0 1 > % — 7 = A ZA~OHE) 7T HE
DL DRI A—FZHTb > TRETEET, —KRIRBERITITKRORERH Y £7,
=T R T 7AT VAN T FELF T AT LV N T 7 AT U4 —LE—F
« Management 0/0 f > 4 —7 = A A :
« 481X Tmanagement)
«IP 7 N L A %7213 DHCP

e X2 UT 4 L0

EHRARNIPT RLADRAEZT (v 7 — bk (BEYT Xy b EIZROES)
« HTTP Y — O RN E 72 1T HEZ)
EHIRANIP T RLAHOHTTP 77 & &

« (A7 a3 ) GigabitEthernet0/8 D7 = — /LA —,3— VU > 7 [P 7 KL X Management0/0
DAZ A TPT RLX

« DNS #—

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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e Av— K T4V AID h—7 ¥~
e A — kK TARVADANL—T v b LULE L ONEREEET « T
« (A7 =3 ) SmartCall Home HTTP 7' 2 % 3 URL ¥ L VR — b
« (A7 a ) SSHEPRE :

e JTIAT L FIPT RLA

=R =Rl AV SV AN

s B—H) T —Z =A% T % SSH I ELRFRE

o« (A7 3 ) REST API DRI E 1= 13D

GE)

Cisco 8FEMIZ éﬁﬁ‘é X, ASAVEA LV Z—Fy 8 T BARMETT, £ X —
e FT?‘IZX’E;’% TL WZTA B AT DI, BARIGEMOBRENLEZ /RS
BB ET,

2B RT Ry 2=y MZOWTIE, ROBREFEZSR LTI ZE0,

interface Management0/0
nameif management
security-level 0
ip address ip address

no shutdown
http server enable
http managemment host IP mask management
route management management host IP mask gateway ip 1
dns server-group DefaultDNS
name-server ip address
call-home
http-proxy ip address port port
license smart
feature tier standard
throughput level {100M | 1G | 2G}
license smart register idtoken id token
aaa authentication ssh console LOCAL
username username password password
ssh source IP address mask management
rest-api image boot:/path
rest-api agent

T 2= —NR=RT7DT T4 <) 2= MIOWTIL, ROFEHEZM LTI,

nameif management
security-level 0
ip address ip address standby standby ip

no shutdown
route management management host IP mask gateway ip 1
http server enable

. ASDM 7y % 1: CiscoASA < !J—XASDM79> T4 F¥al—>ay A4 K (—lRALGEAE)
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5% E DAL

\}

zromn [

http managemment host IP mask management
dns server-group DefaultDNS
name-server ip address
call-home
http-proxy ip address port port
license smart
feature tier standard
throughput level {100M | 1G | 2G}
license smart register idtoken id token
aaa authentication ssh console LOCAL
username username password password
ssh source IP address mask management
rest-api image boot:/path
rest-api agent
failover
failover lan unit primary
failover lan interface fover gigabitethernet0/8
failover link fover gigabitethernet0/8
failover interface ip fover primary ip mask standby standby ip

ASA ZHRTELTCTE=HFTAHIT1E. ROFIEEZFEITLET,

G¥)

ATy T
ATy T2

ATvT3

ATy T4

ATy TH

ATvT6

ATy 717

ASDM TiE, HKRSR2KBOHREZVR—KFLTWET, 2OV A X52B2dE, RT3 —~
VADBENECAZERNHDFET, ASDM I 7 4 X2l — g2 AFYOBK (40 ~—
V) ESR LT TEEN,

FIE

Startup Wizard %5 L CTHIMIERE % 1T 9 1Z1%, [Wizards] > [Startup Wizard] % 3R L £ 7,
IPsec VPN Wizard % i F§ L C IPsec VPN #£#5i 2 5% £ ¥ 5 (Z1%, [Wizards] > [IPsecVPN Wizard] %
BIRL T, RSN DLAHE CHREZITWVET,

SSL VPN Wizard Z i L C SSL VPN 5t & a% &9 5 IZ1%, [Wizards] > [SSL VPN Wizard] % jg
RLUT, REINDEMHEHE CRELZITNET,

A E 2R —F ) 7 4 ICBT 2R EM AR ET D ITIE. [Wizards] > [High Availability and
Scalability Wizard] Z 38R L £ 7,

Packet Capture Wizard Zfi [ L T3 > § ¥ 7'F ¥ 2 ET HITIL, [Wizards] > [Packet Capture
Wizard] Z i8R L £ 7,

ASDM GUI THEHTE 2 3 F &L AX A NV EERT HITIL, [View] > [Office Look and
Feel] ##IN L 7,

BEREZ R ET 5 I2iE. Y —/L 23— [Configuration] R¥ > %7 U w7 L, W ORERER X
YE7YV v 7 LT, BT OIRESS AR LET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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B ssomcoa<s ks 1v8—T42 y—L0ER

(G¥)  [Configuration] Wi 2322 4 D &1L, ¥V —/L/3—"TC [Refresh] #7 U v 27 LC, HE[EHD

arvTF UV ERRLET,

ATY T8 ASAZET=HTHITiE, YV —/L/3—D [Monitoring| R¥ %7 ) v 7 L, HERZ %270 v
7 LT, AETL2E=FV T XA aRRLET,

ASDMTOHDIaAIR 2 KSAA B —TD AR Y—ILDE

H

ZOIETIX, ASDMEFEH L Ta~y FE AT 5 HEBS KO CLIOfFEH HIEIZ W TEB L
7,

AR RSIAAVEA—T AR Y—)LDER

ZOMEEIZIE, avr RE ASAIZKE L THRREZERT D, 7FA M=V — VR HE
éhfwiﬁo

CLIY— VL > TANAREZ 2 o~ i, 2—VHERIC K> TRV 9, A A ASDMT
TV r— a4 D FEICH D AT —H ANN—DER L~ LE BT, CLISEa~
RE2FITT DO EREEND D1 E I DEIER L TLIEEW,

4O SRS

« ASDM @ CLI Y — /b AS1T 5 a2~ Rid, ASA DG H —IF b A1+ 5a~
VREEMENRRLRDEENHY T,

s AT RTT— Bol ATIa~wr RIZL o T2 I —BRBE LS., 0 Tma~
RiZAX vy 7S, TOMMoa~> RIZAE S E 9, [Response] SEIKIZ 1L, oo BEElE
WELEHIZ, TT—NRELENEINCONTDERETRT A v E—UBFRENE
T

cAETIT AT AN R A ET I T 47 awr R, CLIY— LT FR— &
NTWEFTA, ZNHDa* REZASDM THEAT AI2IX, kOa~r RIORTEIH I
noconfirm *— 7 — K (FEH[EEZ2GE) 2#FEHLET,

crypto key generate rsa modulus 1024 noconfirm

c MOEHE L OFE ZAEE . HEOEHL PN ASA DFEIfTar T 4 Fal—varEk
Ty TR TEXET, ASDMOCLIY — /L Tar7 4 Xal—ia 2B ETLHEE
. T T 4 TRERYE Y a VIMIZARNWT EEFRNCHER L L E W, B0 —
PHRERFIC ASA Za%iE LT6 . mHTOEEDANT/ D £,
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ATy T

ATy T2

ATvT3
RTv74

ATy T5

ATvT6

ASDM (2 & > TEBE B3> ko714 2LToRT [

B U ASA CHUET 77 4 77 OEIY v > a v & FRxd 51X, [Monitoring] > [Properties]
> [Device Access] DIEIZER L £9,

FIE

AA L ASDM 77V r—3 32 7 42 R T, [Tools] > [Command Line Interface] DJIH|Z ik
WLET,

[Command Line Interface] %4 7 2 778 v 7 ANERINET,

WEpa~ FOZA 7 (UTERITEEIT) =R, Fry XU VA Mpbav R
EIBIRT D0, 3R RENTET7 44—V RiZavr REANLET,

[Send] #7 Vw7 LCa~wy REFEITLET,

FlLna~r K& AT 5L, [ClearResponse] &7 U v 7 L TG, T sMloa~r R
I (E71IAT) LET,

Z OREBEDIRIMEAF~NV 7 % F£/RT 5 1Z1%. [Enable context-sensitive help ()] T = v 7 R v 7 A
EANTLET, WRMKFE~NT 2T 4 =TT DL, ZOF =y 7Ry 7 AeF 71T
L/i‘j‘o

RE &AW L7-¥A01E, [Command Line Interface] 4 7 1 778 v 7 A% U7-141Z, [Refresh]
#27 J v 7 LTASDM TOERNFERRLET,

ASDM [Z L > TEREINZAT FDTINA A LETOERTFE

ATy T

ATy T2

B ORE

ZOMREIZE Y . ASDM Y AR—FLTWenwa<y ROo—E2F R TXE3, B ASDM
I, Thooavwry REEGALET, ASDMiZ, Ef7ar 74 Fal—varyolnboaw
VREAEE, BT EEHY FEA, IOV, MR- FERTWW RN R

(99 X—) | ZHRLTLIEIN,

FIE

AA 2 ASDM 7Y r—3 a2 7 42 R T, [Tools] > [Show Commands Ignored by ASDM
on Device] DIEIZEIN L E T,

SET LD, [OK]Z27 Vw7 LET,

A Y
%5 5 (D A
a7 4 X 2= a KL TR a2V T 4 R —DEFREMZTHEIE,. T XTOH L

WEERTTH LR 2 ) T AU =M S E T, BEFOERTIT, £ ORI ML S
TR CRIE SN TWEAR Y =D/ ANKAT SN E T, HWBIIHTT % show 2= KD

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .



B ssozezzoss

ASA OBt |

HAZEnwar 7 X2 —varZRBLTEY, BEICX> UIHWERICET 27 —#
NEFENRNZ ERXHY F9,

7mE 2IE, A v H—T = A AD>5 QoS service-policy ZHIFR L, EIEA— 3 v 2 FHE BT
%Y. show service-policy =~ > RIZiX, L Wh—EX R >—& 83 25 i & B
HAHTHNTND QoS WV X DAFRRINET, HHWARY U —DOREFOER X2~ M
MIFRR SN ERE A,

FTARTOHERDH LWRY P —ZMEEIEN T2 & 912, BHEOEREZMERL, HFLLARY
AL THERRTED LI LET,

2R 21213, ROVWThiroa~<y FEANLET,
* clear local-host [ip_address] [all]

Zoa~wr NiE, Bl RESCHEGEORIRR E, 7 I9A4 T NZEDT U Z A LA
F—NEBEOEELET, ZRICEY, Zoavr RiE. ZNHOHIEEFEH LTSS
RTOEERZHIRLET, SR T EOBREDTRTOREZF R H1201%. showlocal-host
all 2~ FZZRLTIEE0,

SIBERELRNWE, Zoavy ML, 8% %0) 57~ TO through-the-box #ft 4 27
7 LET, to-the-box#ific b 7 ) 7351213 BUEOEHY v a v 25Te) | ald—VU—
REMHLES, FFEDOIP T RLANGMAD T 585t a 7 V7T 521X, ip_address 5|
BAEMBHLET,

clear conn [all] [protocol {tcp | udp}] [address src_ip [-src_ip] [netmask mask]] [port src_port
[-src_port]] [address dest_ip [-dest_ip] [netmask mask]] [port dest port [-dest port]]

Zoawry RiE, TRTOREOER AT LET, BIEOT R TOHEREFRT DI
X, showconn =~ RZHBML T Z &V,

SIEERELRNE, ZOa~vy RET < TO through-the-box #fi 4 7 UV 7 L £ 7,
to-the-box #Efi H 7 V 71 5121X (BEOEHE vy a v &&T) | al ¥—TU— N& A
LET, EETIPT FLA, S5 IPT RLA, B—hF, 71 ha I ESOCHREDOE
a7 V7451, BERA TV a v ERETEET,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)



==
=% =R

ASDM Y S 24 A A—H A48 —Tx
4R

ZTDETIE, ASDM 2—H 4 v FZ—T = A4 ZADFEHHFIEICOWTEBA LE T,

¢ ASDM oo—H A L H —T = A Z|ZHONT (59 =—)
«ASDM 2—H f L H—T =24 ZADFEHF— g (62°—)
s A=a— (63 %—Y)

o« W — LN — (71 =)

* ASDM Assistant (72 ~X—3)

e AT —H A )R— (12 —=)

* Device List (73 ~X—72))

@R Z L (74 =)

e F—R—Kva—rhvh (753=)

« ASDM A > DIRFRIERE (77 ~—2)

o L—)L U A N OREHERE (78 X—)

cJEEA 7 UV —2 U= HR—FOHFMME (79 *—)

B T LA — (79 L—3)

« [Home] A > (Yo7 F—FREarsxAh) (794—)
s [Home] XA > (VAT L) (94 —2)

* ASDM X EDEFR (96 ~X—)

« ASDM Assistant TORFE (98 ~<—)

JBEA N v 7 OFE (99 ~X—)

e AR —FENTWVWRWnWa~<vr K (99 X—)

ASDM 1 —H% 4 >3 —J 24 RIZDWLT

ASDM o —H A v Z—T = A AT, ASADBYHR—FLTWAL S S ERMGEICfHEICT 7 &
ATEDLLIICEHEINTWET, ASDMa—H A U X —T =2 A AIFIROEERH Y £9°,

e Ty AN, V—b, U4 —F, BIO~NNANCTSICT I EATEDL A= 2 —"— A
Za—HHOEZLIZFEF—AR—Fa— Iy b ET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .



ASA OBt |
B rsoma—ssos—szazizo0T

« ASDM OHED T8 0D — )L s3—, Y — L= 5 [Home] <A >, [Configuration] <1
V. B X O [Monitoring] XA NZT IV EATEET, £/o, ~ITDOBREOAA O
B =g b TEET,

o N2 ZRHE7R 24O [Navigation] X >/, [Configuration] X > X> [Monitoring] 31 >
NOBENHEALET, ~v X —IlHB3ORZ L EFNFNI ) v I ThRE, _Mv
DIRFCETNFETT, BERIEER T 0 —T ( U T R U~DEE, ~A COHERE, F
723 A U E LB Z 3 TE £9, [Configuration] 4 >3 X U [Monitoring] ™1 127
7 AT HIIE, ROWTRNEFEITLET,

T TV =gy U4y RYDERICH B MO [Navigation] XA > DV > 7 %7
U w7 LET, BIR L7 [Content] XA > DX A RNR—TRANFRENET
([Configuration] > [Device Setup] > [Startup Wizard] 72 &)

o EWERRAD D> TWBEAE, MO [Navigation] XA > T 7 %7V v 7 L7
KTH, 77V r—var vagry FUOLEMINZSH S [Content] <A D F A [ L/3—
ICEEATITEET,

o 724l [Navigation] A > % FEFKR/ZRR T E % [Content] A > D445 & % [maximize and
restore] R ¥ >,

o K& 7 A[HE7: [Device List] XA >, ASDMINHT 7 BATE BT /N4 ADY A M &k
IRLET, "X —llhD3ODRZ L EEZNETNT Vv I TDHE, XA UOiKRILER
IXETT, BEIATREAR 7 0 —T 4 T R U ~DEE . A OIEFR . A
LD ZEMTEET,

B, BERAT—H A, =Y AETY RAT—H R FfTar7 4 Xal—T g AT —
A MERL~L, BEIORSSL AT —HX A&7 7V r—ar 742 RO FEICER
THERAT—H A )N—,

« 22l [Navigation] XA >, 77 A Jb—/L  NAT )L—/b, AAA L—/L 7 4 LK JL—
. BEOY—E 2 = VOERFFZ V=V T—T NV THATE IS E A7 V=
7 hEFRLET, A UHNDOEZT Z A buid, FRLTWAEEEICIS L TEDY £9,
F7-. ZDA 21T ASDM Assistant 23 F R S E T,

WO, ASDM 2 —% 4 v X —T x4 ADEFEEZRLET,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)



| AsA oBiss
AsDM 21— 1 > 8 —7 x4 xz2>0T |

1:ASDM21—% 4 B8 —T (R

¥ Clzco ASDM &3 forlASA - 10,10.10.
BHela

Sllz wae Jocs WlEmcis M nciv H
ﬁru-l*."‘;"ém .Jd.l[:_:rm..ll\, Ilii-.c‘-". nlla:l [
Maemwdnt o= ¢~ | sroHawabano Oiowal: ciCucs A . b oan e aa
b Sk Sh [Fa - mr @ 4 4 5L B nme e e Tk = A S )
& 1o i 7 = I RN el | u,
21 1o [} e =4 Fo 3 HETTET T Y LE T I:x
& 1240102 = il
A -z L LAk
— T A R A N1 ] RS T
sl - LT, [ - e - & L, —u -
¥ w Rl . TR R p e | s erbensan
_r:rtn: A 1 o s i ey B L. = a sk
SMEET | Bt izd g ek v e T enLombe e
ik ! b - . - LY i Lar. —i.
| By oenT e Ft1 el
1 - ol archeang 0 0 ply =S IT]
: Ll L ) bl @ L4
= L0 i e or
1 o [ PO TR EC T Y ) w' Iz
Z e - e - ar LA,
A A
< v
o & = ol e Dk 1 - vk
3 | aw | . -
a p 5 15 ] |eftl = e nnprHn == E

OO © ®

AR

GUI £% B

1 A= a— N—

2 BMR7 4 —/ K

3 Y — )L N—

4 FTer—rva R
5 [Device List] ™21

6 ERIOF S —g s ~R_a

7 \[Content\] ~A >

8 FROFEF— g 2

9 AT —H A /N—

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .



ASA OBt |
B sova—s51os—or12075—2a>

\}

G¥) w—JL v F2, [Wizards] . [Configuration] <A >, [Monitoring] <A >, AFT—H X /\—%
HGie, GUI O E S ERTDTITEMEINTNWET, Y—Ib B NEFRRTDHIZIE, vV ARE
AT =B AN=ZDHDTAALRE FFEDAZ—F A F—T oA ZAEFD LITEE T,

ASDM1—H A 33— x4 ANDFEHSF—T 3

ASDM L —H A X —T = 4 AZNWRONBEN T H7-0I12, RIOHTHIALIEA=Za— V—
NR—_ Ko XU a1 v B X OLEM &40 [Navigation] A > & #l A G doH T H
TEET, FHTE HHEEIX. [Device List] XA > D FDORK U A MIFERSNET, VR
MMINZIX, IROBERER X VDB A>TV AGEENRH Y 97,

* Device Setup

cTFAT AN

* Botnet Traffic Filter

* Remote Access VPN

» Site to Site VPN

* Device Management
FRSNOWRERZ DOV A ME, AL T A B ARBICESHWTRRSNES, 2~
T4 X2l —vary Ba—FhFET=4 7 Ea—0RR LIEEEOKRYI DA NZT 7

T AT AT, ENFNOREZ L EZ 7V w7 LET, A—Ab Ea—TlE, BERZ IXEFT
EH A,

PRRER 2 L OFITRELEZDHEIE, WOTFIRZFEITLET,

FIE

AT TN BEOHRERZY O TFICHDL Ry 7H T VA NRYZ U ERIRLT, 20 TF AR A=a—
FRRELET,
ATV T2 RONTNNLDOF T a v ZEIRLET,
s BN T DAY L HHELTITIE, [Show More Buttons] 27 U v 27 L7,
« FIRTDHARHZ WS TITIE, [Show Fewer Buttons] #7 UV v 7 L¥ 4,

« RZ U EBIMETZITHIERT 5121E. [Add or Remove Buttons] #7 V v 7 L, £/RrShizV
AR BIBMELIZHRT2RZ 227 v 7 LET,

« [Option] ZB&R3"% & [Option] XA T 7R v 7 ANRERIN, RE DU A NBBIED
EFCRREINET, KOWTINETRLET,

s YR MNNDORY % FIZBEIT 221X, [MoveUp] 227 VU v LET,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)



| AsA oBiss

[File] * =2 —

A=a— .

s YR MNNDORZ % FIZBEIT 512X, [Move Down] #7 U v 27 LET,

c VA NNOHEHDNEF%2T 7 4V FEREICRETIZIL, [Reset] #7 U v 7 LET,

[OK] %27 Vw7 LTREERIFL, XA 707Ky 7 AL ET,

ASDM OF A =2 —I21%, v~V AEIEF—AR—REHHLTT 7 EBATEET,

[File] A ==2—Tlt, ASADIL 7 4 Fal— a3 2FAMTEET,

[File] * =21 —I8H

B

Refresh ASDM with the
Running Configuration on the
Device

FEfrar 74 X2l —rarOat—2ASDMIZn— KL%
.d—

o

Reset Device to the Factory
Default Configuration

AT 4 X2 b—va E TGHAREOT 7 4V MZET L
9,

Show Running Configuration in
New Window

HEDFITary 74 FXal—arEZH Lnwg v Rk
RLUFET,

Save Running Configuration to
Flash

ETar 74 F¥al—varoatt—%27J5via AEYIC
TFEIABFET,

Save Running Configuration to
TFTP Server

HEDFITay 7 4 Xal—ary 771D at’—%TFTP
P—NIRIELE TS

Save Running Configuration to
Standby Unit

TIAVEBEOETa L T4 Fal—ary Ty A2
B—%, TJx— L —N— RZ U RAEEOFITaT 4
Xl —T g IEELET,

Save Internal Log Buffer to
Flash

NEHe 7 Ny T757% 7T v a AEVIRIFELET,

Deploy Firepower Changes

Y a— UKk L T{T> 72, ASA Firepower £ =—/L /K U
Ve DOREEEERIFLET, ZOA T alE ASA
Firepower £ =2 — /L& A A h—/L L C, ASDM CEHT %
LEICOHMEMTEET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .



ASA OBt |
B view x=2—

[File] # =21 —I8H B

Print BAEDO =T ZHIRIL 4, v—AZHRT 5556, ~X—
EREHMICT D2 2880 LET, Internet Explorer D355
3. BAME T T Ly NN U TR R CRIBIAE R 2

Bz bnTnEd,

Clear ASDM Cache 71 —H/L ASDM A A —T %HIBE L E£9, ASDM 26T 5
LOASDMICE D A A=V a— Aty ra— REnE
j—o

Clear ASDM Password Cache |# 1\ 2 T — RE2ERLTHIC., FREITERE L AMFZD N
AT = FREIES> TV DL 5EIE, ATV —FFyyvak

HIBR L £
Clear Internal Log Buffer syslog A v —U RNy 77 &2 LET,
’T ASDM z#PA L %7,

[View] A =1 —

[View] A ==2—TlX, ASDM 2 —% [ L X —T =2 A AD S F 8 E RN EFE R TEE T, H
TEDOE 2 =S CTRFEDHANRE RINE T, BUMEDO L 2 —ICRRTERWHEBILERTE

FH¥ A,

[View] * —21—IEH SiER

/—k_A Z]_\“—A t“;b—%%ﬂ——“ L/i‘g—o

$%7E (Configuration) Ly 74 FXal—vara—rFERLET,

Monitoring E=HV T Ba—%RRLET,

Device List Ry X ZRGERRA NZTF AL ADY X |
ARALET,

+FESY— 3y a7 4Fal—varyta—BIOE=H
Y > 7 B =2 —"C [Navigation] XA > & HK/RFE
TTFERTRICLET,

ASDM Assistant X A7\ Uiz ASDM O iiE D~V T %
MEL, ROTET,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)



| AsA oBiss

iew] x =1— [Jj

[View] * =1 —IEH

B

Latest ASDM Syslog Messages

AA— A B =2 —C [Latest ASDM Syslog Messages]
NA U EFRRETITIERRICLET, 2O
A 0F, F—Lh Ea—TOREATEET,
BHOV Y =T v 77— RT 5700
AEYDBRELTHDLEEIE, syslog A > E—
¥ %ASA-1-211004 ERL S H, A A b—b
SNTWHAEY | BIOMERAEY NR
SNET, TOAYE=IE, AEINT v
T — RSN DHET, 24 B Z L ITHER
SIET,

Addresses

[Addresses] <A ZRRETNIIERRIT L F
T, [Addresses] A E, 2T 4 F =2l —
v a Y B a2 —®@ [AccessRules], [NAT Rules].
[Service Policy Rules], [AAA Rules], LD
[Filter Rules] ~3A > CORMMHTE £,

Services

[Services] <A R ARFEITIEERTFICLE
9, [Services] XA L, 2T 4 F a2 b—
g B o —® [AccessRules], [NAT Rules].
[Service Policy Rules], [AAA Rules], 3L
[Filter Rules] ~2A > COREHATE £,

By i 5

[Time Ranges] ~A &R N FEICIFIERTITL
¥ 9, [Time Ranges] A1 (&, 27 4 F =
L—3 3 B2 —® [Access Rules], [Service
Policy Rules], [AAA Rules], 3 J O [Filter
Rules] A ' COREHTE T,

Select Next Pane

N IVFARA TR DA a R R L
F9, 72 & xIiX. [Service Policies Rules] ~A
VN ZEDEED [Address] A B EIL F
j—o

Select Previous Pane

VTS VB TTRIO A V& RFHFR R L
=7

Back ATDNA NZRY £,

Forward PIFNCER LTZRONAL 2 BE L E 1,

Find in ASDM FERES> ASDM Assistant 72 F OIEH # iR L %
R

Reset Layout VAT O T 74V D7 4 X2 l—

va IZRERLET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .



. [Tools] A —a1—

ASA OBt |

[View] * =1 —IEH

B

Office Look and Feel

EE D7 4 > b & 4% Microsoft Office 5% &\
EELET,

[Tools] A =1 —

[Tools] A ==—I%, ASDM T TE 5K O—HEDY — /LA L £,

[Tools] * =1 —IEH

B

Command Line Interface

o< K& ASA IR L THREZR R LE
7,

Show Commands Ignored by ASDM on Device

ASDM IZHEMH SN 7=V — b st o a~
KEFRLET,

Packet Tracer

BELFEEELT RLRAEAL L F—T oA R
MHIETEET, Ny hE ML —ALET,
v harltBIOR— T —4% ¥4 7T
bR BETE, T CETINALED
PR — X STy N O—TE& A R
TEXET, HMlcHOVWTIR, 77 AT T —
IWORREHTA RS LTI,

ping

ASABLUOBRT2WE v/ Da 7 X
L—y g UREEEREEL . thoxRy FU—
I TN ADIERWN 2T A N EFATLET,
PR OWTIE, 77 AT U — IV OREN
A4 REZBLTIEEN,

traceroute

2N NIRSEIEICBIZE T D FE TOL— k&
BriFEd, FEM>WTIE, 7747 Ut —
NDFBRETA R LT IEEN,

TJ7M4ILER

7Ty va ARVIRESINZ T 7 A VEER
R, BEh, avr— BXOHIBRLET, £,
77y va AEVICT 4 VT MY EERT D
b TEFET, Fo. TFIP, 77 v o A
EFY, B—ANPCHREIETIERT AL
VAT LITT 7 A MREN TE E T,

Check for ASA/ASDM Updates

AP —FEHEHLTASAY 7 F =T Bk
WASDM Y 7 "7 =7 %7 v 77 L—RKLZE
7,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)



| AsA oBiss

ools] x=1— [Jj

[Tools] A =1 —IEH

B

Upgrade Software from Local Computer

ASAA A= ASDM A A —, Fioldz—
PFPCOMDARA—THT T v a AEVIC
Ty Fa—RFLET,

Downgrade Software

BWAEFEITTOLD LD HHWASAA A—T%
o—RLET,

Backup Configurations

ASAD =7 4 F 2 b —13 3, CiscoSecure
Desktop f A —3, ¥ XV SSL VPN Client
A—=VBIOT0 Ty ANENRNyTT v L
e

Restore Configurations

ASAD a7 4 F 2 l—3 3, CiscoSecure
Desktop £ A —<7, ¥ J ¥ SSL VPN Client
A—=VBIOTun 7 s AV EEITELET,

System Reload

ASDMZHEFHL, RFLIZa 7 4 F a2 b—
varvEAEVIZUne—RKLET,

Administrator’s Alert to Clientless SSL VPN
Users

EEEN, 7 T4 T b L ASSLVPN 2 —+
79— hF AvE—U%%EETESL91ICL
F9, FEMICOWTIX, VPN T A R&22
LT EEN,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .



B wizards) x =2 —

ASA OBt |

[Tools] A =1 —IEH

B

[Migrate Network Object Group Members]|

RILIRICHATT D556, ASAITAHIfTE xR v
NTD—2 FT7 V=7 FEERL T, —H O
HEOA L TA L IPT RLAZESHZET,
AT EA TV =7 MTIMA T, ASDM (I =
Y74 Xal—varyTHEASR TS TR
TOIPT FL AR LTARIR LA T V=
NEBHERICER L ET, 2D 0 HEMER
INDHZAT V=7 MIIPT RLARIZK->TO
R S A, LRI IR, TT v M T A— A
RECAHMTEAT V27 e LTIFEEL
FHEA,

BATO—E & LTARITE ATV =7 b2 ASA
PERLT 256, 8T 24T & ASDM
HHAT7 V=7 M, AR EAT V=7 b
[CEBINET, ME—0BiNT, *y FU—
I XTIl N IN—TDOIELRIE AT
V7 FTY, XYy NIV—=I ATV NS
N—TRNIZHDIPT R ADARIMTELT
V=7 b ASADMERT 585, ASDMIFIE
ARt EA T2 NEMFF LI E £, BE
L7eA7 Y =7 b ASDM TIERR L £, =
NEDOAT V=l Ne~—UF 520, [Tools]
> [Migrate Network Object Group Members] % 13
RLUET,

FEMEZ DWW TIE, [ Cisco ASA 5500 Migration
to Version 8.3 and Later] 2L T 72XV,

TYVIF7LUR v a VETOREE D ASDM BERE DB E %
EHRELET,
ASDM Java Console Javaa Y —)VE R R LET,

[Wizards] * — 21—

[Wizards] A == —I|2k bV, SESIEoiEs

BET DY 4 P FEETTEET,

[Wizards] * =21 —IEH

B8

Startup Wizard

ASA O TE % BRBERIZ T A RLET,

VPN Wizard

SFESERVPNEREHOY 4 F— KR HES
NTWET, FERICOWTIL, VPN R A
REsR LT 7EE,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)



| AsA oBiss

[Window] A =1 — .

[Wizards] * —1—IEH

B

High Availability and Scalability Wizard

7 2 A N DOFBGENAREIC A2 ) T
VPN FAH u— RNZ v JEIZITASA
EDASA 7 FAHBY T

Unified Communication Wizard

ASA LT, IPEHFERED2Z=T7 7 Fala
== a UEREDORENAIREIZR D £77,
PRI OWTIE, 77 A T U A — IV OKEN
A4 FESHRLTLIEEN,

ASDM Identity Certificate Wizard

Java 7 Update 51 LM 2 256 . ASDM
T F X I IHMEETE DREHE NP LE T,
AEAEOEMRL, HOEAN EDOIDFEHEL
A VAR—=NT DI LI Lo TREICHZ 9
TLEBRTEET, 2OV 4P —FEEMALT
REEAZ A A =)L T % F TlE, Java Web
Start Zf#i[] L T ASDM Z B35 Z L A Tx
F9, FEMICOWTIE,
http://www.cisco.com/go/asdm-certificate % 2Pt

LTS,

Packet Capture Wizard

ASA ET, "oy b Xy IF X OFKEN AIEE
R0 ET, ZOU o F— R, A1~
B —T A ADFNENT/NT Y Ny I TFx
ZIEFATLET, F¥ 7 F v DETHE, v
TFxEara—XIRfFL, Xy R T
FTIAVEFRH LTy 7Ty 2REBLIO
IHTCTEET,

[Window] * — 21—

[Window] A ==a—%fH LT, ASDMD Y ¢ > RUBEBEICEXES, 77747y 1
ROPRBEBREINT =T 4 R E L TERINET,

[Help] A == —"TiX, A2 TA > ~NT~DVY 7 OfIZ, ASDM & ASA OIFH biRfkSh

£,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .


http://www.cisco.com/go/asdm-certificate

ASA OBt |

. A=a—

[Help] * =1 —I8H SRER
Help Topics LT T oW w0 RUMREWTASDM O

T T4 IVTRERSINET, ASDM T
ASAFirepower &Y = —/LEEFIH L TWDE5E
X, Z ®OIEAIZ [ASDM Help Topics] &5 7
NUPERINET,

ASA FirePOWER Help Topics HLWT I W v RN T, ASA
Firepower & ¥ = — /L DAL T A Vo ~ILTHRFK
mENET, ZOHHAIL, ASDM TEY 2 —
NaA ARV L TEBRLTWDOHAICE
FEATE £,

Help for Current Screen FREN TV D WEIZEET 2 KK FE~Vv T
NEFET, I 2227 Vv THZL
TEET, V== [Helpl| R¥ >,

Ji)—x /—Fh Cisco.com (T & % Fc#/3—2 3 D [ASDM
release notes] P& £9, VU —R /— kT
i3, ASDM DY 7 h 7 =7 bn— D =T %
HORFIEHR, BLOY 7 by =T EHTIZH
T HRAIE RPN TOET,

Cisco ASA Series Documentation AFARER TN TCoOME~=a2T L ~D Y
7 & e Ciscocom F D R o A M= F
ﬁ‘o

ASDM Assistant Ciscocom/»H A U m— Ru[gglpa sy

B CTX, BEDX A7 OFEITICET 53
#2375 [ASDM Assistant] % B & £ 97,

About Cisco Adaptive Security Appliance (ASA) | V7 h v =7 N—T g 0 ~N— R = THERK.
AR =T vy TR — REhdar7 1 ¥=
L—yar 77ANRY T N =2T A A=
mE, ASAICHTOEHER T LET, Zh
DTN T T NY a—T 4 v T ORI O
T,

About Cisco ASDM VI N7 N—Tar . AR N, HERL
N, ARV —=T 4 T VAT A, TA A
H AT, Java DX— g 72, ASDM (21
ToHHEHREETRLET,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)



| AsA oBiss

v—nri— |

W—)L/\—

A= —D FIZHAIY—ILIN—0nH, A—AL Pa—, a7 4 FXal—ar Pa—, BXL
WNE=Z Y T Ca—llT77BATEET, /2, AT 2 TFANE—FTUVRATLL
X2 VT4 I THFRAMERNLEZD, TS —va BRI EHT HREEZSE
TTEET,

Y—JLIN—RE ERBA

R—L A EB—=T 2 A ADAT—H A, BITHDOR—=a v, T4 R
W, NT AR E ] ASA DEBERERE KR TE S [Home]
A EFRRLET, vV F T— FDOEA, [Home] XA ViddH v £
}\Jo

FX%E (Configuration) |ASA Z##%7E L £, AMO [Navigation] <A > OERERZ > %27 U
7 LTHEREZ R E L E T,

Monitoring ASA ZE=% L %3, D [Navigation] XA > DIEFERZ % 7
Vw7 LT, SE8ERhEHELPE=FZLET,

Save BXADLT JEANRHEER I LTI AMIBEY, F47a 074X
L —YavhAZ— R v ar7 4 ¥al—vare LTHREL
\iﬁ—o

T34 A 112 ASA FirePOWER £V 2 — /L3 A U A h—/LENTH
0. ZiE ASDMRH TEE L TWAEEIE, 2 DR ¥ (2 [Deploy]
REANEEHL ONET,

R RE F 84 A 12 ASA FirePOWER E ¥ 2 — /LA v A F— L ENTH
V. ASDM %k THIE L T 5%E1%, [Deploy] 7% 13 [Save]
ZokEEZ, WOX T v arvbEghEiqT,

* [Deploy FirePOWER Changes] : & ¥ = —/LIZx3 5 ASA
FirePOWER £ 2 —/L R U 3 —~DRELEF 2R 1FE L E£7,

* [Save Running Configuration to Flash] : ASA /727 f ¥ =2 L —
varPAav—x7Jyvva AFRVICEZALET, ZhiL,
ASA FirePOWER & ¥ = — /L & & £ 72T /34 AD [Save] KX
L FRI%ETY,

Refresh HEDODETa L 74 X2l —2 a3 TASDMEZ U 7L vy a2 LET,
7L, FE=Z VT XA DT T 73 7y LERA,

Back ERTZZF7R L2 ASDM O~A SIZEY £,
Forward HERNZER L7 ASDM D2 A R FE T,
Help Z OB TERRENTW D EEOIRIKF~L T2 FR L ET,
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. ASDM Assistant

ASA OBt |

Y—ILIN—RE > B

BE®R ASDM AN CHEREZ MR L 97, MERIEREIR, A DX A P i
Nfﬁﬁbf BHEEHARRLET, M=V T2 7735

YA N BICERRSIVE T, [Back] £ 7213 [Forward] %
7)/7?5&\ﬁﬁbtzo®&4y%¢ﬁ%<@0§iézkﬁ
TEET,

ASDM Assistant

ATy T

ATy T2

ATvT3

ASDM Assistant TlX, Z A 7125 U7z ASDM O HFEO~LV T2 HRE L, ERTEET,
TOMEEIE, VUL AV TR ARNEVATAILTFANDOL—T v R E—RBLIONT
VART LU R E—RCHHTEET,

[View] > [ASDM Assistant] > [How Do 1?] DJIHIZEIRT 57>, A ==2—/3—0O [Look For] 7 ¢ —
VRINHLREY 72 A MEASILTHERICT Z7®8ALET, [Findl RRy X7 U X MG
[How Do I?] Z i8R L TR #BltE L £,

ASDM Assistant Z 351213, WOFIEEZFEITLF T,

FIE

[View] > [ASDM Assistant] % 3R L £,

[ASDM Assistant] XA V' NFRRIIVE T,

[Search] 7 ot —/V IR T 21EHMAEAT L T[Gol &2 U v 7 LET,
FR SN 7B [Search Results] ~5A NI F R SHVET,

[Search Results] fEIkFS K O [Features] FURIC R R SNAEEDOY > 7227 U v 7 L, sE0TE®
T AFLET,

AT—HR R IN\—

ART—RRAN—IZADSM ¥V 4 > RUD TEFICEREINE T, ROFKIZ, ENLHICERIN
HEEE AR L E T,

)7 5 BA
Status (R T—% R) AT 4 X2l —TarDAT—H A
( MDevice configuration loaded successfully.| 73
) .
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Connection to Device .

Ty7r BL)]

Jx—I)LA—/\— T rx— VA —R=MEEDODRT—H AT, T
T4 T ETNTAZ XA DUVNTID,

1—H4% ASDM 2 —H D2 —H4, 2—HF 471 Th
TA v LIgE,. 2—V41E Tadming T,

User Privilege ASDM = —H DR,

Commands Ignored by ASDM TAarE s Uy r3T5L. ASDM THLEE X

Nppol-ary 74Xl —yagroavy
ROURSNRERENET, ZNHDa~<
Ridar 74 X2 —TarhbliRang

A,
Connection to Device ASDM @ ASA & DA T — X A,
Syslog Connection syslog #EREDNEIE L TRV . ASA BEERHL S
SSL Secure ASDM ~D#EGEICSSL 2 L, Z#eThD
ZEERLET,
Bl ASA [TRRE S TR,

Connection to Device

Device List

ASDM [T ASA & O % 5 IZHERF L. [Monitoring] XA >3 X U [Home] A > DT — X %%
BB ET, ZOXATRITRY 7 AHEHAT —F ANREREINET, a7 Fal—
TavEERETARS, FELTWAR ASDM 13854 b 5 — X, ZENKDLLEEFD
B a2 U ETN, 20X T el Ry 7 AL 2 DAOERIIR RS NE T A,

[Device List] i% K> F > JA[RERSA T, N~y X —lHDH3DDRZ o HENZENT U >
7355HE XA UDOREKICETITE L, BEARER T e —T 4 TSN U ADEE, XA D
FEERE, FHREFAA EALDZENTEET, ZOXS FF—L, 2T 4 F2b—
Tayv, F=FV Y BIXOVATADOZ E a—THATEXET, Z0OA &AL T,
BOTNA AZYDFEZ T2, VAT AEayT XA MNITYUVEZ TN TEET
N, BIEEITTO LD LR U N—2 9 D ASDM BNZFDF 34 ZTHEWEL TWAMLENR S
DET, A UEZRIIRRT DI, DR EBL2DDTNAARNY A MIRRINTWND
VERHYET, ZOXA 0%, v arTxA s, wAF arTFARBINY AT
AaArTXANONLV—T v RE—RBIORN T AT L N E— RCHEHATEET,

ZONA EFERLTCHOT NA RTERT D121, WOFNEEZFEITLET,
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| ST

ATy

ATy T2
ATvT3
ATy T4

ATy TH

HERE D

FIE

ASA DEa

[Add] %27V » 27 LTYU R NMIBIOT A ZA%BIMLET,
[Add Device]l ¥4 7R TR v 7 ANREFRINET,

FRAZLEINIT AL ZADIP T FLAZANL, [OK] %227V v LET,
URABPBIER LT A ZAZHIBRT H121%, [Delete] 227 U > 7 LET,
[Connect] #7 U v 7 LTHIDT NSA AT LET,

[Enter Network Password] # A 7 1 7' 7R v 7 ANFR I ET,

2—PHENRRAT = REFEUTLHT7 4 — /L RIZASL, [Login] 7 VU7 LET,

%< D ASDM 21 21E. ROFBITRTRAZUDBDEENTWET, HIOIEXE2=TT5IC

E. BT HREZE ) v LET,

RE £BA

Apply ASDM TOEENE % ASAIZEF L, FEfT=
V74X 2L —Ta U ZEALET,

Save FITar 74 Fal—varyOat—w7Iy
‘:/3— }:‘E‘U L:%%@Ai—g—o

Reset EHRNKEMFHEL T, ZHEAT, F721X [Refresh]
R [Apply] Z & IZ 7 Y > 7 LIRER O RRIE
WK LET, [Reset] &7 VU v 7 L=tk
[Refresh)| #2 U » 7 LT, BIEOFET= 7 ¢
Xal—a  OFRBERINTNEI L
FHERLET,

Restore Default BIRLE-RTEEZ VT LTT 740 PREI
RLET,

Cancel ERERRNKZWEEL T, A0 AR £,

Enable FEREIC DWW TRt A B D B O FHE A2 For
LET,

Close W TWAE AT a Ry 7 2L £,

Clear 74—V K BIEREHIRLET, £7203.

Frv IRy I AEFTIZLET,
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£

—R

f—k—rva—trvt |

Ra> s BA

Back RIDASA TR £

Forward WD_A BB L £T,

Help BINLEAA VEFZFAT R I Ry 7 A%

ForLET,

—ka—rAy b

F—R—FEHEHLTASDM 2—Y S v Z—T =2 A% T EHF— FT&ET,

IROEIZ, ASDM L—H | L 4 —T = A ZAD 3 DO FEF A 2 B84 % 72 0166l THE
R¥F—R—Rva—thy hO—EERLET,

R2AAY T4V EIADF—R—F a—t+Ay b

RIRXR Windows/Linux Mac0S

[Home] A+ Ctrl+H Shift+Command+H
[Configuration] ™= > Ctrl+G Shift+Command+G
[Monitoring] ~-1 > Ctrl+M Shift+Command+M
Help F1 Command+?

Back Alt+7E%H] Command-+|
Forward Alt+4 RH] Command+]
NN A = F5 Command+R

Cut Ctrl+X Command+X
Copy Ctrl+C Command+C
Paste Ctrl+V Command+V
a7 4 X2 b—3aroff |CultS Command+S

7

Ny T A=a— Shift+F10 —

vhHUHY v KU EFL |AlttF4 Command+W

%)

Find Ctrl+F Command+F
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. F—R—ka—thvt

ASA OBt |

FRNE Windows/Linux Mac0S

T Alt+F4 Command+Q
T—T7I)VETILT ¥ A NMEM | Ctl_Shift F 721X Ctrl+Shift+Tab | Ctril+Shift F 7213

DT Ctrl+Shift+Tab

WIZRIZ, _AVNEBOFT B —v a3 VICHEAATEERF—AR— K a— by ho—EZRL

£,

RIRAVADF—R—FK a—t+tAv b+

T+ —HRADEENE F—
WD7 4 —V R 27
BiD7 4 —L R Shift+Tab
WDT7 44—V E (F—TNVRNIZT +—H A7) | Ctrl+Tab
HDHHE)

HiD7 4= K (F—FVWNIZT 4 — 5 A | Shift+Ctrl+Tab
HDHHEE)

[Next] # 7 (X727 =W ANHDHLGE) | 4KH
[Previous] # 7 (X 77— ANH D | L£KH
)

T —TILNDORDE IV e

T — 7 ILNOFIDE IV Shift+Tab
WDRA 2 (FEOA vinForEnTng | F6

e

Ao v (DA R FREN TS | Shift+F6

50

ROFIZ, Log Viewer TEEHAIREZR ¥ —A— K

R4:OJE2a—TOXF—R—Ka—thyt

Ya— My FO—EERLET,

Bt Windows/Linux Mac0S
Real-Time Log Viewer ¢ —ffz | Ctrl+U Command-+
136 L UHERE

gy RNy 7y Lrnl) 7 |F5 Command+R
Lo
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asom <1 »omziss: [

B Windows/Linux Mac0S

Clear Internal Log Buffer Ctrl+Delete Command+Delete
WRL7-n s = FYoa  |[Cul+C Command+C

B —

a 7 OEAE Ctrl+S Command+S
Print Ctrl+P Command+P
vhLoFY 4 Ry AL |AltHF4 Command+W

%)

WDOFRIZ, Ama—THB~OT 72 AERHIRERF—FR—Fa—rbhy hOo—&2RLE
j—o

K5 AZA—BBICTVERTHEHDF—FR—F a—+Aay b

T EARE Windows/Linux
A= a— N— Alt

DA = 2— FEPNEL

RO A = 20— s SEL
WKDOA=a—FT vz PSEL
AIOA=a— AT g NS NE]]
BRLIEA=2—F T g Enter

ASDM XA > DIRFEHERE

—HBD ASDM A 21T, L DEHREFFOT—TARNEGENTOET, BEOZ M) &
FHLIC IR I L OSEEZOR L CTIRET 572012, D ASDM 21 (2id, Zh b1 v
NOF TVl NeRBTEHRBIEENEENTOET,

WMBAEFATT DAL, [Find] 74—V RIZ7L—RX% AL, BEDXA L NOTXTDH
TLERBTEET, 7RI VANRKI—RLFD [*) BLO 2] 25D LNT
TET, IO EOTEE L, 210X FE—HLET, [Find] 7 4 —/V ROAIC
HDHERMETFRANZHFEALT, & (L) £720E367 (F) o7 Lb—XoHBLUIBEIL £,
[Match Case] = v 7 AR v 7 A& AT 5 & AT] LT KIUFEB L OV CRICEREIC—HT
LTy b BB LET,

7z & ZIE B¥ton-L* E AT DH L RO—HERIRSNET,
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B vz ronzme

IL—IL 1) R

ATy I
ATy T2

ATvT3

ATy T4

ATy TH

ATvT6

ASA OBt |

Boston-LA, Boston-Lisbon, Boston-London

Bo%?on & A1 T 5 &, RO—HNEINET,

Boston, Bolton

b DIRFR B EE

ACLX° ACE BLOZEDOMDON— TS ESERIA TOLEOBERNEENTNDHTD,
NV EFIRT DAEE DA ORRERERE TlX, DA  ORBREEEL Y b IR EK - T2
REFTCTEET, ZZE, 778A L—)b, =X R Y I — )L—/L ACL Manager,
ACL V=1V % —BFRRTHEDOMDONA ) BIRNAT L — b EENET,

= U A MNTEZZRAET D121, ROFIRZETLET,

FIE

[Find] 227 U v 27 LE7,
[Filter] 7 4 —/V R T, Ry X7 VR RINNLIROLTT > a O TInERINL E7,

BRATRERE AL, V= XA T IZK-oTELRY , ZOFNTHHELTWET, o7 4—n1
R Z&Af 4 D M R A BT D5 E 13, [Query] 2R L £,

[Query] Zi®IR Lo 12 A/1E, 2FHDO 7 4 — /L RT, Ruy X JARDLROWD
TNNDA T a U EBIR LT,

o [is] : MBXFINCH T D —HERELET, HEEICZ7ZY047 v a T,

* [contains] : FREESLFHNDO—BE I IT BB E BZTALEONL— T 5 —BAEFRELET,
3FHOTZ 4 — NV RIZ, MBETIXFHNEATILET, B Vo7 T25E, VARNNPLET
Vxl heBRTEET, 72U EFEHLTWDEEX, [Define Query] #7 U v/ LET,

IP7 RLVAZRET 2551, ASDMIZ Lo THER SN A T V=7 NEIZZNV—T7Th
LRV, Ry NT—7 F TV FEFRIZINA—FHNOT RL AT 504G T F
T, DFEV, ZL—T74X DM INLINE THAE Y £7, BRBEKEERILZ, =2 —F2MERLI=A4T
PV FNDIP T RLAERBETEXEH A,

& F4T79 HI12IE, [Filter] 27 V v 27 LET,

Ea—NEHI, BTAIV—NVOBERERINET, L—NAFZX, L—N TR NHNDIHE
RINLEEFERTED LIRS E T,

[Clear] 7 U w2735 &, 74 NMEZDBHIRSNL,. VA NEAFERRINET,
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ATy 717

mEz s y—> u—4 yi—roant [

FET LD, READxEZ 27U vy 7 LTHREKay he—LZ L £,

Wik AV )—2 ) —5 HiR— FOFEMIE

ATy I

ATy T2
ATv73
ATy T4

T 74V R TIE, Tab ¥ —EW LTSV NEBEITH L X2, T-ULERBILY 7 0B85
MBS ET, JAWSDO L 72— DA V—2 V=K1, 74— AD & 5 A
TVl NegmA R0 T, EEAZ Y —2 V=X YR — b e X—TNIZTDHE, TUL
EHICL X T EBESES ZENTEET,

PRA 7 V=2 J—=F HR— b oA X =T M HITIE, ROFIEZFEITLET,

FIE

[Tools] > [Preferences] DJIEIZEIR L £ 9,

[Preferences] ¥ A4 7 B 7R v 7 ANFRSINET,

[General] % 77 @ [Enable screen reader support] = v 7 Ry 7 A=A 12 LET,
[OK] %7 Vw27 LET,

A7 V= V=F P R—= &7 77T 4 72T HIZI1L. ASDM & iHEE L E7,

BIBRAIAILY—

A7 4Falb—Tary Ba—BIlRE=FY T Ea—DF S —var Xf UIZEEN
H—O7 FNFIIE, BHEffTFonzar7 s Falb—ar XM UR0E=F Y T A
VIRV ERA, INOLDOT A NFE, BET AT 4 X ab—Ta LV FRIRE=H Y
T HRAY BT LEDIEHALET, N0 T7 4V EE7 Y v 7325 L 50D [Navigation]
RANZHTHAOY A MBRERINET, FPTHAOLAFIEZ Y v 35 EZOHEAICEE)
TEET,

[Home] R > (VT I E—FEQAVTEREN)

ASDM @ [Home] A > TlE, ASA IZBT 2 EHEREHRAF R TE LT, [Home] A DA
T2 AERITI0MHBCREFRT SN E T, 2D 1 ITITl@% ., [Device Dashboard] & [Firewall
Dashboard] ™ 2 >D % 70350 £,

IPS EY =2 —/, CXEY =2—/l, ASAFirepower T 2 — /L7 EON— Ry =7 £721LY 7 |
TxT BV a— VRTINS RZA VA =L ENTWAEEIE, TNEHOZ TRERINE
bd_‘o
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. [Device Dashboard] 2 7'

[Device Dashhoard] &2 7

[Device Dashboard] # 7 Cix

> A

ASA OBt |

AVE—T A ADAT—R X FITHROAA—Ta . TA4k

W DX, [Device Dashboard] ¥ 7 DEHE &R L F T,
2: [Device Dashboard] 2 7

Tiua ASNH 71 Fer A5 - TAAR TR

A7¢%7/x&k‘%A@%£ﬁ%ﬁ% HCHERTEET,

@f' Fasligarmion |5 Venrrra o See 8 3rtweh | E30uck [ Faraasd | D bl

L]

Lems Ll
badd O Debes & Caness |n.- - E Al

Tir: T re Defomeanionn
= Lol B LEsns 854
L RUERTERY
A i

Hme Mars: [ETF
L RLEL NS R 2
ERNE TILES AR AR [GURSETIE T It
PRI RILAT] AN ErmaL T.IcE119 e
L RCE- R R Firsssull Wed s Faersed T
A inaiiais Breparmzn Halia: P 0K ol blak
LRLELREE ]
A e o
A I AT
L

B 0o 1L @*“ T -
A i hias SR 1 baplin

e i

= 10 124528
L et
ERTT YRR

A it il
B ITIAEEN.EL
- NECEL RSN £
& ITEIES
B ocrlsoman
R RS Ea L By

EREEELELTRE
LTSN L

‘:llH'."l.-'H. BE
B TIIEIMLLEY
NI EO T NSl
B ITEFIIIETD
L RS LR
CRTERL TN
L B
-

AR

@—» iﬁuaﬁﬁwm ci

arp Lnag s 1ME

S

oo lal suunslals,

i
B )

e

Rty

e

e

Clurar

et 124 LhAdin 14

- ANG FEETORER IS
zzp: g
ZI9E HE

Saleran

rrarfack 1o wae zan and surmar Khze

Tralln Sdan -(—@
et Caeat o HEly Carractiaze FerSacond llosgs

IR " (L] e (BT

ELE-0 WD G Tersk 1

raragerzrld waaloe i Ui bl '(—®

o e LA nage | LaveUesge | Ddab
[T T
E e ] I [E1S
L e T
Bda T Eoaee® Tk ke B ke Triwkr

LIEDLS M L9 38 LM 22
12004 I8 1935 1o T3

LOS6 Ll =43 Dwry TCP
MGG 182 ~41 Teaadzar

dan

A [ T T a3

W gl ko L L DEF R

-
L
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skl
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2 carrectian LRSS lzr 1010455520 2a g, 0
wr| B B st s s by

GUI &%

FiEA

1

[Device Information] X1 > (81 ~X—)

2

[Interface Status] ~~ > (82 ~—73)

[VPN Sessions] ~A1 > (82 ~<—2)

[Traffic Status] ~~1 > (83 ~—)

[System Resources Status] <1 > (83 ~X—73)

[Traffic Status] ~X1 > (83 ~X—7)

Device List

(73 =—3)
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[Device Information] X1 > .

GUI Z=x% B

— [Latest ASDM Syslog Messages] X > (83
)

[Device Information] X1 >

[General] # 7

[Device Information] X1 (214, [General] # 7 & [License] ¥ 7 & W9 T /3A A fFEHRELRT D
2ODHXTRBHY £, [General] ¥ 7 T, v AT A~ JLAR—H T 5 [Environment Status]
RE AT 7 BATEET,

DX TITIE, ASA IZBET D ROEAEHRP T ENET,
* [Host name] : 7 /34 ADHEA "R R LET,
* [ASAversion] : 7 /3A A LETFEITSNTWNDASAY 7 b= T D=V arzZRrLET,

* [ASDMyversion] : 7 /3NA A L TERITENTWVWHASDM Y 7 v =7 D=V a U EFR L
i—a—o

« [Firewall mode] : 7 /3 ANFEITENTNWEL T 7 A T U4 —/L T— FEFRLET,
« [Total flash] : FAEMEH STV 5D RAM OB 2R R LET,

* [ASAClusterRole] : 7 7 A& U IRHHDZEI, Z0HEEOR—/L (v AX—FT2iF
AL—7) BRRLET,

s [Device uptime] : IV 7 N =T 5T v 7 B—RKLTHhH, T4 ABEMELTND
RefE] &2 R LT

s [Context mode] : 7 /31 AMFETINTWNWDHIALTHFA N E—RERRLET,
s [Total Memory] : ASA {24 > A h—/L I T\ % DRAM #FR LET,

* [Environment status] : ¥ A7 A~V A %K R LE T, [General] % 7 @ [Environment Status]
LWV TNV DEMNZH DT T AT S (+) 27 Vv 7 LT, ~"— Ry =T HiHERE &
RLET, RESNTWOEREEROMR., 77 v LEREY 2 — VOEHWERAT—Z X
DB, B XU CPU DIRE & > 2T ADFEFRIRE OB Z EITTEET,

—f&\Z. [Environment Status] R % > TV AT A ~ILAR—HThNY 4, VAT AND
EFEHRBOTXTON— R =7 TR —F3 "R IEF2@ENTEIEL T D54,

7T A5 (3) RZAAL[OK] Bk CRRINET, —H, N—RFU =T AT AN
DA R—=F PR 1O THIEEREEHSTEIEL TWD5EIE, 77 RS () R
IR DIN RS TI VT A N AT —F AER L, N—FU T a iR —xr kI
L TT IR ETHL Z 2R LET,

BrED/N— R =7 OFFHERICET 23NN TR, TOTF AL AD [N—Fo =T
A R] 25 L TLTEEN,
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ASA OBt |
. [License] 2 7

\}

GE) HEHVIU—ADASAILT v 77 L—RTHIZEAEYBARELTODHEEIE, [Memory
Insufficient Warning] %A 7 0 7R v 7 ANERINE T, TOXA T 0T Ry 7 AR REN
HIERICHES T, PAR—=FENTWA HETASA B L ONASDM Ziffkfe: L CHEA L £9, [OK]
IV LT, ZOFATa Ry 7 A LCET,

[License] % T

ZDETINE, FAB L AEROY T2y FRFRINET, LT A B AEROFRRE
T LT 7T 4 _X—= 3 v =D AJJEAT 921X, [More Licenses] #27 U » 7 LET,
[Configuration] > [Device Management] > [Licensing] > [Activation Key] ~*A ' NFERR I IVET,

[Cluster] & T

ZDZTINE, I ITARIDA B =T 24 AF—FBLOY FAZDAT —F ARFRENE
D

Device Information

General = License

Cluster Interface Mode: Spanned EtherChannel

Cluster is not enabled.

Details

) Y—X 27 (ASAv)
ZDOXTIE, ASAILE > THERAEINTHWAIEY V—2&2F R LET, vCPU O, RAM,
ASADTBEY a =V 7 OBARENEGEENET,
[Interface Status] N1 >
ZORL AT, A VE =T 2 ADAT—HANEREINET, f X —T = AD{T%
BIRT DL, ANBIOH I ANLV—T" 82 Kbps AL TT —7 VD FIZERRSNET,
[VPN Sessions] N1 >
ZDORA NI, VPN b )b AT —F ANRFRENET, [Details] 227 Vv 735 &,
[Monitoring] > [VPN] > [VPN Statistics] > [Sessions] 1 I EI L E 7,
[Failover Status] X1 >
TDONRA TR, T bR AT R ANFIREINET,

[Configure] %~ U 2~ L C., High Availability and Scalability Wizard Z & L 4, ZD v ¢ ¥ —
REZETTDHE, Jo— A —R—ar7 1 Fal—a AT —HA ([Active/Active] £ 7=
I& [Active/Standby]) WNER I ET,
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[System Resources Status] X > .

T )L A R RERE STV D AT, [Details] 227 U~ 7§25 & [Monitoring] > [Properties]
> [Failover] > [Status] X1 > 3B & F 97,

[System Resources Status] N1 >
ZORA 2, CPUB LT AE Y O RIS D MaHE RS F RS E T,

[Traffic Status] X1 >

ZORA NTE, A Z—T = A ABROBERE/M L, Kb EBENVEXF 2V T 4 X —T
AADNT T 497 AN—Ty DT T ITNERENET,

AT 4 X2l = a3l X2 VT 4 LR BIEWA U —T = APNEBEENTE
D, ZOWTNIDOLHETN Toutside] THIHH., TDOA L XZ—T A ANNT T 4T R
N—""> NOTZ7IEHINET, TNLNOEE, ASDMITEX =2V T 0 LV RS
BN H =T 2 A ADTINT 77Xy MED U A NPORPIOA X —T = A A% #EIR L E
7

[Latest ASDM Syslog Messages] X1 >

DA T, ASADER LIERFO L AT A Ay =T 100 HE TRRENET, =
XL ITNT 4B —T M5 T DAL, [Enable Logging] %7 U v 27 LTA X—7 /T L
i‘j‘o

WDKIZ, [Latest ASDM Syslog Messages] <A > DHEFZZRLET,

3: [Latest ASDM Syslog Messages] <1 >

3 ikl

Latest ASDM Syslog Messages Og ? *
Severty | Dabe Time Swskg 1D | Source TP Source Dastnabion P Dastind Dascripbion

T 3020 lagiy:-214:Eadf,., O iz G Taardewn ICMP connaction for faddr fea: 214 e .9
f F L Eope 2

[y

S14:Eaff... O gzl v Byl inbound |

N0 Pl =20k Feffr... @ FRd2:1 o Tasrdown ICMP connaction For Faddr fel0: 200

£ ¥
FLA51
GUI Ex% ELE)
1 NRA DY A REBEFTHIT0E, Ta4N45

ZEELIITICR T v 7 LET,

2 A VCERBBALEST, XA E2T 74V D
YA RCRETICIE, ZEQEAROT A =2
7V LET,
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ASA OBt |

GUIEH

B

Ja—7 4T XA UEERLET, 1
ERyX U TTHIE, RyFdFodLi=Ra
oTAarEs Uy LET,

HEWEE 2 A =TV EITT =70
WZLET, BEEFERRDA X—T NV RGETE.

2 FHBIZ & 5 [Latest ASDM Syslog Messages]

RE D EZH—=I N EaBETHE, N
NERENFET, H—INEA U BEES
&L A TIEFIRITAR D £,

A EALET, A U E2RTTDHITIE
[View Latest ASDM Syslog Messages] % 3R L
EJu e

FHHZH 8 EDOT A a7 Vw735 L,
syslog A v &— Y DRFDOEH 5HeAiT LET,

FHWZHEFWNT A arvzrs )y rd5L,
syslog A v &=V DRROEFH &AL L FET,

FZoHDT4NE TAaL %20 v IT 5
& . [Logging Filters] ~1 > 233 & 9,

e AR &2 Y v 27 LT [ClearContent] Z8#IR$ 2 & | BIEDOA v —VEHELET,
e ARV NEHT Y w27 LT[SaveContent] 227 U v 735 &, BIED A v&—T%PC ED

T AVREFELET,

e ARV NEHIZY v LT [Copy] ZiiIRT 2 &, BIEONFEZaE—LE T,

e A XU NEHZ Y w7 LT [Color Settings] Z1&R 5 & BHREIZESUNT syslog A >

-

[Firewall Dashboard] % 7

BLATRGEELELET,

[Firewall Dashboard] % 7 Cl%, ASAZ T 5 N7 7 ¢ v 7 IZHT A EERIERZHERCTE E
T, ZOX v aR—RiIE, Yo/ arFRANE—REREIVAF AT EA R E—F
DELLTHDLIMNZEVERYES, v /LF a7 FHF X~ F— NTiE, [Firewall Dashboard]

K TR A NNICRRTEET,

W ODIKZ, [Firewall Dashboard] % 7 D #EZED—i %~ L E T,
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[Traffic Overview] XA > .

4: [Firewall Dashboard] 2 7

# Cizem A%DM 6.3 for ASA - 10 B8 54 BE

F_‘ U_.I d 3 - ~ _ml Pl 1y
= it | ] et |l et Qeeh ) e i _‘-Tl'_?.El'E. i

[ o
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a| g !. F_.'l. ._ql > H |
1 i wad -l el Y
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r_:fﬁ‘u_“!uf:f_ o [ i Joge L0 Sopweom | 1 L Comlimaoes | s 8 Lt ﬂ
o o 3'\.. m [ 1'_"‘} . l| Il e [enettnss
5 — ¥ |
| Eo oy o B I m&mﬁ =rnlanrds o # 1=
o E b & Rl s i e 3
JLA5|
GUI EX% 5 EA
1 [Traffic Overview] ~XA1 > (85 ~X—737)
2 [Top 10 Access Rules] X1 > (86 ~—7)
3 [Top Usage Status] ~~A > (86 ~~—73)
(£R72 L) [Top Ten Protected Servers Under SYN Attack] <~
Av (87 =)
(FR72 L) [Top 200 Hosts] ~~A > (87 ~—2)
(FR72 L) [Top Botnet Traffic Filter Hits] <31 > (87 ~X—
)

[Traffic Overview] XA >

T 74NN TIE, A F—TNTT, BREEREET cv—7 0T 5L (28 | Z0OfE
18121 [Enable] 78 % > RN FE R SHUET, [Enable] N % 2 L CHEAGBRH AT 1 —7
N TEET, FETRFORFERICIT. BrREHOKROERNP G ENET,

o BEfCEC & NAT ZEH8,
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. [Top 10 Access Rules] X1 >

e TR VANMIIDBEERBIOT YV r—va v A AT a il TRay”
Ny R,

s Ky Ty N, Thiud, Ax v VU HBO—HE L TRESNDIGE L. REE
v iart LTHHINEES (TCPSYN KERLF— 472 L UDP v a WS
BMELIESRERE) B’ £,

[Top 10 Access Rules] X1 >

FIx N RTIE, A RF—TNVTT, TIZERANL—LOERBEHEHERET + E—T T 5
E (774704 —NORETA R 258) | Z OFKIZIL [Enable] RN U BERRZIVE
¥, [Enable] R¥ L & LTT 7t A L—LOFEHERE AN TEET,

T=T N Ea—TiE, VAMROA—AEZRIRLTHZ Vv 7L, Ry 7T v 7 A=a—I
H ® [ShowRule] # X R CTE £¥, ZOHHZEIRN L T [Access Rules] 7— 7 /LB EH L, 7—
TANICHHZDON— NV ERIRLET,

[Top Usage Status] N1 >
FI ANV BT, TAE=TNTT, ZOXL T, RO 4ODOXTRHD £7,
* [Top 10 Services] : & B HH— B2
* [Top 10 Sources] : Z@iff Hi#— £ 2
« [Top 10 Destinations] : i H - — & &

«[Topl0Users] : 7 AT T 474 77 AT Ut —/L —ER

&IP3 >DH 7 ([Top 10 Services]. [Top 10 Sources]. 33 Y [Top 10 Destinations]) Tik, &
B — B AT A FGEHER AR L E T, FF 7L, ENENOBBRET—Ev X%
AR—=TMZT 2% [Enable] RFZ 3V £T, [T7 AT U+ —VORENA R 129> T,
INbLEFMMITEET,

[Top 10 Services Enable] "% > M35 & N—F & 71 b a /Lol OmEHEHRD A 1 —
TR ET (EBHLFRTFAICA F—7 MITH0%ENRSH Y ) . [Top 10 Sources] 7R
> ¥ OV [Top 10 Destinations Enable] 78 % > 325 & | R A b OFEHERND A R —7 T

RV ET, FARN GEEIXBLO%E%) O EHRT —% AFEHER, BLOKR— KT
haALRRRINET,

4FEHDH T [Top 10 Users] Tlk, TAT T AT 4 7747 U4 —/b —E AT DHE
BHRERBELES, 74T T4 T4 77AT V4=V —ERATIE, 2=V DT AT T 4
TAWZESL T 7 vA 2 ba— v ERHELET, BHEILIPT RLATERS 22— L a—
P IN =TSN TCT 7R L= Fa T 4 R —%2RETEET, ASAITL,
IPLa—HYDOvv LT T—HR—RITI7EALT, 2OV —ERAEZRMELET,

[Top 10 Users] # 71X, ROWTNMNERELIZGEDH, T—F2ERRLET,

» Identity Firewall "—E 2 227 ¢ ¥ 2 L—3 3 I : Microsoft Active Directory 33 J U" Cisco
ActiveDirectory (AD) T=— = VDB Rm—3 2y NORELE G I FE T, Identity Firewall
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[Top Ten Protected Servers Under SYN Attack] ~ - > .

P —E AL, user-identity enable =~ > R (5 7 #/L h TH%)) I K user-accounting
statistics =~ > RZHEH L THEMEINE T,

* VPN :L‘_‘]j_o)muu muj‘if’ i?ﬁ‘?/T% N 7&??971:_&)@: RADIUS ‘H‘—/\%ﬁﬁﬂﬁ"
HVPNa 7 ¥zl — 3,

IR L7247 v a2 T UC, [Top 10 Users] Z 712, BAL 10 2 —HF D3Z{E L= EPS /37 »
b EE LT EPS Xy b BROWEE SN HBICET D FHERN R RSN ET,
(domain\user name & U CHREIND) F2—HFIZEHL T, 20X 7I2id, Z2O2—F DY
EPS /X% b, BIED EPS /37 > b, MU HT—, BLOGHEA XY MEIRERENET,

R RMEHERE AT D L AT AMEHERO X A TG C T, ASAD/RT =~ A
NBLEZTET, RANOREFEREA X —TMITDHE, T p—< L AR R BEN
HVET, T T4 v I OARPEWEGEIEL. 20X A T ORFHERIZ A F—TIZ
THZEERFLTLIEZ N, 72720, A= FOREHE#HEZ A 2—T7 ML TH, THITEE
IH Y A,

[Top Ten Protected Servers Under SYN Attack] N1 >

T 74NV ETIHE, T4®—TNTT, ZOMHEKRICERIFL TS [Enable] R & > 2 LT,
COMREEAIIICTEET, T2, [77AT7 U4 —RETA K] 12> THEDIZT S Z
L TEET, WEBAZT CRESNT B 10 b —_OFEHERAFREINE T,

TEHE L — FORE. ASAIZV— MEE (7740 MI30%7) ICHLT30R T LIcT—4
YooY T LET,
BEOBWEE DN DLEEIX.,  [<various>] DORIZHEKEDKEBEDIPT RLANFREINET,

[Detail] 7 VU » 7 LT, 10 BOH—_"7Z1F T, TXTOH—N (JK1000H) OFFHE
WEFRRLET, BEV LTV T T— 5%%%?6’&%T%ET<MAiV~B%%®
MICBEBEOKZ 6017 ) 755D T, T 744 D305 HETIE. 607 Z & ITHHE
WAL S NET,

[Top 200 Hosts] N1 >

T AN BT, T4 B8—=7 0 TH, ASAZI L CHHEH D L2200 DA A M ERRLET,
ARAFOK{T L FUITIE, FA M)IPT KL AL FRX ML TGS NN E
Fh, 2O XNV LT v I T—haNET, TORREA RX—T T HITIE
hpm topnenable =~ > K% A7) L £

[Top Botnet Traffic Filter Hits] X1 >

TI74NENTIE, T48—7NTT, ZOEKIZIE, Ry hRxy N NG 7407 T4V E%
BETHIZDODOY) I NEENTHET, EMI0HORY by b A b, A=k, BIWY
YR A RDULAR— NI, T—FDAFT T vay MRt U, HaHEROUERBLIED
MI0EBIC B LARWEARHY £9, IPT RLAEZE7 U v 745 L, whois ¥V —/L3jiE
FHLTARY bRy b A FOFEHBRFRINET,
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. [Cluster Dashhoard] % J

FHZOWTIE, ARy by FRETA R 22 L T EE0,

Tup

[Cluster Dashboard] 2 7

ASA 7 FAZ Y U T A R—=T ML T, vAX— 2=y MNIEH L T 555 1%, [Cluster
Dashboard] # 727 T AX DAL=y 7L ) Y —AFHROMENEREINE T,

a8 Home

B e Daooad,

Device Mamse ‘ Management IF Address Role Resource Utilization

Version ‘ Uptime Enviromnment Status |Hullh Status cPU T Used Memary
elsl 172.23.204.243 MASTER 100.8(0.94) 2d 15h 56m 495 | - . - - —
2001:b0b-6500:3 ' ? FAL ¥ Unknown [ 1%[ 204 MB

Average CPU Usage (percent)
: g

w ~Cluster Overall

2
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40 1

10 al " J
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Connections Per Second Throughput Load Balancing P_]

0807 0808 08:09 0810 08:11
Wcisl: 0

0
18:11:00 D07 0808 05:09 0&:10

[HT

¢ [Cluster Members] : 27 7 A X ZHgT 5 A /" —DA4 & HAEHR (FHIP T FL A
N=Tar, JIRAZANO—=LIRE) BEOALN=DNVART—H A (BREAT —
HA L ANWVAAT =R BIOY Y —=2HER) 2FKRLET,
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[Cluster Firewall Dashboard] % ' .

A\

GE) VI F A THARNE—RTE, B TF X M2 ASDM %
Bfe L, wIZoa 73 A MIEFELTH, VA MRRINT
WABHIP 7 RLARBRED LT A NOEHEIP 7 RLAIC
EHREINFEFHA, ASDMPBEER SN TND AL 7 TAXD
IP7 FLARZEGHEHa TR AMOERIP 7 KL A%, 5l&
eEFR LIS E,

* [System Resource Status] : 7 7 AZ R{RD Y VYV —2ffiffj= (CPUB LU AEY) & 7
TAwIDTTT7 (I ITAZERBLOT A ATL) 2RKRLET,

* [Traffic Status] : &% 7IZIZRD T Z7 70360 £,
 [Connections Per Second] % 7
[Cluster Overal] : 7 7 A Z KD BN OB BT RINET,
[Per-Member Total] : % A > /X— DR BN O R R R S IVE T,
« [Throughput] % 7
[Cluster Overall] : 27 7 A X 2RO ST A NV—T" ERFRINET,

[Per-Member Throughput] : A >/ X—D A)L—7F v kX, AL /R—=T L2 1 {TT0FR
INET,

* [Load Balancing] % 7

[Per-Member Percentage of Total Traffic] : A > N—MNZ(E LTI TAKX N T T 497
DFENIG, A N=T LR RINET,

[Per-Member Locally Processed Traffic] : ©—# /WZALEES 7= N T 7 4 v 7 OEIGD,
AUN=TLIZRRENET,

* [Control Link Usage] % 7

[Per-Member Receival Capacity Utilization] : Z5E R EOMEHFEN, A =T L ITRR
SNET,

[Per-Member Transmittal Capacity Utilization] : S2{ R E DN, AR —T L2k
RSIET,

[Cluster Firewall Dashboard] % 7

[Cluster Firewall Dashboard] # ~7'1Z1%, [Firewall Dashboard] {IZFH /R SN D IEHR EFED 8T 7 4 >
7 OWER LY TtopN] MEFHMERP RS INFE TR, 7 7 A BRIZOIEDEHIFR RSN E
A,
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. [Content Security] 2 '

Connection Statistics

Interval: | Last 1 hour + | Based om: Packet HitsDisplay: | Tab

sl

3

2

The Top 10 Access Rules feature is disabled in the Security Appli
1 Please click the button to enable it.

| Emable
D . - . N
0807 0808 0&:09 D810 0811

__ M Connections: 1 M NAT Xlates: 0

Dropped Packets Rate
The Dropped Packets Rate feature is disabled
in the Security Appliance.
Please click the button to enable it.

Top 10 Services Top 10 Sources >
Interval: | Last 1 hour + | Based on: | Packet Hits [

Possible Scan and 5YN Attack Rates

The Possible Scan and SYN Attack Rates
feature is disabled in the Security Appliance.
Please click the button to enable it.

The Top 10 Services feature is disabled in the Securi
Please click the button to enable it.

Enable |

[Content Security] & 7

[Content Security] % 7 Cld, CSC (Content Security and Control) SSM (Z B892 B H 72 5 & fife
RTEET, ZDOA E, CSCSSMTEMEL TS CSCY 7 MY = 7R ASAIZA A b —
NLEINTWDHEEDOHERENET,

A\

((¥)  [Configuration] > [Trend Micro Content Security] > [CSC Setup] % &R L T CSC Setup Wizard % 52
T LTWARUE | [Home] > [Content Security] D N2 H A AT 7 BATEEHA, LDV
WCHEATa TRy 7 ANRERZ L, ZOHATH 5 CSC Setup Wizard [Z[EHET 7 B AT E7,

W ODIKZ, [Content Security] ¥ 7 DHEF %R L £ T,
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[Content Security] 2 7' .

5: [Content Security] 7 7

# Cisco ASDM 6.3 for ASA - 10.86.94.88 LEx
File Miew Took Wipards Window Help i NI
@:[%mgm (e Qs o 7 s i cisco
Noma s a — o
F "|_u""'_'|.'£_—||.' I |__.- "u_u__a'm:
@—-"L?: I T e—r— EL ———— I +—@
el Barie Liceree Thevst Fpes Tasds Lt 7 s Lyt 00 s
CAsieing, ArtSprpaars, Fle Bladirg)
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Fpepn Pl aares:
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®_*ﬁrﬂv—ﬂmtﬁ Shakas Emad 5 +—®
™ i Phoaris rasd i sl
(L -. R S5 Sy L3S [V . | ] -;'H'P Tm:-
. Phoaen re. . y
s | | * B ne = 1 ] xR
O3 '
T Snroe  ThepstFlter SubosrtyFe UL P e Saerucies o, e B rton [
= 3
e ——r— o L] mg Emmn:nmmn
JFL451
GUI Ex% EREA
1 [CSC SSM Information] ~5A >,
2 [Threat Summary] < >, CSC SSM {Z & ¥ f&
HENTZBBOENT -2 2FRLET, ¥
AWA AL T2T, T4NEV T E-
X7 vy 7 S URL, 78y 7 Zjfc AN
L, Tav 7 ENET 7 A, BEREY—
ERRENH D £,
3 [System Resources Status] <1 >,
4 [Email Scan] <A1 >, 77 7IZi%, 10 k@ T
T—ANERINET,
5 [Latest CSC Security Events] <1 >,
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. [Intrusion Prevention] 2 7'

[Intrusion Prevention] 2 J
[Intrusion Prevention] % 7 CliX, IPSIZBAT A EHEREREZMB TEET, ZDF 7L, ASAIC
IPS EV 2 —ANBA A= LERTVIHRBICOARTENET,
IPS &Y 2 — VT T 51213, ROFIEEZFATLET,
1. [Intrusion Prevention] ¥ 7% 7 U v 7 LE7,
[Connecting to IPS] A 7 0 /'R v 7 ANERINET,

Connecting to IPS...

ASDM will make a new connection te the SSP-IPS module in this ASA system.
ASDM makes a separate connection to the IP address of the management port
on the 55P-1P5 module.

55P-1PS Management IP Address: 10.89.147.143 Port: 443
Username:

Password:

__| Sawve SSP-IPS login information on lecal host.

*Password cache is encrypted. Use File = Clear Password cache menu to clear it.

% s N\ s " “\
Help ) [ Cancel ) ( Continue )

255100

2. IP7T RLA, FB—h, =2—HF4, BLIORT—RKEZAHLET, T74LFDOIPT R
LA ELR—FE192.168.1.2:443 TF, T 74V hOZ—HF LB LAY — RiZ., cisco &
cisco T,

3. nlA UEHRE B — BV PCIZERIFT HIZIL, [SaveIPS login information on local host] 7 = v
IRy I A F AT LET,

4. [Continue] #2 Y v 7 LET,

RABEICEE T 258>\ TiX, TIPS 7 A v o7 A% — K A R 2L TS,
W DIKZ, [Intrusion Prevention] # 72 & % [Health Dashboard] # 7 D% F# % /k L £,
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asacxstatus] 2 7 [

6 : [Intrusion Prevention] 2 7 (Health Dashboard)
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i I':qm.mmmml.m:
Sopherd v e 13, B0 | o SO
e Jpoits S Find Thanciond
LB ﬁ
e EHE I —
FL51
GUIEX% HoL:L
1 [Sensor Information] = >,
2 [Sensor Health] ~= >,
3 [CPU, Memory, and Load] ™~ >,
4 [Interface Status] ~<A >/,
5 [Licensing] ™A1 >,

[ASA CX Status] & 7

[ASA CX Status] # 71Z1%, ASACX Y o —/VZHT 2 EERERNFRINEST, Z0OXT
L. ASAIZASACX EV a— A BA VA M=V ENTVWAGHRIZOAERRINET,
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. [ASA Firepower Status] % 7

e e Home
s sicelisbboitt ™ fusilRasiaaiy ~ s xesrans
|,
ﬂﬁ Device Information Last updated: 10:56:39 AM m Interface Status Last updated: 10:56:39 AM
Maodel: ASAS5585-5SSP-CX10 Application Name: ASA CX Security Module
Hardware Version: 1.3 Application Status: up
Serial Number: JAF1543CGRE Application Status Description: Normal Operation
Firmware Version: 2.0(13)0 Application Version: 0.6.1
Software Version: 0.6.1 Data plane Status: up
MAC Address Range: 70ca.9bf0.1cad to 70ca.9bf0.1cab Status: Up

H[EET

Connect to the ASA CX application: https://10.89.147.153:443

[ASA Firepower Status] % 7

[ASA FirepowerStatus] % 721X, ZDOFY 2 —/VICHETAEMPFRINET, ZOMHRIC
T, T, VUTNANEES, YT hU=T RXR=U g R0V a—NERE, TV r—
vark, TTVr—vary AT—HA T—H T—r AT —H A BIKOAT—HX A7}
EDEVa— )V AT —FZANEENET, £ =—/L2 FireSIGHT Management Center {288k
ENTWAREARIE, Vo2 &22) v 7 LTT 7 ) r—ya rw#fl&, SR omeEeEya—b
DEREEITIZENTEET,

Z DX 71X, ASA Firepower E ¥ = — /LN T /NA AZA VA B =L ENTWDLEAIZOHRER
EhEd,

FireSIGHT Management Center Cl72 < ASDM % {# f§ L C ASA Firepower £ 2 — /LA FH L
TWAEEIT, BINOZ TRERENET,

* [ASA Firepower Dashboard] : % v 3 =R — RIZiX, £V 2— /L TCETHDOY 7 by =7,
WEDOT v TFT =, T4V UT VAT LAOAR, T4 AT DM VAT Ll
M, BEXOA v H—T 2 AD AT —H ZTONTCOMEFEFE DRI NE T,

* [ASA FirepowerReporting] : L' AN — MERDOX—IZIE, Web 7 V| =2—H %[EF

Jo, BV a2 VEEUTHR I 74 v 7 NESND5EER Y, SEZFERTY 2—LOHFH
WX LT EM 10O E v 2R — KRR SN ET,

[Home]l] N1 > (AT L)

ASDM ¥ AT LD [Home] ~A1  Tld, ASAICHT 2 EE R AT — X AfFEREFRTEET,
ASDM ¥ 27 LD [Home] <A NNIFERINDFHEMOIT L A ETL, ASDM Ot IGHTC 6 2
TEETN, ZOXA U TITASAOERIREELZ —H CHRE TE X7, X7 LD [Home] ~A
YDAT—H AERIT 10 R CTEF SN E T,
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FFE D ASDM iR EDEMEE EFRTE 7,
ASDM O X F X ERHELEF T 5001, WOFIEEZFATLET,

FIE

[Tools] > [Preferences] DJIEIZE4R L £ 97,

[General], [Rules Table], 35 U [Syslog] D 3 DD X 7 D % [Preferences] XA 7 27K v 7 A
DERRSINET,

REXERT DT, oD XT7D125% 27 Y v 7 LET, [General] % 7 TIXLHT Y 7 7
L A% L., [Rules Table] # 7 TlX [Rules] 7T—7 VD7V 77 LU AEZRELET, %
72, [Syslog] # 7 CliX, [Home] ~A NZERREID syslog A vE—TDOABAEIEE LTV,
NetFlow B D syslog A v —DEE X o —VDFREA X —T M LTZY TEET,
[General] # 7 Clix, WOHHAZHEELET,

ARG = Ty T AT 4 Fal—a I Tar T4 Xab—a YARPLTW N
XA IND L DITT HYA 1, [Warn that configuration in ASDM is out of sync with the
configuration in ASA] F = v 7/ Ry 7 A& AT LET,

« ELEIEEFIC read-only —HIZxF L CRD A v &— T & FRT D841, [Show configuration
restriction message toread-onlyuser] 7= v 7 R v 7 ZA&AF NI LET, TOFT T3 U,
T 74N FTHTT,

“You are not allowed to modify the ASA configuration,
because you do not have sufficient privileges.”

c AL —7 2=y MR I N2 —PITHRERIRA v -V E2EKRZT HITIE, [Show
configuration restriction message on a slave unit in an ASA cluster] = v 7 R > 7 A% F 1T

LET,

«ASDMZHU % &L TR TEMRTH 7T a7 MREREND X 92T 5121, [Confirm
before exiting from | &= v 7 Ry 7 A% A NI LET, ZOF T a ik, T 74/ KT
Fr T,

e AV Y= U—H—% A 3Rx—TWMIF HIZIX, [Enable screen reader support (requires ASDM
restart)] = v VIR VAR F NI LET, ZOF T a a4 =TT DHITIE,
ASDM % FHEEEN 2 MERH Y £,

« ASA AE Y DR/NZEEFKEN, ASDM 7 7Y r— a3 U OFERRERE R FEITT HIITR
+CTh DG AICEIZ %57 521X, [Warn of insufficient ASA memory when ASDM loads]
Fxv IRy I AEF AL ET, ASDM L, BEBEIRFIZTF A b N — X vE—TT A
FEVELELLRL, ASDMDZ A ML AN—F XX MNMIA v —U%FoR L, 24 2L
WZsyslog 77— hEEfF LET,
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* [Communications] B T :

s ASDM IZ X » TAR &5 CLI 2< > REFART HIZ1E, [Preview commands before
sending them to the device] = v 7 R v 7 A& AN L ET,

s ASAIZBE D a~ L RE 15D 7 N—7¢ L TEET 5ITIE. [Enable cumulative (batch)
CLIdelivery] F= v 7 R v 7 2% 42 LET,

cFALT U Ay VREREOKERMEMHEMTANLES, 7741 T
60 B T4,

* [Logging] fEIHK T :

o Java B X2 7 B ET HIZ1E. [Enable logging to the ASDM Java console] F = v 7 7R »
I AEA AT LET,

s Ky 7 H v U A RS [Logging Level] 23R LT, EREAZHELET,

* [Packet Capture Wizard] 6k T, ¥ v 7' F ¥ S7o37 v &R T HITIEL, [Network Sniffer
Application] IZ4HTZ ATJT 57, [Browsel %7 U w27 LTT7 74/ AT ATHRELE
7

AT v 74 [Rules Table] # 7' ¢, RDIAHZEELET,
» [Display settings] CliZ. [Rules] 7—7 /L TON— IV DOFRRFIEEZERTEET,
* Auto-Expand Prefix R EICESWTHBRASINAZR Y NV =2 BRLOY—E A 57

Tl b IN—T%FEKRT HITIL, [Auto-expand network and service object groups with
specified prefix] = v 7 R v 7 A& F I LET,

s [Auto-Expand Prefix] 7 « —/V RiZ, £RTH EXICHEWIZERT A Ry NU—7 8
SO —b 2 AT N ITN—TDS VT w7 A ANTTLET,

XY NIT—IBIOYV—ERAFTT V=S N IN—T DAL ZDITN—T 2%
[Rules] 7 — 7 /WZHEKRT HIZ1%, [Show members of network and service object groups]
Ty IRy I RAEF AT LET, T2y IRy I ABRFTTOEET, T V—T472
IRERRSNET,

« [Limit Members To] 7 4 —/V KiZ, PR THFR Yy hU—I BI RV —ER 4TV xs

N IN—=TDEEANNLES, ATV b IN—T AR RBRREND EEIT
I, WD nJ]D A L N—=T2FRERRENET,

¢ [Rules] 7— 7 /AT XTDT 7 ¥ a ukFaT 5HIZIE, [Show all actions for service
policyrules] = v 7 Ry 7 A% AN LET, A7 OHAIE, P~ —BRRENF
ﬁ‘@

* [Deployment Settings] CTi%. [Rules] 7— 7 /WIEENEEZEHT D & & D ASA DEMELZ &
ETEET,

cHLWT 7R VR NEEAT S EXIINATT—T V%7 U T 5HITIE, [Issue“clear
xlate” command when deploying access lists] F— v 7 RN > 7 A% A N LET, ZO5%
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ERioEHENS X I LET,

» [Access Rule Hit Count Settings] Tld. [AccessRules] 7—7 VDt v MNgET v 75— FT
LHEARETEET, by MUk, BRI — UZiZgEH S E T, BERRYe L —
LD ML, [Access Rules] T>—7 IR TSN ET A,
s [Access Rules] 7—7 /LTt v NEBRBBIMIZT v 77— SN d L9123 51
[Update access rule hit counts automatically] &= v 7 ;R v 7 A& F N LET,

e [AccessRules] 7—7 /W2, by "EAH T L ETHITHHELPDEMNTIEELET, A
MEOFPHIE 10 ~ 86400 ¥ T4,

AT w75 [Syslogl] # 7 Clx, WOHEHAEZRELET,

* [Syslog Colors] fEIE Cix, BERE L~V T L IZH RO ERTRAZHEL, A ‘y’ff**“/vi%ﬂ?
Bl AR~ A XTEET, [Severity] 7 7 LIZiE, FEKNELABLHIBLOE ST &
FRENET, FERELNVLTRA v =V O RO EITRTRAZER 520, X]Lﬂ?
TEHT %7 Vw7 LET, [PickaColor] ¥4 7RI Ry 7 ANERINET, KOV
TNNOX T2V T LET,

o [Swatches] # 7 C/NL v hILEERINL, [OK] 227V v 27 LET,
*[HSB]# 7 TH, S, BOREAHEL, [OK]Z7 VU v/ LET,
* [RGB] # 7" TR, #k. BOXKELEEL, [OK]Z27 V7 LET,
LR ZRsyslog A v —VET 4 =T NMIT DL IBETHAvE—VOERREA X —T

LIZ9 5 1T1E. [NetFlow] #Hik C [Warn to disable redundant syslog messages when NetFlow
action is first applied to the global service policy rule] &= v 7 &R v 7 A& 4 NI LET,

RTYT6 TNH3ODXTOREEFRE LK T, [OK] 27V v 7 LTEREEZRF L, [Preferences] &
AT7alRy 7 AEHATET,

GE) TV 77V AREEA L ERIIAT7ICTH-NT, BEHNEFT conf 7 7 A VIR
SN, FOBETY—7 25— g v ETEITHOZFDMD ASDM & v 2 3 i)
DRATE L2 ET, T XTOEEEZHNCT HI2IL, ASDM & FHiEL# 4 5
PMERHY F97,

ASDM Assistant TDRE

ASDM Assistant *Y —/LTld, Z A 725 U7z ASDM O HIEDO~LV T 2B L, R TE
i‘j‘o
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I T 7 & 29 5121 [View] > [ASDM Assistant] > [How Do I?] DJIEITEINGT 575, A == —
/S—® [Look For] 7 4 —/L R BIEBEEREZ A LET, [Find] Kry 7FX 7 URXRpb
[How Do I?] Z3&R L TR ZBtA L £3,

ASDM Assistant /79 51201%, WROFIEEZFEITLFE T,

FIE

[View] > [ASDM Assistant] % 38R L £,

[ASDM Assistant] XA V' NERRINE T,

[Search] 7 ot —/V IR T 21EHAEAT LT [Gol &2 U v 7 LET,
HR SR [Search Results] ~SA S NICFR SN ET,

[SearchResults] v 7 v arBEL O [Features]| 7 v a VICRRINDIEEDV 7 %7 U v D
L. #MEHREAFLET,

v I DAL

[History Metrics] ~~1 & Clk, S E I ERFEHERDOBIELZRAFT D L D IZ ASA R ETE,

ASDMEFH L TENE T T 77T — 7 NWMIRRTEET, BEA N v 724 X —T7 L
ROV, R TEDDIXY T A A LOFEHERIZIT T, BEA N v 7 &4 X—T LI
T HE, ERID 10 43, 60 43l 12 KA, 5 HIO#EH Y 7 7 2R R TE LT,

JBIEA RV v 7 ZRET DL, ROFIHZEITLET,

FIE

[Configuration] > [Device Management| > [Advanced] > [History Metrics] % i8R L £ 9,
[History Metrics] A » NERARINET,

[ASDM History Metrics] = v 7 R v 7 A% AN L TCREA N v 7 &4 Fx—T7LIZ L,
[Applyl 27 UV v 7 LET,

HR—rShTUWEWNavT U R

ASA THEHTRERR o~ FIRIEEA YT _TASDM THR— FENFETH, BEOI LT 4
Fal—varoavwy RO—FILI TERINIEERHV T, ZhbDa~vr RDiEE A
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ElIar 74Xl —va AT ENTEET,

ASA OBt |

FEHIZ DU TIE, [Tools]>[Show Commands

Ignored by ASDM on Device] & L CT< 72X\,

mMESINASARTTEHaT VR

CLI £l CilBmE =54l

WD,

CASDMO=2y 7 4 X al—2aryTHR—FEND

2. ASDM CilEMEmIFmETERVWa~w L FO—EE2RLET, ASDM CEHIN o~
> RIZASDM @ GUILIZ—BIFRSNFERHA, BrFEHa~r FIEGULICERENE TN, K

LiIxTEEHA,

K6 R—rShTLWELWavTY FO—&

YR—bEIhTLVEWITUFR ASDM D EpfE

capture R INET,

coredump WA SnET, 2, CLIZHEHAL TOAFKETE
F7,

crypto engine large-mod-accel mHSNET,

dhep-server (N2 RV J—T 4 —

ASDM TiE, §XT® DHCP —Zxf LT 12D

eI ) WEDHNFFAI SN ET,

eject AR — b xtgst

established BHINET,

failover timeout BEINET,

fips BRAINET,

nat-assigned-to-public-ip HHINET,

pager BHINET,

pim accept-register route-map M S ET, ASDM Tl [List] 47+ 3 v 21 ek

A,

service-policy global

match access-list 7 7 A THEH I LTV D55 1T AR,
WIZHl R L ET,

access-list myacl extended permit ip any any
class-map mycm
match access-list myacl
policy-map mypm
class mycm
inspect ftp
service-policy mypm global

set metric

IS ET,
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HR—bShTVELaITU R ASDM DB 1E

sysopt nodnsalias RSN ET,
sysopt uauth allow-http-cache WA INET,
terminal mHINET,
threat-detection rate BEINET,

HR—hrEShTWVEWNav Y

F\O)E'/ =

BEOETa L7 4 Fa2lb— g% ASDM IZu— RLEEA. £ 22 R— hxgstoa

< FRH-TH. ASDM DOEIEIZI

HELEYA, PHR— I‘XT%%OD:!V/ RZFRT 51

. [Tools] > [Show Commands Ignored by ASDM on Device] % %R L ¥ 9,

HBR— bR DER L TGN TRY b TRY

ASDM TiZ, 255.255.0255 D L 512 L TW AW 7 Ry h =273 R—FEhTnE

Hh, L& 2E WIFEHATE £ A,

ip address inside 192.168.2.1 255.255.0.255

ASDM CLI YV — )L CHHKR—
EOVAN

fERTWGEWSA 2259747 1—H 0

ASDMCLI Y —Wit, £ 2570 T 47 a—¥ a<w FaEYR— L TWEFTA, 14T

7747&ﬁu%ﬁ%&?écu:V/b%Aﬁﬁé&
VI RBREREINETN. ADHFIT

LT RMLET,
I &R L ET,

[[yes/o]) D AN ZEHERS %7 0
S EHA, BT ASDM 1L, IEDORE % A

1. [Tools] > [Command Line Interface] % &R L ¥ 7,

2. crypto key generatersa =~ > K& AJJLE T,
T 7 A/ D 1024 > b RSA F— AR SNET,

3. crypto key generatersa =~ > RZFHEAT L ET,
VIR RSA ¥ —% E#EE L THAERT L0 TIERL, ROTT—RERREINET,

Do you really want to replace them? [yes/no]:WARNING: You already have

RSA ke0000000000000$A key

Input line must be less than 16 characters in length.
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ASDMCLI Y — )L THR—FEINTVWEWNSA VRS9 T4 T 21— av UK

%Please answer 'yes' or 'no'.
Do you really want to replace them [yes/no]:

SERROR: Timed out waiting for a response.
ERROR: Failed to create new RSA keys names <Default-RSA-key>

[FIRETR
* [ASDM] <A v inh, 22—V ADBRERIFEAEDa~ L FE

enoconfirm 47> a3 VNHBHCLIa~ Y RIZOWTiL, CLIa~> FASBRZZ 47> 3
VEFERLET, RICHFHZRLET,

BiETEET,

crypto key generate rsa noconfirm
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*PAK 7 A B ZIZ2WT (103 ~=—)

*PAK 7A L ADHA KT A4 (120 X—2)

PAK T AL ADERE (122 %—)

 H T A ADEE (AnyConnect 3 LAFI) (127 X—2)

e ET NI LI AR —FENTWEEEDT A A (133 X—)
cPAK AL ADFE=XY 7 (154 =—)

*PAK 7 A & ADERE (155 ~2—)
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b, AR— M VYT T =2T TA B ATT 4 8—T TR EHA,

1> Smart Call Home F§iEIX. HFIZFEE LARWER D A 113720 £H A,

AY—hk SA U REIREZENDEE

ASA I Smart Call Home ¥ — \FEIEZR1T L7z CA OFEMEEZ G N 7 A MARA VM E HE)
AR L £, b — NiEHEFEZRITT 0MENEE S D56, ﬁ‘ 2Ok 2R < T
W, EMEY72 trustpool /N> R/VO HEYT v 77— MR EENT/2 D X 51T, [Configuration] >
[Remote Access VPN] > [Certificate Management] > [Trusted Certificate Pool] > [Edit Trusted
Certificate Pool Policy] [Hi[fj ® [Automatic Import] fEIk 2 5% & L £ 7,

Aw—hK T4V A Y= NINEEAE LT —  FEE L, [Extended Key Usage] 7 « —/L RiZ
rServAuthJ NEENTORITINERY FHA, ZO0OF =y 71, HEBALEAZLSOZEHA
COHRFETSNET, HOBLMHEORE, 207 4 — L RIEIEFRINERA,

A4V RICHAT HIEEFER

ROFIZ, T4 AT 2BIMERZ S LET,

AnyConnect Plus $5 &< U Apex 514 22 X

AnyConnectPlus 3 L WM Apex 74 B A X, FA BV ANEET 22— V=L a2 G757
RCOBEHED ASA ICHATEDFFHEA 7 A B ATY, Av—h TV AEFERATHT
INA ATIE, BEOTZ >~ N7 4 — A1 AnyConnect 7 A & > A WA #EH T 2 L EIXH
DEFA, 2L, ALTA BV RAZEALT, Y7 =T U F—~DT 7 AT 7 =
v B R— N EFEHT 572 DI BE S % Cisco.com ID (ZBIHEAHT AMLERH Y 9, FEA
WZOWTIE, BLFEZRLTIEENY,

+ [Cisco AnyConnect Ordering Guide]

» AnyConnect Licensing Frequently Asked Questions (FAQ)
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« IKEvl Zf# ] L7z IPsec "1 Y —H% 1 ~ VPN
« I[KEv2 Zf# ]l L7z IPsec "1 Y —H% 1 ~ VPN

TDITA B ARFEARTA B RAIZEEFNLTWET,

BEVNtEy S a #, 2847

* VPN & v ¥ a3 > ORKEDO GG, VPN AnyConnect & Z D> VPN & v 3 a3 > DK
L L hoTh, MAEDLEEE Yy a VBN VPN Yy a v ORIREBZ 5 Z
LiIxTEEVA, VPNORKE YV a VEBEB2-5E. ASA 24— "—o— KL T,
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L7etk, 7747 RUASSLVPNAR—H Licu 74 v LA, 22008y a U»
RIS THET,

S ERS1E : ASAv

License Authority [Z#2f¢ 9 DA, @R =1k (3DES/AES) & & BB TE 5D T,
ASDM % L&) L T License Authority (2t 35 = & 23 TX £7°, through-the-box N7 7 4 v 7
D356, License Authority (Z#H2ft L CHEERT S L7 A B A2 WMGTHE T, AL—7"» M
LS HIRS N ET,

A=KV T =T TRV T T AT G ASAY DXk h—27 L 2 BRT DL
[Allow export-controlled functionality on the products registered with this token] = v 7 7R v 7 2 %
AU LT, mERE{t (3DES/AES) OT7 AU AN@AEhD Lo IcLET (ZHEAOT
A0y N CTEOHEMPHFAT SN TWDLENRDH Y £7) . ASAV R TaA LT T7A4 7T 2 AER
W olehty, TV AR—bar T T4 T A =7 UREFIZEH S TOIIE, ASAVIZ
TAB U AZLREFL, L— MBRIRIBIZE S Z L13H 0 8 A, ASAVEFEEEL, =27 AKR—
b Ay T ITAT AN o T DEE EILITASA 2 T AR OBGEICE T L2
G, TA B R FHIBRENE T,

S ERES1t : Firepower 2100

License Authority £7213%7 7 A b — ITEHET DRI, mERT 51t (3DES/AES) % & B
PefelZfEH C&E 20T, ASDM # B T&X £9, ASDM 77 £ Ri%, 77 4+ /V FOKE5{b%
HWHT2EHERNA X —T 2 A ATOMEMATE D Z LICHERE LT ZEWN, EER LT
A ' RTHEE L CHUS 3% £ T, throughthebox N7 7 ¢ v Z I IFFRI SIVEH A,
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A=KV T T2T TAR VT THY Y R0 ASA DB b — 7 L &2 ERT D54
[Allow export-controlled functionality on the products registered with this token] = > 7 78 v 7 A %
AN LT, mERS{L (3DES/AES) OT7A By ARNBEHAENDL X 2ICLET (THEHDOT
A N TCEDHERNFAI SN TWDRENHY £F) o ASANETI LT T4 T ZEIT
Rol-gty, T AR—F arFIA47 A b= YREFITEA ST, ASA 135]
Efi X throughthebox N7 7 ¢ v 7 ZFFALET, ASA ek L, =7 AR —hK 277
AT VAPENI 2o THTH, T ATARREETT, ASAZ LYHIR OBREITHE
LT HE, TA B AFHIBRESNET,

230 LVHIOHT T4 N —_"DNRR—T 5 o Tld, ASARTETCHER LT A & 2% FH)
TERTAVERHLDVET (V7 AFR—F arTF5A4T LA =7 3 FR—FERTWE
HA) . TOHE. ASAN LT TAT UV RAERIZRDE, ANV— T T 4 v 7 TR ENE
A,

S ERSS1t : Firepower 4100/9300 &+ — <

A=Y T NUx=T T4 T MG Firepower ¥ ¥ — 3 Ok h—7 %
FRT 554, [Allow export-controlled functionality on the products registered with this token] 7~ == =
IRy I A AL T, mERG{L (3DES/AES) DT AU AR#MA IS LI ICLET
(ZHEROT 7 hTCEOFERPTRAINTWAIRLERHY ET) .

ASAVGRERT A R L LTINS &, vy —I o mERSLT A B AR SN D7
., ASDM ZEE) L TAL— T 7 4 v 7 ITOREZ T ITHEHTE 7, ASA % T=
VITAT VAREBERII R TGE, T AR— N aryFIAT A V=7 UNIEFICHEA S
AUTWAUE, ASA 1E5| & i X throughthebox N7 7 4 v 7 ZFF A LET, ¥ ¥ — T & ek
L. T AR— K ar T T4 T UV APEHZ /> TODEE, £ v — % LD
BRIECE I LTSS, 74 B ATHIBRESVE T,

T AR—N arFITAT AR M= o EFR—FL TR, 23.0 LVRTOYT T A |k

Y= ROR—=T g U DEA - ASDM I21E 3DES ML ETH 572, CLI 2l L T ASA % &
TREREILTA B A2 THTERTILENRH Y T3, ASARIL T T4 T 2 AEKIZR
HEEBEBHENT T4 v IR IDTA B AREMBELTHANL— T T 4 v 7 XS NER
Ao

DES : I RTHOETIL

DES 94 AT 4 B—T M TEEH A, 3DES TA BV AE A A h—/LLTWBH
&, DES Il & cE£d, MR T 2 MH LzWiEE 12 DES Off %51k
T A2, BARKESALTE T 2T 2 L 20T _XRCoEa~ Yy RERETLHIMLERDH Y F
j—o

Fr )7 SA4EVRA

FrUT TARATIE, BTFOA U ANT v a UHEREDAINT 2 D £,
* Diameter
* GTP/GPRS
» SCTP
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Encrypted Voice Inspection D4 TLS 7113 & v i g %, TLS 74 &2 ZADHIRIZ L TH
v RINET,

TLS 7 uxv vy va zZHT5Z0MOT7T 7V r—>a > (742 ARARE Mobility
Advantage Proxy 72 &) Ti&, TLSHIFRIZKLTH T R LEHA,

TFV = a A& o TR, 1 DOERICEB O vy v a Y EBHT 2580 B0 £,
k ZiX, I A4~V Ly 7T v 7D Cisco Unified Communications Manager % EaEIZFRXE LTz
Bl TLS ek oL 2 > S x4,

TLS 7' v % v O#lfRi%, tls-proxy maximum-sessions =~ > R & 72 {3 ASDM C [Configuration]

> [Firewall] > [Unified Communications] > [TLS Proxy] ~A Y Z i H L TP E T £, £
TIVORIRZ FRT B121%. tls-proxy maximum-sessions? 2~ K& AN LET, T 74/ b
D TLS 7 X UHilfR LY %)mb\ TLS 7r %o 74t Azl 258, ASA T, €D 7
AR —ET DL IITTLS e D ORRAEBRIICRESNET, 71 ZADHIR

FUHTLS 7 U HlRAESLESNET, TLS 7o X fllRE 7 A B 2 L0 D7 BIE

THE, TABVATTIRCOEy Vv a v EERATEEEA,

GE)

(K8 THbDTA oy AMMEE (2L 21X —PHEMN 250 KD 7 A & ) Tk, TLS
TaxT ey CHIE1000 £TICHIBSNET, K9 THKRDDL T Ao ABEEKS (2
kz Fa— PR 250 L EDT AL R) TIE, TLS 7o XL OfilfiEar 7 4 ¥al— 3
WIRAF L, BT VORIRBHRAREIZ/720 £9, K8EKIIL, =7 AKR—MIOWNWTZEDT A
ﬁyxﬁﬁ@énéﬁgéﬁ%%biﬁgKsﬁﬁ@éﬂf\Kwﬁm@éﬂiﬁo

(7z & 2T clearconfigureall = v > RZfEH L T) a7 4 Falb—rarazs V745,
TLS 7’0 & VHlIRNBETNAVDT 7 4V MIRESNET, ZOT 74N FBRT A ZOHIR
X0 H/hE UL | tls-proxy maximum-sessions 2~ > N2 L7z L 12, FOHIREZED D
Iolce T — A ve—URERENET (ASDM O [TLS Proxy] <A > & H) , 7 =—/
F—"—ZAHEH LT, writestandby 2~ > RZ AT 57, £/2ILASDM TF' 7 A ~ U &
1Zxf L T [File] > [Save Running Configuration to Standby Unit] %/ L TI&HIMIC =7 4 F =
L—ya rORMIZITH & &Bh 2 Z U EET clear configure all =~ > 7% H B ARk <
. BEAUHFVEEIZEER -V RRRINDIEDHY T, = ‘/74’ Fal—gr
DEINZEY 7T A4~ VEEED TLS 7'u ¥ UHIRORENE LS NDH D, T OEETHEGR
T&EET,

BH#EI21Z. SRTP IRkt v a VA2 ERTAIEELH Y £,
e K8 T A4 ATiX, SRTP & v a3 ¥1% 250 £ TIZHIREE L ET,
KO T A AT, #HIRIZHD £H A,
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GE) AT 4 TORSAL/EBLEZLE L 25 32— 720, SRIPHIRICH LTV hEET,
T /UK L TARAZNL—=RRESN TV D HAIE, WFO Ly Z73SRTP Téh-> T, SRTP
IRz LTy hSLER A,

VLAN. =K
VLAN ROt G LT H Y 5 A F—7 x4 A2, VLAN ZEI0 M4 TE 1,

RYCRYM S T499 T4 S4E2R

AL F Il T—HR=2R Xy n— K45 (20%, 87855 (3DES/AES) 71t &
75“2\%’6@—0

TJI— LA —N—FIEASA YV SRE 5S4V

ASAVD D T —I)LA—N— 542X
AZNA A=y MUTITTIA~) 2=y FeFLET NV T4 8 ANKBETT,

Firepower2100 D 7 = —J)LA—/\— 54V X

4 Firepower 2100 (%, License Authority £7213%7 T4 N — NIZHREESNTWDLERH Y
9, BAUXY 2=y MGENERITDY £H A, K7 A B A2 TRTHICIE, Vv —
VIEIER DT A ABEATBELERNH D T,

% ASA IZRI UK H b T A B ANMETT, @ERSZT A%, Bk b—27 &6
TBE. MRERDIBEHEOLEHEBINICENMEINET, 2.3.0 LY #]D Cisco Smart Software
Manager 7 74 FBREAINTNDIEHEEIX. LTFTESHRLTIEE0,

TITATIARZ U INNA T 2= )VF—NR_—TIL, 77T 4 THEBEIDOHRAT— T BV
THERECEES, 79747170747 7=2—vE—1R_R—TlX, 7xz—/)LA—— J)L—
TNRT 7T 4 TR TVDHEBIZOAAY— I BV TEFRETEET, REITA
BN 2=y MIERISNETRN, AX NS 2=y MIREEHFHALEEA, ZORTE
XXy v a2 OREBOFEFIZRVET, 77T 4 T REEBOHR—NDT A B ABTRL
F9, ARV RTHE—D T =2 — VA —N"—=F 4 RZELDHDHI, 7=V —/ =D
TCHAEEINET, TOEKNTA BV RAFTAZ AN, 2=y MIbF Y vy 2 S, fBERT
T4 T oy Mol LEIEHINET, T4 BV A Z A TITRO XD ITUE S E
7

e Standard : 77 T 4 TIRIEEDO BB — NI DT A B AZERLETN, AX A
WEIZIZT 7 4V N THEDNTR > TWA Stardard 7 A B AR H Y £9°, TOFEHO-0
W — NI EREIT O MLEITH Y A,

sContext : ZDT AV RIT V7 4 TRBEEOHRDPERLET, 7L, 774/ FT
Standard 7 A B A2 D2 TFA MR EEN, ZNEHFO2=y MZHY £9,
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TATIARB L NAXT DT 7T 4 7704 EIZ30Context 7 A B AERELET, =
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27X A MIHIROFFHN T,
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(3DES/AES) 7 A & ZADFHH T A £ A3 —WH Y £H A,

T =)V —N—DRITIE, LT 7T o TEEBITEN T A R EREEHLET,
Xy v va&8NeTIA v AREEHEHA L, V= NCHERM S 2FERLET, HWT 7T +4
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BATR 2 R0 4, BEICIIEELETA, FFILWT V7T 4 7B S4B ADa
TIAT VAP EIND ETISH T EATHERAGEE R EZERFE L ET, 7= — A —3—
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WCDIHAT—K TARVAEBRETEET, 727471777 47 72— )VE—/"—T|L,
Tz VA== T N—TNRT VT 4 T TN EBEICOBA~Y— N TV T %
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ERTA A% 30 BEEATE TN, oM THREUBEL L TI3A4 T RAERK E D
Uald, B 74 A2 B LT OBORTELET 21T 4272720 £9, SEICITEE
LEHA, FILWT 7T 4 THEIZ, SA B A0 TFI5AT UV ARMHIEENDE T/
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HEHE L v AKX — 2=y NOBRNT—AINLIEHET A ABTERLFET, AL —T 2=
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RGHET, 3022y FOBE, AEHTI00OaL TR A MIMESNET, <A
ey b ETEMD250 2L FF A TV RERELET, LER-T,
HERISNTE T FTAZTA B L AT280D AL T XA N EHhET, 2oy NLDS
7 v M7+ — LR 250 TH D2, eI T A& A TERERK250 D=
TXANBHEAESNET, 280 2T XA MIFIREZBLZTOES, LER-T, <
RS =2z b ETRRB0OT TR MOHERETEET, HAL—T 2=y
b, 274 Fal—a OBEREFLT2500a T FA MEFFOZ LIZRD
T, ZOBATHE, vAF—DALTHRARTL L AL LT20DaTHA L
DHEFREST DUHENRDH D £,

e XX UT B S2S VPN IZHE, ZOT7 A4 B AFTa=y T LEDWHERMSETHD
Faz=y NIV —"DOEEDOIA B AZTERLET, ZOTA B ADREITAL—
7 o=y MZEREINET,

s HERF B (3DES)  (2.3.0 LARIT® Cisco Smart Software Manager V7 7 A MEADLE D

H) DT A AT =y FTEOHRMETHY, Ha=y MIF— 00K HD
TA B AZER L ET, SmartSoftware Manager 7 7 4 FREA I TV 5E, ASDM
MO ERE SRS RE AT D 11X, 7 T AXERKRICYAY — 2=y N TASACLI %
M L CamER ik GBDES) 74 B AT D24 ERHY I, ZOTA A
DREFTAV—7 2=y MIERINET, ®ERS{L BDES) 741t AT A
BUREFUIHY FHAL

HLWS AL —a=y NRBRESNLE, 0=y MNERNTA B 2Z8| G EHLE
T, ¥, SAA—TA BV RAEFBERTLEOIC, Fv v aE&NETA B ARE L
LET, v AF—a2=y MPRAL—T 2=y b LTI TAXIIHESMT S L, A
H—a=y hOTA B AR GBI SNET, TH Ty MIFRAARER T A2 A0k
WSS, AL —T7 2=y MR TA B U RAERILT DRI, A — 2=y FOTAEUVAN
AT TAT UABEREICR D ZERHY ET, REESNTZT AU AL 30 HAEZTT
D, ZOMTHIRLEE L 2 T T4 TV RERK E IR DA, Rl T A U AT LT D%
BEOBRELEFZITRZE A, 2770, IMEIZIZIHELY F¥A, HILWT V7T 47 2=y |
i, A4 B AT TA TV ADHERSND T 12 Bl I & ATHERRAGE H B Rk 2 2415
LET, FA B ABEBRPZERICUIELEINDE T, REDEREAELZTLLEIW, 2=y MR
U T AEMBEENT-BE, Fy v aShiEv A —REITHIRENES, 5T, 2=v b
L OMERIIRE SN ET, ZOBRE. VAN DA=y FDOAUTHRA N T ARH
FRTDHMLENRH D FT,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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AX—F YT LT T7 T4 ADHHREHR

* Cisco Smart Software Manager C~ A% — 7 17> M &ERK L £ 7,

https://software.cisco.com/#module/SmartLicensing

FETHVY MERBRLTROEAIZ, V7227 v 7 LTHLWT ATV REREL
TL 72 &V, Smart Software Manager Tl flfkD~A X — T h o v F&ERTE £,

» Cisco Commerce Workspace 2>5 1 DA EDO T A B A AL ET, &—2 =D [Find
Products and Solutions] #8387  —/LV K C, A B APID ZME L T, —HDOTA
AR TI N, A~v—F VT 0T TAR AT AV MIENL 2B 5 0H
B0 ET,

* ASAv I LW Firepower 2100 : 7 /34 ANHDA X —Fy N 778 A, 72X HTTP 7
nXy 7T IRA FEYTIA NV RADT VA EEELET, 2. KT A
B ADOTFRERMTLZI b TEET,

+ ASAv 1 X O'Firepower 2100 : 7 /34 A 73 License Authority D4 Bij 2 il T& % X 9 IZ DNS
= NERELET,

» ASAv 3 LU Firepower 2100 : 7 /34 A0 7 v v 7 %5 E L £, Firepower 2100 Tl,
FXOS T/ my 7 & E LET,

« ASALI : Kt T A & ADTHIE Azure A N— A P TEHR—FShEEA,

* Firepower 4100/9300 > ¥ —3 : ASA 7 A & A A ET HAIIZ, Firepower 4100/9300
Yy —V TCAY— R YT NIx2T FARVAA VT TANT I F ¥ EHRELET,

AR—EYVYIEDIT7 SACVADHA RS54V

A=K YT 2T FTA B ADIEBYHR—FINET, ASAvVOEWNY 7 F 7 =72
DWTIE, PAK 7 A BV ARG SNTZBEFO ASAV 2T v 77 L— RT 5854, Ao
VANV LET VT 4N =gy T ERINE TR, TS RS NE T,
ASAV X T L— KT 5L, TOT 4=V ay F—=NEELET,

e KT A B ADTFRINZONTIL., TS, AZEET AN TA B AEZETHLERH Y
¥, A BV AFZERICEER WS, T4 B U AMERTOREOEEIZRD ., HLW
T A AZFHEHTE EHA,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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AYX—bFYITIFDTT7 A ADT 7L F

ASAv
¢ ASAV OF 7 4 /L FEREICIT. FREE/HD URL 2453 5 Smart Call Home 712 7 7 A JL73
GENTVET,

cASAVZE AT D L X, HEEE A L—Ty b LULERE LT, BIFS T, R

LV DBEFERTEET, K T7A B ATROBE, ZNODNRTA—XERETDH
VEITH Y FH A, KETA B ATREAEDICTLE, ZhbDavr NiEar 7 g
Fal—TarPbHlRInET,

e Fm, WMAIRIEE CTHITP PR X  2RETEET,

Firepower 2100

Firepower 2100 ?OF 7 # /L b E121%. Licensing Authority ® URL ZF8E T % [License] &>
5 Smart Call Home 7’2 7 7 A LR EENTWVET,

Firepower 4100/9300 > v —3 L@ ASA
TI7HNVIRETHY A, BET A AME, BXOFEOMOF T3 T4 AT
FEICTHMETDILERH Y £,

ASAv: AX— K YT+ TT7 5S4V DETE
IO arTE, ASAVICAY—h V7 hNT 2T TABVAERET D HIEZHHALE
T WOFEDOHF NG 1 SZ2BIRL T EEN,

FIE

ATFYT1 ASAV : EIA~— K V7 "I 2T S4B T7TOHE (183 ~2—) .
RATFY T2 ASAv : KiETA B ATRORE (188 X—) .

ASAv : EARR—h VI b7 SAEVVVTDRRE
ASAv ZJBBHT 25818, 73 AZFEFNIERE L. License Authority (2 8% T 2 72 DI B &k
M= ZBEHLC, A~—h Y7 0T T4 VU TERENT D ENTEET,
HTTP 7'm %3 = T A v 2R G2 L ET DLERH L5E . £7213 ASAv 2 Bk
THVENS LS Dayd 2 7 4 Fab—2a 2D b—27 V2G0T BAa77R E)
X, ROMEEEITOET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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FIE

ATFYT1 T4 B ADOREE ASAV OBGE (184 _—3) JEBHEFICHRE L7 HTTP 7 12 3 3 £ 72 1T HERR
(EEZEETHZVNENDLIES. E/IXASAV AR LIZEXIZID h—27 U ZEDRhoT-
BAIT. ZoFEEZETLET,

ATFwT2 (7 ar) ASAv ORGSR (187-—2) F/2ik (A7 ay) ASAVI AT T 4T 4
AERAEFEZIE T A B U ABKOES (187 X—) HA[RETT,

T4t ADEKRE & ASAv D E %

I arOHTTP 7 u XL 2REL., T4 B2 AR5 28R L, ASAv & &81 51213,
WDOFINEEZEITLET,

\}

GE)  ASAV AZJEBH L7z & &2, HTTP 7' r ¥ v & T A & o AMERAT R FANI R E STV D AThE
WRHY ET, /o, ASAVEZE L7 XICDay0 2> 7 4 F 2 b—a U CHEEh—7 >
PHEENTVWDLAREMERDH Y £4, TOHAIE., ZOFEZMEH L THRET2LETH Y £
A,

FIE

AT w71 Smart Software Manager (Cisco Smart Software Manager) T, Z DT /A ZAZBINT H/3—F ¥
VT AT NOBREGERN—T U EBER L Cat—LFET,
a) [Inventory] #7 VU v 7 L7,

14: 4RV L)

Cisco Software Central > Smart Software Licensing

Smart Software Licensing

Alerts Inventory License Conversion Reports Email Motification Satellites Activity

b) [General] # 7 C, [New Token] #7 U v 7 LE T,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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15: L=

General Licenses Product Instances Event Log

Virtual Account

Description:

Default Virtual Account: No

Product Instance Registration Tokens
he registration tokens below can be used to register new product instances to this virtual account

Token Expiration Date Description

NWU1IMzY 1MzEtZ]NmOS00MjF..8  2018-Jul-06 14:20:13 (in 354 days) FTD-5506

c) [Create Registration Token] % 7 12 77K v 7 AT, LA F OB EM%Z AT L TH 5 [Create
Token] %7 V v 7 LET,

- SEA
« Expire After : #53E1% 30 A T,

* Allow export-controlled functionaility on the products registered with this token

ol =V
FTAT VAT T TEH MM LET,

16: %85 b—o VDR

Create Registration Token

This dialog will generate the token required to register your product instances with your Smart Account.
\firtual Account:

Description:

ASAFP 21101

= Expire After: 30 Days

Enter the value between 1 and 365 but Cisco recommends a maximum of 30 days.
Allow export-controlled functionality on the products registered with this token €

Create Token Cancel

h—2 3 A o _ R ICBIMENET,

d) F—27 OFMZHDRET A% 27 U2 LT [Token] XA T RTHRy 7 AZRE,
=22 ID%EZY Yy TR=RIZaE—TEDLIICLET, ASA DBGEPMLER E X
BOFETHERTLH-DIC, 2O U 2HHELTBEET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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General Licenses Product Instances Event Log

Virtual Account
Description:

Default Virtual Account: No

Product Instance Registration Tokens

The registration tokens below can be used to register new product instances to this virtual account

New Token...
Token Expiration Date Description Export-Controlied Created By Actions
M|M32JIhYTIT.ZGOdOSDDYJK2U@ 2017-Aug-16 19:41:53 (in 30 days) ASAFP 21101 Allowed Actions =

18: h—H>DaE—

Token 0 X

MjM3ZjInYTIZGQ40500Yk2LTgzMGIMThmZTUyY]ky
NmVALTETMDISMTIT %60AMTMxMzh8YzdQdmgzMjA2V
mFJN2dYQjISQWRhOEdscDU4cWISNFNWRUtsa2wz %
NAMDANSTN%AINANA

Press ctrl + ¢ o copy selected text to clipboard.

RFvF2 (EE) HITP 7u %L ® URL ZfELET,
Fv NT—7 TA Vv H—Fy N TZEAZHITP 7o x V2T 5854, A~—hL Y7k
VxT TARADT XY T RV AZRETHLERHY £, 20T uXiq, R
Smart Call Home IZ & H S v E 7,
a) [Configuration] > [Device Management] > [Smart Call-Home] % 38R L ¥ 9,
b) [Enable HTTP Proxy] # 4 > IZ L7,
c) [Proxy server] 33 & OY [Proxy port] 7 4 — /L FIZ72 ¥ DIP T RLAEAR— M2 AN LE
T, 72 & ZUE HTTPS — DR — k443 Z A LE T,
d) [Applyl =27 V> 27 LET,
RT9T3 T4 AHERMNGEZFRELET,
a) [Configuration] > [Device Management] > [Licensing] > [Smart Licensing] D JIHIZ3 R L %
hd_o
b) [Enable Smart license configuration] = 4 12 L £ 7,
c) [Feature Tier] K1 v 7% 7 A== —5 [Standard] Z 3R L £7°,

EHTE 5 DITHEHERE 21T T,

d) [Throughput Level] K2 v 7 & ™ A ==a—7/6 [100M]. [1G]. [2G]. [10G] Z3&R L £
j—o

(G¥)  [Enable strong-encryption protocol] = v 7 7R v 7 A3 A NI LN TL 2 &V,
ZOREF, 23.0 LOFIOVT T A b F—EHHTT,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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ATy T4

73 asavoszzk ]

e) [Applyl %27 V27 LET,

ASAv @ License Authority <~ %5k,

a) [Configuration] > [Device Management] > [Licensing] > [Smart Licensing] DJIRIZE&R L &
D

b) [Register] #27 V v 7 LET,

c) [ID Token] 7 4 —/V RIZ&GK h—2 &2 AT LET,

d) (7T =) [Forceregistration] = v 7 7R v 7 A% 4 /|12 LT, License Authority & [f]
B SITWRUWATREMEDS & 2 Bk 7+ D ASAv Z 8k L £7,

72 & z1%. Smart Software Manager 7> 5> T ASAv % HlIfR L 723541C Force registration
ERHEAHLET,

e) [Register] 27V > 27 LET,

ASAv (X, License Authority ~D X §kZ il REINTZT A & A OFRIEL ER L E
@—O

(T a>) ASAv D EExfERR

ATy T
ATy T2

ASAV DREREFRERT D L. TH U Minh ASAV MHIBRS 4L, ASAV DT RTD T A R
G CFEENHIBR SN E T, BEREMRT 2L T, TV A EFH LV ASAVIZFIIT %
ZEHTEET, HDHWIL, Smart Software Manager (SSM) 75 ASAv ZHIRCTX £,

FIE

[Configuration] > [Device Management] > [Licensing] > [Smart Licensing] DJIRIZE&R L F 7,
[Unregister] 7 U v 7 LE7,

ASAV N m— RENET,

(FT23aV) SAWNFATUTATAHMAZFLRF SV REROER

ATvT1
ATy T2

FTIFINVENTIE, AT T 4T 4iEHEIZ 6y HI L, A48 AEKIZ30 HZ LICHE)
BICHEHEINET, A Z—Xy N T 7 ZOHBINBEOLINTWAEEXC, Smart Software
Manager CT7 A B AZEER LG E2 R, INOOREETETEHRITLHILLTEE
-éAO

FIE

[Configuration] > [Device Management] > [Licensing] > [Smart Licensing] DJIH|Zi#R L £ 3,
TAT T 47 4 EEETH T 521X, [Renew ID Certificate] #7 U v 7 LET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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ATV T3 T4 AEHKERH T HIZ1E, [Renew Authorization] 27 U v 7 LE T,

ASAv : kiS4 o RAFTHNDETE

ASAV ICKFETA B AZBIN B THZ ENTEET, Z0O®Z T3 Tl ASAv DEFER
ETFNVBOEFRLEICEIVHLWVWT A B ARKEE RSB/, T4 B A ERT )
BIZOWTHBHAL X7,

FIE

ATV Tl ASAV X—< R b TA BV ADA A =L (188 X—)
ATFwT2 (IE) (A7 ar) ASAv D/ 8—< Ry kN T4 ZADOEHE (190 =2—3)

ASAV /R—T R b A ECVADA VR =)L

A B —Fy N T 7 BAERTZ/20 ASAvs D34 1%, Smart Software Manager 7> 5 /3 —< R >
b IABVAZERTEET,

\}

GE)  R==Rr b TABLVADTHRITONTIX, ASAVEZFEFHET HHNCTA B AEZRETLERH
DET, 74822 ERICESR2WE, T8 AREHAFOREOE FICRY, HLW
ASAVICEEH CEX £/ A, (A7 ar) ASAVDO/R—< %2 b T4 B ADIRA (190 ~2—
V) BBBLTLIEEND,

458 HHEIIZ

e N— RN TA B AEEAT S & Smart Software Manager TZALDL 2 TE £,
FTRTCOTH T P R—=< % b TA B ADTFRITONTEKBEN TN D DT TIEDH
DEFA, REZRABET LRI, ZOBEREIZOWVWTY A aDEBNH DL Z L 2R L E
j—o

¢ ASAV DEFNERICR—~F 2 b TA BV AZERTELERHY T, FOH= 7 4
Fal—raryD—EE L T—~R L N IA BV RAREA VA=)V T BRI ELIITEEY
/\Jo

FIE

ATYT1 ASAVCLI C, "= R F T4 B ADTFHIEZRD L HITHMILET,

license smart reservation

ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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ATy T2

ATvT3

AsAv $— 42 b S vRD1 VR =L [

1 :

ciscoasa (config)# license smart reservation
ciscoasa (config)#

WD a<r RPHIBRSNET,

license smart
feature tier standard
throughput level {100M | 1G | 2G | 10G}

BHDOA~Y—F T4 ABEHATHIE, Z0a~vr Fon BXE2FEHL, Litoa~yr
REBANLET, FOMD Smart Call Home fX E1XF DO F FHEEFSINE TN, FEHINZ2W
72, FRo0avwy ReEFANTHIHEETHD FH A,

Smart Software Manager (ZAJ]T 5T A A a— REROLHIZERLET,

license smart reservation request universal

&1

ciscoasa# license smart reservation request universal

Enter this request code in the Cisco Smart Software Manager portal:
ABP:ASAv, S:9AUSET6UQHD{A8ug5/1jRDaSp3w8uGlfeQ{53C13E

ciscoasa#

ASAvV B ARFIZHHT 2 ET /L LU (ASAV5/ASAVIO/ASAV30/ASAVS0) % R 5 MLEEAH
HVET, TOETIV LI EST, BRTDLTACABRED 3, B TET L LA
NEERLIEWGEIE, BIEO T A AR, BREOET IV Lo-UIHHRT 25T 7
ARV AEZERTHLERDHY £9, BEICEAINTVD ASAV DET IV EEET HITIE,
A /8= F 5 vCPU & DRAM O EEH LWET VEFICEbE TERTE T, Th
OOEIZDOWNTIE, ASAVY A v 7 AX— KA FESZR LTI, BIIEOET LV EFRR
T A5I12iE, showvm 2~ RE2EHLET,

Zoavr REHFANTLE, Ve—RRICLRICa— RBRRINET, ZOa—RE2E72
Smart Software Manager (ZAJ] L TWRWEE, BRE X ¥ L3512, T2 AN LE
D

license smart reservation cancel

N X N TARADTRET 4 8—T7 T DL, RETOTRTOERNF ¥ &L
S ET, 9 TIZ Smart Software Manager |IZ 21— FZ AJJ L TWAHGEIX, TOFIEELET L
TASAVIZ I A B AEZWHATH2LENHY $9, TOREENL, LEISLTIASA V2%
RS ZENARRICARD £9, (A7 v ar) ASAVOR—< 32 b T ZADEH (190 2—
V) BRIRLTLIEIN,

Smart Software Manager > X2 I U HIEIZFE) L T, [Instances] ¥ 7% 7 U v 7 LE 7,

https://software.cisco.com/#SmartLicensing-Inventory

[Licenses] # 727 0 v MIBET 2T X TOBEFED T A B AR BEHEL LU —v R
FOWS EbRRINET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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B 7030 aswos—vso k5120 20ES

AT w74 [LicenseReservation]| %7 U v 7 LT, ASAvD— R%& R v 7 A A LET, [Reserve License]

7 Vw7 LET,

Smart Software Manager 3K 2 — R&AAERK LET, a—FE2Fvrmn—RELIEZ Y v 7R —
Rizabe—T&Fd, ZORRT, 742 AL, Smart Software Manager (25t > Tl HH T
-g‘o

[License Reservation] 78 &% N FER S WIGH, BEWOT U MInNn—~vxr h 74tk
YADTHRIIOWTRR SN TV EE A, ZOHE, =X b T B ADOTHIZ B
LTHEHEDA~— K T4 R avy REFANTLLENH Y £,

ATvT5 ASAV T, AR — RERD I IICATILET,

license smart reservation install code

&1

ciscoasa# license smart reservation install AAu3431rGRS00Ig5HQ12vpzg{MEYCIQCBwWS
ciscoasa#

THT, ASAV TA B U ANERICEASNE L,

(FTar) ASAVDN—TI R b 54t RDRA

ATy I

N== R F TA R APREI R T235E (ASAV ZFEFET 256 ASAV DET )L LUb
DEFIZL>TH LW T A B ARKBEIZ R T25572E) | LFOFIEE-TTA LR
Z 1IERUZ Smart Software Manager |2 T MERH D £9, TXTOFIRLETLRNVWE, T4
TUABPEHTOEEICRY | MMOGFT THMT S 1-OICES IR TS <m0 £,

FIE

ASAv TIlRHIZ— RZRO X HITER L ET,
license smart reservation return

1 -

ciscoasa# license smart reservation return
Enter this return code in the Cisco Smart Software Manager portal:
Au3431rGRS00Ig5HQ12vpcg{uXiTRfVrp7M/zDpirLwYCagq8oSv60yZJuFDVBS2Q1iQ=

TZIZHIZASAY DT A B A< 720 . FHERBICBATLE T, Zoa—FE2FERTTD
VERHLEEIE, ZOa~vy REFANLET, HiLvwi—~vxv b T4 REERT 5
(license smart reservation request universal) 7>, ASAv DET /L L -V &2 EF T3 (BR%ZY)
Y vVCPURAM 2£E ¥ 2%) &, ZOa— FaBRRTERLRDL I LITERELTIEI N,
WP, I—FREF Yy 7 TF ¥ LT, BIMEELT T LTIEEN,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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AT w72 ASAv L= N—H )L T3 ZFHIF- (UDI) %37~k L C, SmartSoftware Manager N C Z @ ASAv
A VAL A ROTET,

show license udi

&1

ciscoasa# show license udi
UDI: PID:ASAv,SN:9AHV3KJBEKE
ciscoasa#

AT w73 Smart Software Manager - > X2~ U [#{# |28 L C. [Product Instances] ¥ 7% 7 U v 7 L ¥
—g—O

https://software.cisco.com/#SmartLicensing-Inventory

[Product Instances] # 712, T A BV ARMFHEINTND TR TOREN UDLIZL > THRRS
ET,

ATV T T8 AEMERT D ASAv ZHEZR L. [Actions] > [Remove] % %K L T, ASAv OiRH=— K
R 7 A AT L ET, [Remove Product Instance] 272 U v 7 LE 7,

NRew X b TAB U ANMERTRER T A B ADT— MR ENET,

Firepower2100 : RY¥—+ Y2 b7 SA4 D VT
DEXTE
Z DI TIL, Firepower2100 (A~ — K V7 Ny =7 A4V T RFRET HHIEZHH L

FT, ROTGEDOHINE 1 DZBIRL T IEE 0,

FIE

AT w T 1 Firepower 2100 : EA~—h VY7 =7 T4 TOFRE (192 %—) |
(A7 a ) Firepower 2100 DBGKRER (EWIIB IO T T4 ) (200 ~—2) F7zi
(A 7> 2 ) Firepower 2100 ID GEFEF 72137 A & o AHERM 5O FH (BB L0 T 7
A k) (200 =) HLARETT,
AT F2 Firepower2100 : Y77 A h A~—K VT b =T T4 TORE (1953—) .

(F 7> 3 ) Firepower 2100 DEEKfEER (EHB LOHT 74 F) (200 *—2) 721X
(A7 =) Firepower 2100 ID GEBE L 72137 A & o AMER 5-OFH (EMB LT Z
A F) (200 2—2) HLEEETY,

AT w73 Firepower 2100 : Kt 7 A £ A THROHEE (196 <—) .

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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ASA OBt |
B rirepower2100: AT —F VIR T SV UL TOR

Firepower2100 : E IR — b+ VI FD 7 SA4 VU TDEE

&
Z OFNEIL, License Authority Zffif L7= ASA [CHEH S vE T,

FIE

AT 71 Smart Software Manager (Cisco Smart Software Manager) T, Z D7 /NA AZBINT 5 /3—F %
NTATY OB —7 o EERLTat—LET,
a) [Inventory] %7 U v 7 LET,

19: 42~ Y

Cisco Software Cenfral > Smart Software Licensing

Smart Software Licensing

Alerts License Conversion Reports Email Motification Satellites Activity

b) [General] # 7 C, [New Token] #7 UV v 7 L¥7,
Ba0:#H LN =D

General Licenses Product Instances Event Log

Virtual Account
Description:

Default Virtual Account: No

Product Instance Registration Tokens

The registration tokens below can be used to register new product instances to this virtual account

Token Expiration Date Description

NWU1IMzY 1MzEtZ]NmOS00MjF..8  2018-Jul-06 14:20:13 (in 354 days) FTD-5506

c) [Create Registration Token] # A 7 2 77K v 7 AT, LA TFOREME AT L TH D [Create
Tokenl %7 V v 27 LT,

- EEA
« Expire After : #E45EfEI% 30 H T,

» Allow export-controlled functionaility on the products registered with this token : ¥ = > 7
FTAT VA TIT T2/ MMILET,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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-

Firepower2100 : TR Y —F VYT b7 SA4 2V VHTDE

21: B85 b—0 VDER

Create Registration Token

This dialog will generate the token required to register your product instances with your Smart Account.

\firtual Account:

Description: ASAFP 21101

= Expire After: 30 Days
Enter the value between 1 and 365 but Cisco recommends a maximum of 30 days.

Allow export-controlled functionality on the products registered with this token @

Create Token Cancel

h—27 3A v _v MICBEmMEnET,

d) b= OFRMIHIRET A ar% 7 Vw7 LT [Token]| #A 7T a7 Ry 7 A&,
=22 ID%aZ7Y Yy TR=KRIZaE—T&E5LIICLET, ASA DBFENPMLER E XI|Z
BOFIETHEATHEZDIZ, 2O =T U 2HHLTBXFET,

22: k=9 VDORE
General Licenses Praduct Instances Event Log

Virtual Account
Description:

Default Virtual Account: No

Product Instance Registration Tokens

The registration tokens below can be used to register new product instances to this virtual account.

New Token...
Token Expiration Date Description Export-Controlled Created By Actions
M]MEZJIhYTITZGOdOSﬁOYjKZL@ 2017-Aug-16 19:41.53 (in 30 days) ASAFP 21101 Allowed Actions ~

B23: =Y rDatE—

Token 0 X

MM3Z]IhYTIZGQ40S00Yjk2L TazMGItMThmZTUy Yjky
NMVHLTE1MDISMTI1 %0AMTMxMzh8YzdQdmazMiAZY
mFJN2dYQjIEQWRhOEdscDU4cWISNFNWRUtsa2wz%
NAMDANSTNSAANANA

Press cfrl + ¢ fo copy selected text to clipboard.

AFwv T2 ({EE) ASDM T. HTTP m % URL #HEL £,
F NT—=JTCA v HF—Fy N TZEBRCHTIP a2 2T 584, A~—K Y7k
T TARADT XY T RLAZRETHILERHY £9, Z07ax L, —iKi
Smart Call Home |Z & H S E T,

a) [Configuration] > [Device Management] > [Smart Call-Home] % %R L £ 7,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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. Firepower2100 : TR Y —F VI L7 SA VO VT DERE

ATvT3

ATvT4

b) [Enable HTTP Proxy] 4 12 L&,

c) [Proxy server] 33 X OV [Proxy port] 7 4 —/L RIZ7BX T DIPT RLALR— 2 AN LE
4, 7=& ziE. HTTPS — DR — 443 Z AL £7,

d) [Applyl®7 U w7 LET,

TA B AR 5 2RE L E T

a) [Configuration] > [Device Management] > [Licensing] > [Smart Licensing] O JIHIZ2R L %
7

b) [Enable Smart license configuration] 412 L ¥ 7,

c) [Feature Tier] Ku v 7% 7 A =a— 5 [Standard] ZZR L E 7,
EHTE 2 DIIERERTZT T,

d) (EE) [Context] 7A B ADHH, a L THFAFOKEANSLET,
AT FRAMORREIT, ET ML TERRY T, 774/ F Tl ASAIF2Ho0D=
VTXARNEYR—FLTWEHTD, BRI THIFANOENL2OOT 74V K v
TXANEEZLSWELDOEERTAHILERHY £,

(G¥)  [Enable strong-encryption protocol] = > 7 R v 7 ZIA N L RN TL IS0,
ZOREF, 23.0 KVEIOYT T A F = EHATT,

e) [Applyl 2V v 7 LET,

ASA % License Authority [Z 58k L F 77,

a) [Configuration] > [Device Management] > [Licensing] > [Smart Licensing] D JIRIZ 38R L %
7

b) [Register] 227 Vv 7 LET,

c) [ID Token] 7 4 —/V RIZHEK h—2 V2 AT LET,

d) (F 7T =3 r) [Forceregistration] 7= > 7 7N v 7 A% 74 {2 LT, License Authority & [A]
B SR TWARWATRENEDS & % B Gk A D ASA & X%k L £,

7= & 21X, Smart Software Manager 7> 53> T ASA % HlIF& L 72354 1Z [Force registration] %
HHLET,
e) [Register] 7 U 27 LET,

ASA L, License Authority |28k L, 8XIE S T A & o ZHERMT 5 OFGEZ ZR L E T,
License Authority [Z. ZEEM O T 4 7 o F3FFA[ LR ) 7ehE 5k (3DES/AES) 71 &
PABWMHLET, TA A RT—F AL D5 1%, [Monitoring] > [Properties] >
[Smart License] DJIEIZEER L £ 5,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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Firepower2100 - 4754 k 2¥— bk Y7 k17 S1tvovrngE |

Firepower2100 : 45754 F AYX—F VYT b7 54DV TD

=JL ==

ax AE

ATy I
ATy T2

ATvT3

ATvT4

ZOFEL YT IA N A= VYT UT TABV T =BT D ASA (T3
MEhETd,

48O HREIIC

Smart Software Manager %7 7 1 ~ OVA 7 7 A /L % Cisco.com7/*H X 7 > 20— K L, VMwareESXi
P—=NZA VA P—=ABLORELET, FEMICOVTIE,  [Smart Software Manager satellite ]
ML TLLTZEN,

FIE

YT T4 N = "THREEN—27 EBERLET,
({E&) ASDM T, HTTP 7m ¥ URL ##REL £,

Xy T =0 TA L H—Fy b 727 EBAZHITP Fux T 2T 5848, A~—KF Y7k

V=T T4 ADTuFY T FVRAERETDHLENRDHY £T, ZoOTaF A%, fRIC

Smart Call Home (Z b H S v E 7,

a) [Configuration] > [Device Management] > [Smart Call-Home] % & L £ 7,

b) [Enable HTTP Proxy] &4 12 L &£,

¢) [Proxy server] 3 LU [Proxy port] 7 4 —/L RIZ7 B XD IP T KL ALR— b 2 AN LE
T, 7o& ZIE, HTTPS #— DR — b 443 Z AJLET,

d) [Applyl®7 U v 7 LET,

FABLU AP —=NOURLEZEELT, ¥ 774 8 B—ICBEILET,

a) [Configuration] > [Device Management] > [Smart Call-Home] % 584R L £ 7,

b) [Configure Subscription Profiles] i}k T, [License] 7' 02 7 7 A L& fRE L £,

¢) [Deliver Subscriptions Using HTTP transport] fiE55 T, [Subscribers] URL Z3%&R L, [Edit] % 7
Vw7 LET,

d) [Subscribers] URL R DEIZET L, [OK] %27 Vv 7 LET,

https://satellite_ip address/Transportgateway/services/DeviceRequestHandler
e) [OK]ZZ7 Vw7 L, &5 [Applyl 227V v 7 LET,

TA U AMERA 5 ARE L ET,

a) [Configuration] > [Device Management] > [Licensing] > [Smart Licensing] DJIRIZE&R L &
7

b) [Enable Smart license configuration] = 412 L ¥ 7,

c) [Feature Tier] K2 v 7*'X 7 A== — 5 [Standard] Z IR L 97,

EH T 2 DITHRHEZ 21T TT,
d) (EE) [Context] 7A B ADHE, a v THFAMOKEASLET,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME)
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AsA oFAsE |
. Firepower 2100 : 5kt > 1 t > X FHIDEKTE

AT HRANORREIT, T ML TR £F, 774/ P T, ASAIF2 5D =
YTHRAREYR—FLTWDED, BBERIAVTIANDOENL2OOT 74V b A
TXAMEELGWEbDOEZERTLZMLERH Y £7,
(G¥)  [Enable strong-encryption protocol] = > 7 R v 7 ZTA N LN TL IS0,
ZOREE, 23.0 KVFIOVT T A~ Y —EHTT,

e) [Applyl &7 Vw7 LET,

AT w75 ASA % License Authority |28k L £9,

a) [Configuration] > [Device Management] > [Licensing] > [Smart Licensing] D JIRIZ S8R L &
D

b) [Register] #27 Vv 7 LET,

¢) [ID Token] 7 4 —/V RIZREK h—7 »EH AT LET,

d) (7T =) [Forceregistration] = v 7 7R v 7 A% 74 {2 LT, License Authority & [F
H S TRV RATRENEDS & 2 B Gk A D ASA &8k L £,
72 & 21X, Smart Software Manager 7> 572> T ASA % HIIBR L 7235412 [Force registration] %
BEHLET,

e) [Register] 7 U v 7 LET,

ASA X, License Authority |28 8k L, 5XE STz T A & 2 AMERRMT 5 OFBGEZ ER L E T,
License Authority 1Z, ZEEHOT 4 7 > R FFA LR ) elE 5k (3DES/AES) 74 &
YABWMHLET, TR RT—F A LT DA 1%, [Monitoring] > [Properties] >
[Smart License] DNEIZEIN L 97,

Firepower 2100 : kit 5 1 £ > XA FHRIDEETE

Firepower 2100 {27kt 7 A B A ZF VB THZ N TEET, ZOHTIE, ASAZFEIETD
BRCTA v A IHEC OV THRH L ET,

FIE

AT w T 1 Firepower 2100 Kt 7 A L ADA A h—)b (196 X—) .
ATy T2 (EE) (F 7 3) Firepower 2100 Kt 7 A 7 ADIEHE] (199 ~—) .

Firepower 2100 X#t 51 2 ADA VR k—JL

A B =3y N T 7 BAEFTZ72\ ASA DA 1, Smart Software Manager 7> 5 7K #i 7 A & >
A BRTEET, K7 A B ATIE, TNTOBENEINTRD EF (BF2UT 4 3
THRANPBRROBERET 4 7)

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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Firepower 2100 k%5 1 £ > 204 v 2 b—L ||

G¥)

ATy T

ATy T2

ATvT3

K7 A | ADTHINZONTIE, ASAZBEFRTHANCTA B AZRERTHLERHY £, 7
A A EXICRSRVWE, TA B ARMEHTOREOE ISR, B L ASA (2L
HATxEdA, (FFT =3 2) Firepower 2100 kit 7 A £ ADIRA (199 ~—) ML
TLEEW,

B8 BRI

N p o b TA B AZEAT S L. Smart Software Manager CZINLH ZFEHATEE4, &
RCDTHT Y FBRR—=<R L FTA B ADTRINIOWVWTHEBINTWDIDITTIEHY £H
ho BREZEBBT HANT, ZOBKEICOWTURAIDOERBNH L Z L aHRLET,

FIE

ASACLI T, KfET7A L ZADFHIZRD L HITHMTLET,
license smart reservation

51

ciscoasa (config)# license smart reservation
ciscoasa (config)#

Smart Software Manager (AT 57 A A a— FE2RO LI IZHERLET,

license smart reservation request universal

51 -

ciscoasa# license smart reservation request universal

Enter this request code in the Cisco Smart Software Manager portal:
BB-ZFPR-2140:JAD200802RR-AzKmHcc71-2A

ciscoasa#

Zoavry REHFHANTLE, Ve—RRICLRICa— RBRRINET, ZOa— e E2
Smart Software Manager (ZAJ) L TWRWEGE | BRZF v AT 5121, UTE2 A LE
ﬁ—o

license smart reservation cancel

N X b TA R ADTPRIZT 4 =TT DL, RETOTRTOERNF v 2L
SN FET, $CIT Smart Software Manager (27— KZ AL TCWAHAEIE, TOFIEEZET L
TASAIZTA B AZWHT DLENRDHY £, TORFRNDL, BEIELTIA B A%
R ZEMNAREICR Y £, (A7 3 ) Firepower 2100 K#t 7 A & ADEE (199 ~—
V) ZZRLTLEE N,

Smart Software Manager f > -2 kU i (28 L C, [Instances] ¥ 7% 27 U v 27 LET,

https://software.cisco.com/#SmartLicensing-Inventory

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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B rirepower 2100 kS 4 £ 22D VR b—iL

ATv74

ATy TH

ATvT6

[Licenses] # 7127 > MIBEHET 2T XCTOREGFD T A U AN, EHELBION—v
FOW G EbRARINET,

[License Reservation]| #27 UV v 7 LT, ASADa— R%&HR v 7 A AJILET, [ReserveLicense]
27y LET,

Smart Software Manager 3 KG8 2 — R&EER LET, a—FE2Xvran—RERIEIZ VU v 7 HR—
Nlzabe—TxFEd, ZORRT, 742 AL, Smart Software Manager |Z9¢ > CHEHH T
—éﬂo

[License Reservation] /8 & ' BNER I N2 WA, BEWOT I MIN—vx bk 714k
VADTHRINIONWTHEB SN TWERFA, ZOHE, X—~3R h T4 ZADOTHIZ TN
LTHEEDZR~Y—F TFAEL R a<wy FEFBANNTALERSH Y F7,

ASA T, KRa— FZROLIIZADLET,

license smart reservation install code

51

ciscoasa# license smart reservation install AAu3431rGRS00Ig5HQ12vpzg{MEYCIQCBwS
ciscoasa#

ASA TT A & AMERRFT 52 BR L E T,

ASA DFBGE THERAT G- 2 ZRT 5 Z LI2E D ASA TENDLZMEHTE 5 L 9IS 245N
&) D \i—gﬂo

a) AV AAY—F ar74Xalb—varE—RNEfBLET,
license smart

51

ciscoasa(config)# license smart
ciscoasa (config-smart-1lic)#

b) HEEEEZRELET,
feature tier standard

EACEDDIMEHERBZ T T, 747 74 B AL, MOEET A B A2 BINT 57
O ORITESRMTT,

C) ’IZ'}(:J_U?/]’ :’.\/?#Z F@?%tyx%g;}%{/ij—o
feature context number

IUT XA NDRREIIET VICE TR 3, I, KT A o RTITR R
DAVTHFAINNEENTNDZOHT, KRENL2OOT 74/ k 2T F A FEEREWD
2HDEERTIVNENRSH Y 7,

51

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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(A7 3>) Firepower 2100 kS 1 2 > R DIRA] .

ciscoasa(config-smart-lic)# feature context 18

(F 7 a>) Firepower 2100 5k#% 5 1 > A DiRAN

ATy I

ATy T2

ATvT3

RATv74

KRET A B ANREI R -T2 56 (ASAZBEIET 25672 8) 13, ZOFEEMM L TEX
|Z Smart Software Manager |27 A £ A ZBHTLIMLENH Y £3, T XTOFIEELFET LR
We TARVABBEHBOE IR tMOBFTTHERT D7 OICES IR TE R 2D
£,

FIE

ASA TEHIa— RFRE2RO LA L ET,

license smart reservation return

1 -

ciscoasa# license smart reservation return
Enter this return code in the Cisco Smart Software Manager portal:
Au3431rGRS00Ig5HQ12vpcg{uXiTREVrp7M/zDpirLwYCag8oSv60yZJuFDVBS2Q110=

TZIEHIZASA DT A B AN 720 FHBRIEICBITLE S, Z0a— RefERTTD
VEROLGEIX, Z0a~vr REFANLET, HLWKHT A A (license smart
reservation request universal) BERTDHE, ZOa—FE2HFRTERIRDLIELIIEEL
TLIEEW, 4T, a—FaX¥y 7 F ¥ LT, RIMFEELZTETLTIEIN,

ASA L= /N—H L TS, ZFEAIF- (UDD) MFEREI D DT, Smart Software Manager T ASA
A VAR AT RODLZENTEET,
show license udi

&1

ciscoasa# show license udi
UDI: PID:FPR-2140,SN:JAD200802RR
ciscoasa#

Smart Software Manager 1 > ~X> kU M2 %) L C, [Product Instances] ¥ 7% 7 U v 7 L&
T

https://software.cisco.com/#SmartLicensing-Inventory

[Product Instances] % 712, T A B AR HEINTNDTRXTOREN UDLIZE > THRRS
ET,

FTA Y RAEMRERT D ASA R L. [Actions] > [Remove] % E2fR L T, ASA OiEHIa— %
Ay 7 A AT LET, [Remove Product Instance] #7 V v 7 LE 7,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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ASA OBt |
. (7 3 >) Firepower2100 DEEXMER (EHELUY T4 F)

WRe=w R b FARVAPERARERIA B AT — VRSN ET,

(AT 3 >) Firepower2100 D EFKERR (EHESLUYTIA M)

ASA DREREFRIRT D L. 7T I ASADHIBRSNE T, ASADTRTDOT AL A
MERRAS 5- L REAE N HIBR SN E T, BEEMRT22 8T, A4 B A&H LV ASA IZHIH
TH5ZEHLTEET, HDHWE, Smart Software Manager (SSM) 725 ASA ZHIFRTX £77,

FIE

AT 71 [Configuration] > [Device Management] > [Licensing] > [Smart Licensing] DJIE|Z3&R L £ 9,
AT w T2 [Unregister] 27V v 7 LET,
ZD%, ASAIZY m—RFLET,

(A7 3 >) Firepower2100ID SEBRE F - (X5 1 £ RERFTED
B (RS LUVYTIA4H)

TIZANVNTEH, TAT T AT 4B AEIZ6O » AT L, AU AEKIZ30 B LICEE)
BICEHRSNET, A1 F—Fy F 7272 20HBRE SN TV DEASR, Smart Software
Manager C7 A B AZER LIZGER ST, INOLDOREREFETEHR T L2 L TEE
j—O

FIE

AT w71 [Configuration] > [Device Management] > [Licensing] > [Smart Licensing] O JIE|ZZ4R L £,
RTY T2 TATUT 47 4iEAEEFEH T 5121, [Renew ID Certificate] 27 UV v 7 LE T,
ATYT3 T4 AEKEFTH T 521X, [Renew Authorization] 27 V v 27 LE7,

Firepower 4100/9300 ' v —< : AX— VY7 b7 5
12 ADEE

Z Dk a T, Firepower 4100/9300 ¥ v —Y ICAY—h Y7 by =T T4 A &K
ETDHEEZHPLET,

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T 4 FalL—> 3> A4 F (—RERIZIRME)
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ATy

ATy T2

Firepower 4100/9300 > v —% : 230 L YRIDYT54 F AX—F Y I+I 7 54V VT DERE .

FIE

Firepower 4100/9300 > ¥ —3 : 23.0 KV HiOH T F7 4 h A~— s V7 b7 T4k
TOFE (201 X—) 230 KVEIOVT T4 N F—N"EHEHTHV ¥ —OHEIE, CLI
TASA TA B AERINCHET HLENH Y £F, 74 AWELEZFRRET ST
FXOS 27 4 Xal—valr A REBRLTIEEN,

Firepower4100/9300 > ¥ —% : A —h V7 hU =7 A ¥ U T OREORE (203 ~—
V)

Firepower 4100/9300 > ¥ —< : 230 K YRIDYTS5A4 F AYX—k V7
FOTT SARVVUTDEE

\}

230 X VHIOVT T4 N b—REMHT LUy —2DEAEIE, CLI TASA 71 2 A& K]
CRETDLERH YD 5, T4 b RE 2 FATRET HIIFFXOS a7 4 Fab— 3
VA RESZRLTITEE N,

GE)

ATy T

2.3.0 X Y Hii® Smart Software Manager 7 7 4 b = —H DOHE SRS/t (3DES/AES) 7
AV AT 7 4V hTENI > T2, ASACLIZH L CRERSLT A o R
V7T ANTHET, ASA DFFEIZASDM 2325 Z LiIx T EH A, VPN 25 Teftho
AR BALREEE L. 2DV VA REITO EFTIIHEHATE EHAL

1R BRI

ASA 7 7 AZ DA, REFEDT-DITIEERFHRAICT 7 AT 2 0LERH Y 7,
Firepower Chassis Manager C., fEMEHNMHM ZMER L ET, ZOFIEITRT XL 512, ASACLI
MO LR TEET,

FIE

Firepower 4100/9300 >+ —3 CLI (=22 Y —/L£721X SSH) (Z#fi L. KIZASA IZkE v g
vHEHE L ET,

connect module s/ot console
connect asa

&1

Firepower> connect module 1 console
Firepower-modulel> connect asa

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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. Firepower 4100/9300 > v —< : 230 K YRIDY T34 F AX—F YT bV 7 54V VT DHRE

ATy T2

ATvT3

asa>

RIE] ASA =2 > Y —)VIZHERET 5 & & 13, ASA IZEEREI L £9, connectasa A9 544
BIIHY FHEAL

ASA 7 T AL DG, TA B AREREDRELITIHEIIDHR, ~AF— 2=y NMIT
VAT HRENHY £, BH, A —2=y FRAR Y MIZHDHTD, ZOEYa—
CETERT DLERDH Y £75,

ASACLIT, Zu—)L ar 7 4 F¥al— g F—RE2ANDLET, 74V Tl A
F—T ) NAY — N3 E[ T,

enable
configure terminal

1 -

asa> enable

Password:

asa# configure terminal
asa (config) #

ASA 7 7 AZ DEAEIL, MBIULU T, Z0a2=y NPEERMGTHEMN THDHZ L 2HRLE
7,

show cluster info

1 :

asa(config)# show cluster info
Cluster stbu: On
This is "unit-1-1" in state SLAVE
ID : O
Version : 9.5(2)
Serial No.: P3000000025
CCL IP : 127.2.1.1
CCL MAC : 000b.fcf8.cl192
Last join : 17:08:59 UTC Sep 26 2015
Last leave: N/A
Other members in the cluster:
Unit "unit-1-2" in state SLAVE
ID : 1
Version : 9.5(2)
Serial No.: P3000000001
CCL IP : 127.2.1.2
CCL MAC : 000b.fcf8.cl62
Last join : 19:13:11 UTC Sep 23 2015
Last leave: N/A
Unit "unit-1-3" in state MASTER
ID : 2
Version : 9.5(2)
Serial No.: JABO815R0OJY
CCL IP : 127.2.1.3
CCL MAC : 000f.f775.541e
Last join : 19:13:20 UTC Sep 23 2015
Last leave: N/A

. ASDM Ty % 1: CiscoASA 1) —XASDM79 3> T4 X¥alL— 3> A4 F (—RERIZIENE)
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Firepower 4100/9300 > v —2 : AX— bk VI b7 SA VPV T DEREDHRE .

BlDL = NPEEEHAGTHEAOLGAIL, B E&T L, ELnw==y MIER L ET, B
HTIZOWTIE, UTFZERLTTESN,

ART9Tld F4BVARAY—h a7 4 Fal—vary E—REHLET,
license smart

% -

ciscoasa(config)# license smart
ciscoasa(config-smart-lic)#

ATv TS5 HREEERELET,
feature tier standard
AT DDITERERTT T, 747 748 A, MOWET A B A Z2BINT 57200
R T,
ATV T6 WOBRED 1 L EEY /=2 hLET,
* %+ U7 (GTP/GPRS, Diameter, 55X T SCTP A AT g )
featurecarrier
cEF 2T 4 a2 THFALB
feature context </-248>
KiE T A B ADTRTIE, R TF R (248) #IEETEET.
* mEIE7{t (3DES/AES)

feature strong-encryption

ATV TT ASA LV —LZETLCTelnet 7 7V r—3a VICRDIIE, Yur7 T I~ AL
FT, A=A P CLIZEDIZIE, (quit) & ATTLET,

Firepower 4100/9300 > ¥ —3 : AX—+r YT b7 SA4 VOV
O =Pt —
DEFHADE 3
Z OFNAIL, License Authority ZfEfH 35> ¥ — | 23.0LEDOY T T4 h — "D a—H
FINIKET A B ADOTRINCHEH SN E T, 74 & RAWELE FAET D ITILFXOS X E
HA RESZRL TSN, 230 LVRIOVT T4 F =Tk, YN CLI TTA LA
ERETOILERHVET, 7 T4 b $—N 08— 32230 LIS TIE, EER L
(3DES/AES) T 7 AR— hEJLF— 7 U RH R — R ENTWEH728, tho T A & AHERST
5. %3R4 HHIC ASDM ZEIT T £9,

KT AL ATRIOEE, 74 v RTTRCOMEE, TbbtFal 74 ar7FA R
PERRKOEET 4 TRBEIOF Yy VT T4 AEAZCLET, 7L, ASAR DO
EMHT 2% BT 2] 720X, ASA TERLEFDCT HLERD Y £,

ASDM T4 1: CiscoASA > ))—XASDM79 1> T 4 FalL—> 3> HA F (—RRIEIEME) .
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GE)

ATy T

ATy T2

ATvT3
ATvT4

ATy TH

ATvT6
ATy T17

230 LVEIOVT T A~ = 2 —F DAL, Firepower 4100/9300 >+ —3 : 2.3.0 & D |
DY TITA N AS—K VYT NT2T T4 TORE (201 2—) 2R LUTCCLIT
FTABLAERELTLIESN,

1R8O BRI

ASA 7 7 A Z DA, REFEDT-DITHEERFHRALICZT 7 8 2T 2 LERH VD £,
Firepower Chassis Manager C, 1E#EH AL 2 MR L £97,

FIE

ASDM T, [Configuration] > [Device Management] > [Licensing] > [Smart Licensing] @ JIE|Z %R
LET,

[Feature Tier] K7 v 7% 7 A == —/»5 [Standard] %8N L £ 7,
FEHTE 2 0IIEHERTZT T,

230 KYRIDOYTSA b H—/N 1 —HDH : [Strong Encryption] 7 1 & > A& M2 L2 T
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(f£#) [Mobile SP] [Carrier] Z HEsR L £ 97,

({EE) [ContextlFu v X v A=a—nhb, LERIAVTFANDOESEZRINLET,
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AX—brYIT DT SGACDADE=ZRYY

TR T A=A X—TNZTBET TR, A BV ADMEE, AT —4 A, BXO
FEAEEZE=FTHZ L TEET,

REDSAERADRT
TAB U AEFRIRTHIZIE, ROBEHEZRL TSI,

« [Configuration] > [Device Management] > [Licensing] > [Smart Licensing] ~- > C, [Effective
Running Licenses] fik A £~ L £ 7,

AYX— bk FA4E VR RT—RADEKTR
TAR A AT —=H A% TR DI, WOa~vy FEZRLTIIES,
* : [Monitoring] > [Properties] > [Smart License]

2w — KNV T NI 4V T, Av—h 22—V hONR—T 50 UDLE
HO2Av— T =V FOWREE, /0 — L aL T ITA TV ART—H A BEAT —
B2 A AERTFAEEAEEEB L O TEDA~Y—F 2—V 2 N AT EERLET,

UDI D&~

2= R—P L BRIEERRIF (UDD) 2 %51 5120, kOa<r RE22RLTLLEEN,

show license udi

&Iz, ASAv @ UDI O &~ L ¥,

ciscoasa# show license udi
UDI: PID:ASAv,SN:9AHV3KJBEKE
ciscoasa#
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A<v—h Y7 b7 T4 RIT
foT, 4BV AEBAL, 94 F
VAT = NVEEHTHIENTEE
T, PAK A4 B A L3RR, A
~—h TV RATHED VY TIIVE
FICEEMS T O N EF AL, 2= b
DIARAFT—EFH LR TH,
fEHLUZ ASAV Z B AN LTV EHZ T
L2y T&EET, A—F VT U=
7oA AEFRATIX, 74t
ADFERRDL E B2 O 8 H s s
HrbTEET,

WOBENEAEZFEEINEL
77

[Configuration] > [Device Management]
> [Licensing] > [Smart License]
[Configuration] > [Device Management]
> [Smart Call-Home] [Monitoring] >
[Properties] > [Smart License]

FirePOWER 9300 ® ASA D A =1 A
~v— YT NT=2T TR UT

9.4(1.150)

FirePOWER 9300 {Z ASA D> 2 =2 &
~v— YT NI =2T TR UT
DEAINE LT,

ROWHPEE I NE LT,
[Configuration] > [Device
Management] > [Licensing] > [Smart
License]
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P GEAE ORI THE A E 47z |9-5(2) A<w—hk 54+ A TiL. Smart Call
%4 @ Smart Call Home/ A~— k 7 A Home £ 7 T A KT 7 Fx PMEM X
o AGEE ORRGE NET, ASA Iy 7T KT
Smart CallHome FE44 L AR — b & FcAINIC
FRET D & X2, Call Home V—/3GF
BHEA 51T L7- CA DiFHEL ST k
FANKRA L N EBEBANCER L E
T ASAITH — NFEE DRI THEE )
BHE SN2 5E OFFAEDORBGEE o
A—FLFET, FTARNT =LK
NOEM BB 2 AT E
R

ROWHNEL I E LT,
[Configuration] > [Remote Access
VPN] > [Certificate Management] >
[Trusted Certificate Pool] > [Edit
Trusted Certificate Pool Policy]

FLOXY VT TR 9.5(2) FLOFY VT T4 AFBEFED
GTP/GPRS 7 A & A% @& X,
SCTP & Diameter A > AT 3 U
B R — bk LET, FirePOWER 9300 ®
ASA D¥F4E . feature mobile-sp = < >
R feature carrier =~ > NIZHE#H
BT LET,

WOBEMEAEE SIE LT,
[Configuration] > [Device
Management] > [Licensing] > [Smart
License]
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FirePOWER 9300 ® ASA 125 ERE21L,
(3DES) T A &2 A% HBIIZEH

9.5(2.1)

1B @D Cisco Smart Software Manager
(SSM) = —H# D4, FirePOWER
9300 THGk h—7 v EWEHAT D L. xf
G L R D BRI 2B T A
LU ARBEBICE IR £T,

GE) A—hKM VT =T =
=Ty BT T A FHREA
SNTWDH5E. ASDM X
DR EERE SAgRE 2 %
(Z1%. ASA DREBAIZ ASA
CLIZ{EH LT, mER=b
TA B AERNCT DL
NH0ET,

Z OREREICIE, FXOS 1.1.3 NLBET
_é‘o

ROWENPEL S NE LT,
[Configuration] > [Device
Management] > [Licensing] > [Smart
License]

ASAv DKHET A &2 ATH

9.5(2.200)
9.6(2)

Cisco Smart Software Manager & D {5
PEFA SN TVRWIEFICE X 2 T 7
BREECIE. ASAV HHOKFET A v A

PR TEET, 9.6(2) TiX. Amazon
Web #—E 2D ASAv [MIFIZ, Z O
RROVAR— M RENSNELE, 20O
%8BI Microsoft Azure TiEH A — k &
WEX A,

WDa~<y RREAINE LT,
license smart reservation, license smart
reservation cancel. license smart
reservation install, license smart

reservation request universal, license
smart reservation return

ASDM ¥R — MIH Y FH A,
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C [Configuration] > [Device
Management] > [Licensing] >
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Smart Software Manager 7> 5
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